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Warranty Statement 

There are no warranties, express or implied, with respect to the contents of this document, and all information 
provided herein is provided “as is.” Osteoid reserves the right to periodically change the information that is 
contained in this document; however, Osteoid makes no commitment to provide any such changes in a timely 
manner or at all. 

Limitation of Liability 

In no event shall Osteoid or its affiliates be liable to any party for any direct, indirect, special, or consequential 
damages in connection with your use of this document, including, without limitation, loss of business revenue or 
earnings, lost data, damages caused by delays, lost profits, or a failure to realize expected savings, even if Osteoid 
was expressly advised of the possibility of such damages. 

End of Life Statement 

Osteoid is committed to the continuous improvement of TxSTUDIO by utilizing state-of-the-art technology and 
trends to provide the most comprehensive software for the diagnoses of patients. The “shelf life” of TxSTUDIO 
software has been defined as 3 years from the release to ensure the highest level of patient care and safety. 
Notification of software improvements and new releases will be provided to customers to update to the latest 
version. Previous (older) versions may continue to be utilized for diagnosis, but support may be limited.  

Trademarks 

Osteoid and related marks, images, and symbols are the exclusive properties of, and trademarks of, Osteoid, Inc. 
All other brands and marks are the properties of their respective owners. 

Copyright 

Documentation for TxSTUDIO and the operating software are copyrighted with all rights reserved. Under the 
copyright laws, this documentation may not be reproduced, transmitted, transcribed, or translated into any human 
or computer language in whole or part without the prior written permission of the copyright holder. 

About Osteoid and TxSTUDIO Software 

This version of TxSTUDIO was released as an update to the original TxSTUDIO software from Osteoid, Inc. 
In this document, TxSTUDIO refers to the latest version of the Osteoid TxSTUDIO software. To learn more 
about Osteoid, access the Osteoid website (www.Osteoidinc.com). 

Intended User 
 
TxSTUDIO is designed to be used by medical and dental professionals who have been appropriately trained 
to use 3D CT imaging devices and read the image data generated by the devices. 

Reporting of Serious Events 
 
If the use of this product resulted in, or may have contributed to, a death or a serious deterioration of health, 
this should be reported to the manufacturer at support@osteoidinc.com  

mailto:support@osteoidinc.com
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Language 

The original language of this manual is English. Other versions may be available. Please contact Osteoid for 
other language versions.  

Caution: Federal law restricts this device to sale by or on the order of medical and dental clinicians. 

Indications for Use 
TxSTUDIO is a software application used for the display and 3D visualization of medical image files from 
scanning devices, such as CT, MRI, or 3D Ultrasound. It is intended for use by radiologists, clinicians, 
referring physicians, and other qualified individuals to retrieve, process, render, review, store, print, assist in 
diagnosis and distribute images, utilizing standard PC hardware. Additionally, TxSTUDIO is a preoperative 
software application used for the simulation and evaluation of dental implants, orthodontic planning, and 
surgical treatments. 
 
This device is not indicated for mammography use. 
 
General Precautions 

  

  

 

Warning: The software provides tools for dental prosthetics creation and design but is dependent on the user to 
determine and use the appropriate parameters. Incorrect parameters may affect the quality of  the final milled products or 
otherwise to surgical delays or complications. 

  

 

Warning: Automatic nerve canal estimation is an estimation of  the nerve canal and may not reflect the actual nerve. It is 
not intended for use in treatment planning, and collision detection is not applied to the automatic nerve. 

  

 

Warning: Please ensure all hardware devices with the software are password-protected from unauthorized use and all patient 
information is secure. 
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Introduction 
TxSTUDIO Imaging Software 

steoid, Inc. is a medical imaging company composed of  a 
cross-functional team consisting of  the most elite 
researchers, mathematicians, engineers, software developers, 

business analysts, industry leaders, academic faculty, and dental 
specialists. We believe that TxSTUDIO software will enable the 
profession to initiate a revolution of  unimaginable scope and 
magnitude. Ultimately, our mission is dedicated to developing simple 
and refined software specially designed for dentists to utilize the 
most advanced cutting edge software and technology to better serve 
their patients. With TxSTUDIO software, doctors can create 3D 
volume renderings on their own computers, get cross sections, trace 
nerves, place implants, print images, save images, and many more functions. The software is designed to 
reconstruct these 3D volume renderings from DICOM files generated by CBCT, Medical CT, and MRI 
radiography machines. TxSTUDIO is intended for use as a planning and simulation software in the placement of  
dental implants, orthodontics, and surgical treatment. 

his manual is intended to provide supplementary information to your direct training with the Osteoid 
support team. For correct and safe use, training is available to all TxSTUDIO users and is highly 
recommended. In this document, TxSTUDIO refers to the latest version of  the Osteoid TxSTUDIO.  

For more information about the TxSTUDIO Reference Manual, please contact the Osteoid customer support 
team at (408) 333-3484 or email support@osteoidinc.com 

 

O  

T 

mailto:support@osteoidinc.com
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System Requirements 
Below are the minimal and recommended system configurations. 

aving an adequate computer system is essential to using TxSTUDIO efficiently and generating the 
highest quality images possible for enhanced analysis and presentation for your patients and colleagues. 
The most important element is the video card (3D graphics chip or GPU). If  your system does not 

have an appropriate video card, you can purchase and install video cards for desktop computers. 

TxSTUDIO has minimal system requirements; however, Osteoid recommends the following configurations to 
fully utilize all the features within the TxSTUDIO Software. The following recommendations have been updated 
in September 2017: 

Summary 
 

Minimum Recommended 
CPU Intel Core i series Intel Core i7 (Gen8) or comparable multi-core 

processor 
RAM 8GB 16 GB 
GPU / Graphics Card Intel HD Graphics 515 (Gen9) AMD RX 5500 or comparable 
Hard Disk 100GB 500GB+ SSD 
OS Windows 7 64-bit Windows 11 64-bit 
 

Mac Users 

 OS Hardware 
Not Compatible Apple OS, Parallels MacBook Air, Mac Mini 

Fully Compatible Apple Bootcamp (requires a full license of 
Windows) iMac, MacBook Pro, Mac Pro 

Note: For optimal visualization, the monitor display scale should not exceed 150 percent. 

Graphics Cards / GPU Details 

Brand Model Series Low-End Options High-End Options 

Intel HD Graphics 
Iris Graphics  

HD Graphics 
Iris Pro 

UHD Graphics 

Iris Plus, Iris Xe, Iris Xe Max 
Graphics  

AMD RX 5000/6000 Series RX 5000 – 5600  RX 5000 XT and 6000 XT series 

Nvidia Quadros 
GeForce  

GTX Series 
Quadro K and P Series RTX 3000 Series 

 

  

H 
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Installing TxSTUDIO 
About the License Type 
With the release of  TxSTUDIO 7, a new licensing system was implemented providing more flexibility for users to 
use TxSTUDIO software on multiple devices, in addition to providing more traceability and security. Legacy 
licensing information can be found in our Knowledge Base, as well as their respective User Manuals. 

Invivo Workspace Account 
A free Invivo Workspace account is required to activate and manage your licenses. TxSTUDIO licenses are 
assigned to your user account using your email as your username. To create an account, visit 
www.invivoworkspace.com.  

Assigning a license (Perpetual) 
For users who are migrating from the previous licensing system, as an admin, find your email username in the 
Organization list. In the Information Panel, toggle on the license you want associated with your account. This 
applies to Add-on licenses as well. 

 

Note: Users who only have single person in their organization will have their licenses automatically assigned to them. 

Licensing Support 
User can find knowledge base articles about licensing at the Osteoid help center: https://learn.osteoidinc.com  

 
Internet Requirement 
Internet is required when signing in or signing out of  Invivo. During usage, if  the computer loses connection to 
the internet, a 12-hour grace period starts. If  the computer is not connected to the internet within that time, 
Invivo will be unavailable for use until the connection is restored. 

http://www.invivoworkspace.com/
https://learn.osteoidinc.com/
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Website Installation Instructions 

1. Login into your Invivo Workspace account at www.invivoworkspace.com.  

2. Click on the My Products tab. 

3. Select the respective product (ie. Invivo Desktop , Invivo Ultimate, etc.) 

4. In the Information Panel, click on the “Download” link 

5. Download the latest installer 

 

Validating the Installer File 
 
1. Right-click the Installer file and select “Properties” to open the Properties window. 

2. Open the “Digital Signatures” Tab. 

3. Select “Anatomage, Inc.” and press Details. 

4. Verify that the Digital Signature Information is “OK.” 

 

The following pictures are for demonstration purposes only. The name of  the installer and Digital Signature Information is dependent 
on the release version and may change accordingly.  

   
  

http://www.invivoworkspace.com/


T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 15 of 256 UM-TXS-ENG-71 

TxSTUDIO Setup Wizard 

Click Next to continue. 
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Installation Preferences: The user can specify the folder for software installation as well as the level of  
functionality with which the software initially opens. A PACS-compatible user interface can also be installed 
instead of  the typical File Manager. 
 
Full Functionality Mode: Selecting this 
option will have all view tabs enabled after 
the installation is complete.  

Unchecking this function will install the 
software with only Section, ArchSection, 
Volume Render, Implant, Gallery, and 
Model Tabs visible. The missing tabs can be 
enabled in the Preferences dialog of  the File 
menu. 

PACS Options: Files can be opened from 
or saved onto PACS through the PACS user 
interface. Selecting “Full PACS” will disable 
opening or saving files locally. Selecting 
“Export PACS Only” options will disable 
saving files locally. 
 
Only select these options if  you have a PACS in place.  

 

  

Review the End-User License Agreement 
and accept the terms if  desired to proceed 
with the installation. 

 

 

Click Next to continue. The program will proceed with installation until completed. Clicking Finish will close the 
wizard. 

Launching TxSTUDIO / Signing into TxSTUDIO 
Please be connected to the internet when starting TxSTUDIO. 

1. Launch TxSTUDIO 
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2. During the Splash Screen, your internet browser will launch and be directed to the Invivo Workspace 
login page. 

a.  
 

b.  
 

3. Type in your login credentials. If you have not created an account yet, please follow the instructions to do 
so and launch TxSTUDIO again. 

4. After entering your credentials, a permission dialog will appear. 

a.  
b. It is highly recommended to click “Always Allow” to improve launching TxSTUDIO in the 
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future. Otherwise you’ll need to provide permissions every time you login. 
5. After clicking “Open Link”, Invivo will launch. 

 

a.  
 
 
 
Migrating or Transferring a License / Signing out of TxSTUDIO 
To use the license of TxSTUDIO on another computer, the license must be deactivated from the current computer. This 
can be accomplished by signing out of the TxSTUDIO software. Once signed out, the license will be available to be 
activated on another machine by following the Sign In process.  
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Feature List 
An overview of  the various features provided by TxSTUDIO. 

• Directly Opens DICOM Data from Any CT Machine 
 

• Invivo File Compression 
 

• Section and Multislice View Operations 
 

• Volume Rendering of Scan Data 
 

• Linear, Angular, Circumferential, Area, and Volumetric Measurements* 
 

• Image Capture and Export 
 

• AVI (Movie) Capture and Export 
 

• Implant, Abutment, and Restoration Treatment Planning 
 

• Bone Density Evaluation 
 

• Quick Airway Volume Measurement and Evaluation 
 

• Automatic Superimposition and Mirroring 
 

• Integrated Treatment-specific Video Sequences 
 

• Platform for the Invivo Model and Invivo Guide Services 
 
 
 
 
 *All measurements are performed with the metric system. 
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Software Layout 
The following is a description of  how TxSTUDIO is organized by Menu Bar, Toolbar, View Tabs, View Control Panel, and 
Rendering Window. 

 

 

 

 

 

 

 

  
Control Panel 

The Control Panel is the region 
where patient images can be 

manipulated and controlled.  The 
Control Panel is associated with 

a specific View Tab. 
 

Rendering Window 
Rendering Window is the region 

where patient images are 
displayed.  This window can be 
customized within many of  the 

View Tabs by using the Toolbar. 

View Tabs 
The View Tabs 

perform specific tasks 
or look at specific 

subjects of  interest by 
adjusting the Toolbar 
and View Controls. 

 

Menu Bar 
The Menu Bar 

contains application 
operations such as 
open, save, close, 
print, capture, etc. 

 

Toolbar 
Tools can be accessed to 

perform certain functions on 
patient images.  Sets of  tools are 
associated with a specific View 

Tab. 
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TxSTUDIO Preferences 
This section explains the different options within the Preference window of  TxSTUDIO. The TxSTUDIO preferences include options 
for Display settings, Volume Rendering settings, as well as File Manager settings. 

Accessing the TxSTUDIO Preferences: 
• In the Menu bar of  the TxSTUDIO, select “File.” 
• Select “Preferences…” from the “File” drop-down. 

 
Display Preferences 

 

GUI Settings 
• Background: Sets the background color for 

the rendering window. 
• Measurement Font Size: Sets the 

measurement font size to a size preset: 
small, medium, or large. 

• Measurement Text Color: Sets the text 
color for measurement notations. 

• Measurement Line Width: Sets the width 
for measurements. 

• Measurement Line Color: Sets the color of  
the measurement lines. 

• Tag Text: Provides an additional label to 
the right hand corner of  the rendering 
window. 

• Date Format: Current date format for case 
information display. 

• Continuous view: 
o Checked – Switching between view 

presets for volume renderings shows 
intermediate volume positions.  

o Unchecked – Switching between 
view presets does not show 
intermediate positions; the volume 
“jumps” to the final position. 

• Make text annotations global: When 
checked, previously placed or new text 
annotations added to any 2D slice view 
except group slices (TMJ, ArchSection) are 
visible when scrolling past the slice the 
measurement was placed on. 

• Cycle 2D distance measurement color: 
Measurement colors cycle with every 
measurement that is added. 
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• Enable multiple distance measurement mode: Distance measurement becomes a toggle on/off  
button for measurement mode. Toggling “on” this mode continuously picks beginning and end 
points for linear measurements with each click after the first measurement has been created until 
toggled “off.” 

• Enable restricted access mode: This option is only available when running the software as an admin. 
Toggling “on” this option restricts the standard user from modifying software display preferences. 

• Tru-Pan on by default: For cases with Tru-Pan data, the Tru-Pan is displayed instead of  panos 
derived from the arch spline by default. 

Color Theme:  
• Two color themes are available for the software.  
• The software images in this manual are in Black and White mode, but the overall functions are 

shared between the themes. 
Auto save 2D view setting on application exit 
• This setting determines if  2D view settings made in each of  the applicable tabs are saved 

automatically upon program closure and be reloaded with the next opened case. If  left unselected, 
the user has to manually save the configuration by clicking Save View Settings in the working tab. 
The specific 2D view settings that are saved in each tab are given in the table below: 

ArchSection Slice Interval, Cross Section 
Width/Interval/Thickness, Auto R-L, Pano 
Image Type, Pano Ruler Enabled, 
Brightness/Contrast mode, Layout (including 
Axial vs. Cross Series and Print Layout), 
Sharpen Filter, Color Preset, Nerve Diameter, 
and Nerve Visibility 
 

Section Rendering presets, custom 
Brightness/Contrast (if  the Dental preset is 
chosen), Sharpen Filter, Volume Clipping, 
Slice Thickness 
 

Airway Rendering presets, custom 
Brightness/Contrast (if  the Dental preset is 
chosen), Sharpen Filter, Volume Clipping, 
Slice Thickness 
 

Implant Planning Layout, Restoration Lock, View 
Preset, Brightness/Contrast, Sharpen Filter, 
Volume Clipping, and Remove Crown 
 

Endo Rendering presets, custom 
Brightness/Contrast (if  the Dental preset is 
chosen), Sharpen Filter, Volume Clipping, 
Slice Thickness 

TMJ Lateral Width/Interval/Thickness, 
Brightness/Contrast mode and settings, 
Layout (including sequence type and Print 
Layout), Sharpen Filter, Color Preset, Focal 
Trough Thickness and Symmetry, Frontal 
Render Mode 
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Volume Rendering Preferences 

 

Volume Rendering View Settings 
• Quality Resolution: Sets the limit for the 

resolution of  the image. This can be set to 
either a user-defined number or set to 
Unlimited. 

• Initial Rendering: Sets the rendering quality 
upon opening TxSTUDIO. 

• Shaded Slice Sampling Rate: Accepts a 
numerical value that sets the sampling rate to 
improve image quality at the cost of  
performance. 

• Use lower resolution while moving volume: 
Positional changes of  the volume are 
rendered at a low-quality resolution while 
maintaining the quality resolution setting in 
the final position. 

Volume Rendering Range 
• The user can define the range of  Hounsfield 

Units that are rendered. This cannot be set 
when “Use automatic H.U. range” is 
checked.  

• Checking “Non-CT modality: use scalar for 
min-max” allows the user to define the 
minimum and maximum scalar units that are 
rendered. 

Material 
• Various properties can be adjusted to change the appearance of  a volume rendering. Ambient, 

Diffuse, and Specular effects can be rendered in different colors. 
• The degree of  Emission and Diffuse can be adjusted with the respective sliders. 
• Shininess is set to a number – higher numbers denote less shininess. 
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File Manager Settings 
File Type-Associated Folder Paths 
Folder paths can be set for each of  the Invivo and DICOM file type options. When one mode is selected, 
the program uses the file paths associated with that file type mode, but the user may still save or open either 
file type at any time. 
 
File Path Preferences for Different Users 
In the situation that there are multiple users on a single computer with TxSTUDIO installed across multiple 
user accounts, the file paths for all new accounts initially take on the preferences defined by the user 
administrator account. Non-admin accounts may redefine their file path settings, but they will be 
overwritten the next time the settings are changed on a user administrator account. 
 

 

File Paths 
• Admin Only: Toggling “on” this 

option restricts the standard user 
from modifying software display 
preferences. 
o This option is only available 

when running the software as 
an admin. 

• Anatomage Case Path: This folder 
serves as a backup folder for all 
opened cases from the locations 
selected in the Copy Files to 
Anatomage Case Folder Before 
Open. 

• Default Open Path: This is the 
starting location for attempting to 
open a case through File → Open in 
the Menu bar. 

• Default Save Path: This is the starting 
location for saving a case file in 
TxSTUDIO. 

• Temporary File Path: This is the 
temporary location that the Capture 
To File In Temporary Folder function 
uses. 

Copy Files to Anatomage Case Folder 
Before Open 
• This section allows the user to save a 

copy of  a case that is to be opened in 
the Anatomage Case Folder if  it is in 
any location besides this folder, such 
as on a different location on a 
network, on a CD-ROM, or in a 
different folder on the local hard 
drive. 
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DICOM Advanced Settings: Change Character Set 
• This option is only available if the DICOM File option is selected. 
• Import 

• If checked, this sets the value for the Specific Character Set DICOM tag (0008, 0005) 
o When Missing: This will use the specified value only when the tags are missing 
o Always: This will always use the specified value on import 

• Export 
• If checked, this sets the value for the Specific Character Set DICOM tag (0008, 0005) on export. 

 

   Warning: Importing or Exporting with the incorrect Character Set could lead to unreadable text. 
  
PACS Settings 

 

Import Configuration 
• Configure: Click to edit the server and client 

information from which cases are imported. 

Export Configuration 
• Configure: Click to edit the server and client 

information to which cases are exported. 
Admin Only: Toggling “on” this option 

restricts the standard user from modifying 
PACS configurations. 

• This option is only available when running 
the software as an admin. 

• Software Mode: Files can be opened from or 
saved onto PACS through the PACS user 
interface. Selecting “Full PACS” disabled 
opening or saving files locally. Selecting 
“Export PACS Only” options disabled 
saving files locally. Only select these options 
if  a PACS in place. 
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Module Settings 

 

Server Path 
• Enabling this dialog allows the admin user 

to set the directory for data export within 
the software. 

o This option is only available 
when running the software as an 
admin. 
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Basic Features 
The following is a detailed explanation of  the various features provided by TxSTUDIO. 

DICOM & Invivo File Loading with the File Manager 
  
To open a DICOM data set or TxSTUDIO-associated file type (.inv, .amg, apj), first launch the TxSTUDIO 
software. The File Manager appears upon startup for loading the scan data. If  one of  the PACS mode 
options in Preferences was selected, please refer to page 30. 

 
  

Click the Browse File from This Device 
button to search manually for the data to 
open. For opening DICOM data, as 
shown to the right, simply highlight one 
of  the .dcm files and click Open. It does 
not matter which DICOM file is 
chosen, as selecting one opens all the 
files within the data set present in that 
folder. For opening an Invivo file, select it 
and press Open. Invivo files can also be 
compressed and opened. 
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The File Manager automatically stores recently viewed case locations. This allows for quicker access to these 
cases. By default, files are saved in the “Anatomage Cases” folder, located in “My Documents.” This location 
can be changed in the Menu Bar → File → Preferences → File Manager. 
 

Invivo/DICOM Options: This 
filters the displayed cases by file 
type.  

Scan searches the default open file 
path chosen for the file type 
selected and displays the respective 
cases.  

Quickly search through the recent 
cases by typing in the Patient Name 
or Scan Date in the search fields 
(shown right). 

 
Click the Browse File from The 
Invivo Workspace button to 
search cases available on Invivo 
Workspace. Enter the Invivo 
Workspace account credentials 
when prompted. Available cases are 
displayed in the File Manager to be 
loaded into Invivo.  
After closing a case, to reopen another one, click on “File” → “Open”, and the File Manager will appear 
again. 
 
Selecting Options… displays additional options to delete the recent case history or to delete select cases 
from the list. This only modifies the cases that are displayed on the File Manager and does not delete the 
actual files from where they are saved. 
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Invivo/DICOM File Saving 
TxSTUDIO provides four options for saving and each type 
differs in the size of  the saved file and its compatibility with 
other software. Choosing “File” → “Save As...” for any file 
presents the dialog on the right. Choosing “File” → “Save” 
when a DCM file is open saves an INV in the specified 
location or simply overwrites the same file if  it is already in 
INV file type. 

 
Invivo 
The following work can be saved as an Invivo file 
(.inv).  

• Case Information & Patient 
Orientation 

• Traced Nerves 
• Implants & Implant Measurements 
• Volume Measurements, Landmarks, 

and Annotations 
• Images captured within the Gallery 
• Sculpting Operations 
• †Models imported from MDStudio 
• †Tracings performed in 3DAnalysis 

†These functions require the installation and activation of  additional 
software modules. 
 

 

Click “File” → “Save As...,” browse to the 
destination folder, name the file (default is the 
patient’s name), then click Save. 
 
The following save dialog box appears. Select the 
default “Full” option for saving everything 
without losing any information. 
  
DICOM  
When the DICOM file type is chosen, the output 
options are either a single lossless DICOM or a 
multi-file DICOM (with DICOMDIR) 
accompanied with an Invivo workup file 
containing workup data and a folder of  exported 
Gallery images in DCM format.  
 
For single-file DICOMs (Figure 1), the save 
dialog asks for a location to save the files. For 
multi-file DICOMs (Figure 2), create or choose a 
folder to save the slices and DICOMDIR file. 
The DICOMDIR file presents the directory of  
slices to TxSTUDIO to accelerate the loading 
speed.  

Figure 1: Single-file DICOM Save Dialog 
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The DICOM File Save Option dialog (Figure 3) presents numerous options for saving the file. 
Compression reduces the size of  the file at the cost of  increased saving and loading speed. “Lossless” 
or “Lossy” determines the quality (amount of  data) of  the file that is saved. Resampling changes the 
resolution by a factor in each orthogonal plane. The workup file description can be used to 
differentiate between different workup files on PACS. If  “Save additional series” option is selected, the 
coronal and sagittal DICOM series are also exported along with the default axial series. 
 

 
Figure 2: Multi-file DICOM Save Dialog 

 

 
Figure 3: DICOM File Save Options 

Custom Saving Dialog 
Available for Invivo file saving: By selecting the “Customize” 
option, the custom saving dialog shows up. In the dialog box are 
data compression options. For the main volumetric image, 
“Lossless” or “Lossy” compression options are available. With 
lossless compression, the volume is compressed to about 1/3rd – 
1/4th of  the original size. With the Lossy compression option, the 
file size can be dramatically reduced, but the image is altered. 
Resampling the data greatly reduces its size by combining voxels to 
reduce the overall voxel count. Rescaling the image reduces the 
number of  shades of  gray in the image. Options to selectively 
compress images in the Gallery, the clinical content (such as 
implants and nerve tracings), and the models can be selected. 

 

 
Warning: Saving files in lossy format degrades image quality. 

 
Saving As an Invivo Project File 
Click “File” → “Save As Project...” to save the case as an APJ, Invivo Project file. This file only saves work up 
data. It requires a reference data (.dcm scan data or .inv file) when opening. If  Invivo cannot locate the reference 
data, it prompts to locate the data filepath. Because it is saving only the changes to the original, APJ files save 
much faster than full INV files. 

DICOM File Loading with PACS 
If  one of  the PACS option in the Preferences of  Invivo were chosen, upon launch, the PACS File Import window 
opens instead of  the File Manager. At initial launch, the settings need to be configured to connect with the 
database, but this information is retained subsequently. 
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Without selecting a PACS mode, this interface can still be accessed by choosing “File” → “Import PACS.” 

PACS Configuration 
Click Configure to set up the connection to PACS. 
Input the appropriate server data and test the 
connection to verify the information. Tag configuration 
and Query and Retrieve settings can be accessed under 
Configure Tags. 

Configurations can be added, updated, and removed 
from the drop-down menu. 

Scans from PACS are stored locally in the Local Storage 
Directory folder while they are open. The option to 
delete the local files after opening them is available. 

Transport Layer Security (TLS) setup can also be 
configured. 

Once the information is complete, click OK. This data 
is saved until manually reconfigured.  
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PACS File Loading 
Click Query to load the cases stored on PACS. Filter cases using the patient information fields. Select a case from 
the Case List and click OK. TxSTUDIO searches for any workup files associated with the patient. Select an 
existing workup file and click OK or click Cancel to open the raw patient scan. 

 

PACS File Saving 

Click on File → “Export PACS” to save the file onto PACS.  
• Configure: Opens the PACS Configuration dialog. 
• For descriptions of  the different DICOM types, refer to page 29. 
• Without installing under PACS mode, this interface can still be accessed by 

choosing “File” → “Export PACS.” 
  

Export DICOM and Viewer 
This function creates an executable file containing the 3D volume data from the scan that is currently open as well 
as a 2D TxSTUDIO viewer program. This function is designed to allow the sharing of  scan data from an 
TxSTUDIO user to a non-TxSTUDIO user on shareable media such as a CD, DVD, or flash drive. Note that 
some antivirus programs may detect the file as a virus due to its executable format. 

TxSTUDIOViewer: Running this file 
initializes the viewer program and then 
loads the embedded scan data. The 
EggViewer contains some Section, 
ArchSection, and Gallery functionality. 

                

Export to CD 
This function exports the currently opened scan as a compressed or uncompressed DICOM or a full, 
compressed, or customized setting Invivo file. The exported file is placed in the temporary burn location in the 
computer.  
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Send File 
Invivo Workspace 
The active case can be sent through Invivo Workspace 
as Invivo, single file DICOM, multi-file DICOM with 
DICOMDIR, or multi-file DICOM with .dcm 
extension file types. The software prompts the user to 
sign in to an Invivo Workspace account. If  no account 
was previously made, click Create Account to get 
started. Toggle on “Remember Me” to retain the 
username and password that is used. Click Forgot 
Password? to reset the password for an existing cloud 
account if  needed. 

 

After logging in, select the file type to upload and send. 
The user can then input the recipient’s name, email, 
message subject, and discussion notes. Existing contacts 
in Invivo Workspace can be searched to automatically 
populate the contact. The case and message are sent to 
the recipient’s Invivo Workspace account. The recipient 
can then preview the case through the browser viewer or 
download it for further use. 
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Upload for Service 
To send the case directly to the Invivo Service website for the 
Invivo Model or Invivo Guide service, input the Invivo Service 
login when prompted. Toggle on “Remember Me” to retain 
the login information, and click Upload to upload the case. If  
further instructions are required for processing the case, please 
contact the Invivo Model department at 408-333-3484 ext. 4.  

Note: This function cannot be used for uploading Surgical 
Guide cases. To do so, please access the Invivo Service website 
(invivoservice.com). 
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Case Information Display 
To display or hide the Case Information for a specific patient, go to the “File” → “Case Info.” Click Anonymize 
then click OK to save the changes. 

   

Manage Workflow 
To edit the naming, order, and number of  tabs that load with the software, go to the “File” → “Manage 
Workflow.” 

To rename a tab, click on it in the Name column in the My Workflow window, and type directly into the field. To 
change the order of  tabs, click on the tab and select “Move Up” or “Move Down.”  

To add or remove tabs, select them from the Source Views window or the My Workflow window and select the 
button to add or remove respectively. 

The software must be relaunched to apply the workflow changes. 

Image Capture to File 
To capture an image of  the active display to file, click “View” → “Capture to File.” Browse to the location to save 
the image, type the name of  the file, choose the file type on the “Save as type” drop-down, and click Save. The file 
can be saved as bmp, jpg, or png format. Jpg is the most popular file format for images, but there is a small 
amount of  color degradation. Bmp preserves the image, but the file size is big. Png is an effective lossless format 
that does not degrade the color. 
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Image Capture to Gallery 
Selecting “Capture To Gallery” or pressing Ctrl + G captures an image of  the rendering window and saves it to 
the Image List (see Gallery Tab features for additional information, pg. 141). 

 

Image Capture to Clipboard 
Selecting “Capture To Clipboard” captures an image of  the rendering window to the clipboard for pasting in 
other programs 
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Image Capture to File in Temporary Folder 
Selecting “Capture To File In Temporary Folder” captures an image of  the rendering window to the temporary 
folder set in File → Preferences. The image is always named “Untitled.jpg”. 

 
 
Software Update 

Checking availability of any software updates can be done through the help menu. By default, a check will be performed 
when the application is launched. 

• Selecting “Check for Updates” will check to see if any updates are available for TxSTUDIO. If an update is 
available, the option to download will be provided. Select a location to save the installer. The download will 
happen in the background and when complete, a notification will appear. 

 

• Selecting “Disable Automatic Update” will provide the options to postpone or completely disable any checks 
for updates. 

 

 

• Selecting “Enable Automatic Update” will re-enable the check for software updates at launch. 
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Instructions for Use 

Selecting “Instructions for Use” will open the instruction manual that is installed along with the software. The latest 
version of the instruction manual can be found at the Osteoid knowledge base (learn.osteoidinc.com). 
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Image Navigation 
Below is an explanation showing how to manipulate images in the rendering window with the keyboard and mouse. 

Slider Scroll 

 
 
• Click the mouse cursor over any slider (e.g. axial slice, brightness, etc.) and move it to adjust the image. 
• Click the slider and keep the mouse cursor in the Control Panel before scrolling the mouse wheel forward or 

backward to achieve the image adjustment you like. 
 
 
Zoom In/Out 

• Place the mouse cursor in the center of  the image you want to 
zoom. 

• Hold down the “Control” key + left-button on the mouse. 
• While holding down the buttons indicated above, move the mouse 

up and down on the screen. 
• This shrinks/enlarges the image: Down vertically zooms out. Up 

vertically zooms in. 
 
 
 
 
Pan (Shift) 

• Place the mouse cursor in the center of  the image you want to shift. 
• Hold down the “Shift” key + left-button on the mouse. 
• While holding down the buttons indicated above, move the mouse any direction 

to achieve the desired image displacement. 
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Free Rotate 
Applicable only for 3D images.  
 
• Place the mouse cursor in the center of  the image you want to shift. 

Hold down the left-button on the mouse. 
• While holding down the left-button, move the mouse in any direction 

to achieve the desired rotational position. 
 

 

 

Free Rolling 
Applicable only for 3D images.     

 
• Hold down the “Space” key + left-button on the mouse. 
• While holding down the buttons indicated above, move the mouse up 

and down to rotate the image about a central axis. 
 
 
 

 

Increment Rotate 
Applicable only for 3D images.     
 
• Use the keyboard arrows ← ↑ ↓ → to rotate the 3D Model 1 degree up, down, right, or left, perpendicular to 

the computer screen. 
 
 
 
 
Increment Roll 
Applicable only for 3D images.     
 
• Hold down the “Control” key and use the keyboard arrows ← → to rotate the 3D Model 1 degree rolling left 

or right about a central axis. Pressing ← → without the Control key pressed will roll the image left or right. 
Use ↑ ↓ to roll the image up or down.  
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Anatomical Plane Clipping 
Applicable only for 3D images. 
 
• Place the mouse cursor over the center of  the image, then scroll 

the mouse wheel forward or backward to clip the anatomic plane 
as you like (after enabling clipping in the Control Panel). 

 
 
 
 
 
Scroll Slice 
Use when you would like to move through the series of  sections when 
in either the Section, ArchSection, or Pano views.  
• Place the mouse cursor in the center of  the image then scroll the mouse 

wheel forward or backward to move one section at a time as you advance 
through the data slices. 

 
Note: In the ArchSection Tab, you must first create an arch spline to activate this feature.  
 
 
 
Move/Rotation Widget 

• Superimposition View: Click on either the ring or the arrows circling the patient 
and move it in the direction you want the patient to be oriented.  

• Model View: Use to move a model through a portion of  the volume for 
simulation creation. Click on either the ring or the arrows circling the model and 
move/rotate it in the direction you want it to move. 

3D Restoration Widget 
The 3D Restoration widget is designed to maximize visibility in the 
renderer and provide a high level of  versatility in crown positioning 
and sizing. The resizing handles only appear when the camera 
perspective is within a range of  angles that is relatively orthogonal 
to it. 

• The rotation circle appears on the same plane as the two 
resizing tools that are close to orthogonal to each other and 
the camera perspective and feature eight arrows for rotation. 

• The red resizing handle can be selected and dragged 
toward/away from the crown to reduce/expand the 
mesiodistal size of  the crown. 

• The green resizing handle can be selected and dragged  
 

toward/away from the crown to reduce/expand the height of  the crown. 
• The blue resizing handle (not shown) can be selected and dragged toward/away from the crown to 

reduce/expand the buccolingual size of  the crown. 
• The crown can be clicked and dragged freely along a plane orthogonal to the camera angle. 
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Full Screen Mode 
Below is an explanation pertaining to running the software in full screen mode. 

Switching to Full Screen Mode 
From the software menu, select “View” → “Full Screen.” “Full screen stereo” is only applicable for the stereo 
display system. To return to the normal screen mode, press the “Esc” key on the keyboard. Full screen is not 
applicable to the ArchSection Tab and Implant Tab. 

 



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 43 of 256 UM-TXS-ENG-71 

The View Tabs: 

ArchSection View Features 
ArchSection View Tab is a sectional image exploration view. Instead of  conventional X-Y-Z sections, this view allows the user to 
review the image in dentally meaningful perspectives using multiple cross sections, traversing the lengths of  the dental arches. 
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ArchSection: Toolbar 
Shown below are the Toolbar and tools that are loaded with the ArchSection Tab: 

  

  
Reset: Resets the window to the original view. 

  

Create Arch Spline: After selecting this tool, create a new arch spline or edit an existing arch spline. 
Left-click to place nodes along the arch. Right-click or double-click to finish the arch spline. To 
modify an existing arch spline, drag the nodes to the desired positions. To move the arch while 
maintaining its shape, click and drag the central spline.  

  
Arch Spline Ruler: Places ruler along the arch spline for easy reference. 

  
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 
number in millimeters automatically displays. 

 

Angle Measurement: Select this option and mark three points on the volume, and the angle 
between them appears. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it. 

  

Area Measurement: After selecting this tool, click multiple points along the boundary of  the 
desired area. Double-click or right-click to end the measurement. A number in millimeters squared 
automatically displays. Click on the measurement and press the “delete” key to delete it. 

  

Polyline Measurement: Select this option and mark any number of  points in the slice view. Right-
click to end the measurement, and the total distance appears.  Clicking on the nodes and moving the 
cursor can modify points. Click on the measurement and press the “delete” key to delete it. 

  
Reorientation: Adjusts the patient orientation and the visible range of  the scan. 

  
Arrow Notation: Allows an arrow to be drawn on the image. 

  
Circle Notation: Allows a circle to be drawn on the image. 

  
Text Notation: Allows text to be written and edited on the image. 

  

H.U. Measurement: Calculates the HU value of  an area within a bounding rectangle, circle, or 
ellipse. The measurements display alongside the shape and can also be repositioned by dragging. 
The information updates when the box is moved or if  the user scrolls. 

  

Slice Capture Mode: Opens the Slice Capture Manager to enable the capture of  slices or 
groups of  slices from a series of  cross sections. Requires the creation of  a slice group in the 
Report Tab and an activated Report module. 

  
Rotate Cross Section: Adjusts the patient orientation in the cross sections. 

  
Layout: After clicking on the layout icon, a list of  various layout options appear. Click on the 
desired layout to apply it. A custom layout can be created and loaded. 
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Toggle Cursor Visibility: Conceals or displays cursors. 

  
Information Display: Displays or hides case information embedded in the data. 

  

View Sequence: Allows for the creation of  custom camera sequences and AVI file movie 
capturing. Refer to the Volume Render View Sequence (pg. 73) section for additional 
information and description. 

 
  

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

 
 

mailto:support@osteoidinc.com
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ArchSection: Control Panel 

 

Layout: 
• Change Layout adjusts the layout with different numbers 

of  slices and orientations. A custom layout can be 
configured. (See page 50.) 

• Maxillary Arch and Mandibular Arch options allow two 
different arch splines to be created and saved. Switching 
between the two options changes which spline is 
manipulated and used in creating the panoramic and cross 
sections. 

• “Print Out” layout is optimized for printing the image on 
paper. With Print Out layout, the current view can be 
printed on the paper in life-size. First, capture to Gallery, 
then print from Gallery to ensure the image is life size. 

Axial Section: 
• Interval: Distance between the subsequent axial sections. 

Cross Section: 
• Width: Cross-section width. 
• Interval: Distance between the subsequent cross sections. 
• Thickness: Allows for the cumulative thickness of  the slices 

to be viewed in the cross sections. 
• Auto R-L: This allows the cross section to be oriented to a 

consistent R-L orientation on the screen. If  turned off, the 
cross-section orientation is consistent to the arch spline. 

Panoramic Image: 
• Slice mode displays a single cross section along the panoramic curve (yellow). This mode is used for 

tracing the nerve. 
• X-ray shows the ray sum (reconstructed x-ray) in the focal trough. 
• Ruler: Displays a ruler on the bottom of  the panoramic image. 
• Tru-Pan™: This option enables the one-click volumetric pan that can be created from scans taken by 

an i-CAT© Cone Beam 3D system. 

View Control: 
• Brightness and Contrast can be used to adjust the image. 
• The All drop-down allows for brightness/contrast adjustments in different areas independently. 
• Different Color Presets can be used to view the images in color. 
• Sharpening Filter applies the selected sharpening filter from the drop-down menu to the 2D slice 

renderers. 

Nerve Pathway: 
A nerve pathway can be created manually or by using the Automatic Nerve feature: 
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Manually Create Nerve 
Creating a Nerve Pathway (e.g. Inferior Alveolar by following the mandibular canal to its exit). 

• Click New. 
• Left click the mouse where you want the nerve to start. 
• Move the mouse to the next point along your path and left click again. 
• Repeat this procedure for the entire length of  the nerve. 
• 2.0 mm is the default diameter of  the nerve pathway, but you may adjust it for your preference. 
• Press Done to finish. 

Deleting a Nerve Pathway 
• The Delete tab can be used if  a point was plotted in the wrong spot; it will delete the last point 

added. 
• Picking the nerve and pressing the “Delete” key will delete the nerve that was traced if  you want 

to get rid of  it. 
• Visibility will turn the nerve on or off  from view. 

 
Create Automatic Nerve 

• Click Pick Seed Points. 
• Pick at least two points with the left mouse click on the axial, cross section, or pano (Slice or 

Xray) view. 
• Click Delete Last Point to remove the most recently placed seed point. Click Cancel to cancel 

nerve creation. 
• Click Preview to preview the nerve tracing. Clicking Finish will complete the nerve tracing. 

Click Modify to remove points. 
Deleting a Nerve Pathway 
• Picking the nerve and pressing the “Delete” key on the keyboard will delete the nerve that was 

traced if  you want to get rid of  it. 
• Visibility will turn the nerve on or off  from view. 

 

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of  the nerve can lead to surgical 
complications if  diagnosis, treatment plans and/or actual treatment is based off  of  the incorrect tracing. It is critical for the end 
user to learn how to properly perform nerve tracings correctly. If  you notice any inconsistencies or software problems with nerve 
tracing or have further questions or concerns about nerve tracing, please contact Osteoid support at (408) 333-3484 or email us at 
support@osteoidinc.com 

 

Warning: Automatic nerve canal estimation is an estimation of  the nerve canal and may not reflect the actual nerve. It is 
not intended for use in treatment planning, and collision detection is not applied to the automatic nerve. 

 
 Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 

section in Preferences (pg. 21) for more information on which settings are saved for this specific tab.  
 
 

mailto:support@osteoidinc.com
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ArchSection: Rendering Window 

 
 
Arch Cursor: Notice the green, orange, and brown coordinate indicators. These ArchSection coordinate 
indicators show the spatial location within the ArchSection modeling window. 
Cross Section Indicator: The green lines give the location of  the cross sections along the arch spline.  
• Axial Slice Indicator: The orange line shows the axial coordinate position within the section.  
• Arch Spline: The brown spline in the center of  the arch spline represents the current position where the arch 

section has moved. 
• Cross Section: Mouse scrolling within any one of  the three sagittal frames advances the slices to the patient’s 

right or left and causes the green coordinate indicator to move anteriorly or posteriorly in the axial and pano 
sections simultaneously. The up and down keys can also be used to scroll through cross sections by page. 

• Axial Section: Mouse scrolling within the axial section advances the sections superiorly or inferiorly and 
causes the red coordinate indicator to move superiorly or inferiorly in the cross or pano sections 
simultaneously. 

• Pano Section: Mouse scrolling within the coronal frame advances the slices buccally or lingually and causes 
the brown coordinate indicator to move buccally or lingually in the axial and cross sections simultaneously.                               
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ArchSection: Creating A Nerve Pathway 
Creating a Nerve Pathway (e.g. Inferior Alveolar by following the mandibular canal to its exit). 
• Click New Nerve. 
• Left-click the mouse to start the nerve. 
• Move the mouse to the next point along the nerve path and left-click again. 
• Click Delete to remove the last-placed node if  it is mispositioned. 
• Repeat this procedure for the entire length of  the nerve. 
• 2.0 mm is the default diameter of  the nerve pathway, but the parameter can be adjusted as desired. 
• Press Done to finish. 

 
Editing a Nerve Pathway 
• Click on a nerve tracing to select it. This highlights the nerve in a brighter red color. 
• Click Modify. This reveals all of  the nerve nodes that are visible in each slice in blue. 
• Nodes can be moved by clicking and dragging it across the scan. 
• Set the Nerve Node drop-down menu to “All” or a specific node.  
• If  “All” is selected, the entire nerve tracing’s diameter can be adjusted. 
• If  a single node is selected, it is located in the slices, and its diameter and position may be adjusted 

independently. The nerve node diameter is adjusted in the Diameter drop-down menu.  
 
Deleting a Nerve Pathway 
• The Delete button can be used if  a point was plotted in the wrong spot by deleting the last point added. 
• Once a nerve has been completed and Done has been clicked, the nerve can be deleted by clicking on it and 

pressing the “delete” key on the keyboard or the Delete button. 
 

 
 
  

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of  the nerve can lead to surgical 
complications if  diagnosis, treatment plans and/or actual treatment is based off  of  the incorrect tracing. It is critical for the end 
user to learn how to properly perform nerve tracings correctly. If  you notice any inconsistencies or software problems with nerve 
tracing or have further questions or concerns about nerve tracing, please contact Osteoid support at (408) 333-3484 or email us at 
support@osteoidinc.com 

mailto:support@osteoidinc.com
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ArchSection: Custom Layouts 
A custom layout can be set by going to the Layout tool or Change Layout. Click Set Custom Layout. 

 

Step 1.  

Select whether the axial slice or the panoramic image should be visible. Set the number of  columns and rows of  
cross sections. At least one cross section is always visible. 

Step 2.  

Select whether the main rendering window division is horizontal or vertical. 

Step 3.  

Click and drag the grey dividing borders to adjust the boundaries of  each view. This affects the resulting size 
of  each view. 

Once OK is clicked, the custom layout is applied. If  another layout is chosen subsequently, the custom 
layout can be reloaded by going to the Layout tool or Change Layout and clicking Load Custom Layout.  
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Section View Features 
The Section View Tab gives the ability to view the X, Y, and Z sections (axial, coronal, sagittal) and user-created, custom sections 
simultaneously for 2D visualization, measurements, and the utilization of  several image enhancement features. TxSTUDIO also 
integrates 3D functions in the Section View Tab. 
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Section: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Section View Tab: 

 

  

Reset: Resets the rendering window to the original view size and the brightness and contrast to the 
preset. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 
number in millimeters automatically displays. Click on the measurement and press the “delete” key 
to delete it. 

 

Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click 
the last point to create an angle. A number in degrees automatically displays. Click on the 
measurement and press the “delete” key to delete it. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of  the 
desired area. Double-click or right-click to end the measurement. A number in millimeters squared 
automatically displays. Click on the measurement and press the “delete” key to delete it. 

 

Polyline Measurement: Select this option and mark any number of  points in the slice view. Right-
click to end the measurement, and the total distance appears.  Clicking on the nodes and moving the 
cursor can modify points. Click on the measurement and press the “delete” key to delete it. 

 

Reorientation: Click this button to re-orient the image. Grab the arrow widgets and rotate the 
image to the desired orientation. 

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 

H.U. Measurement: Calculates the HU value of  an area within a bounding rectangle, circle, or 
ellipse. The measurements display alongside the shape and can also be repositioned by dragging. 
The information updates when the box is moved or if  the user scrolls. 

 

Layout: After clicking on the layout icon, a list of  various layout options appear. Click on the 
desired layout to apply it. 
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Toggle Cursor Visibility: Cycles through available cursor styles and turns cursor on and off. 

 
Information Display: Displays or hides case information embedded in the data. 

 

View Sequence: Allows for the creation of  custom camera sequences and AVI file movie 
capturing. Refer to the Volume Render View Sequence section (pg. 73) for additional 
information and description. 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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Section: Control Panel 

 

Layout: 
• Default: Reset to the original layout. 
• Change Layout: Click to choose custom layout. 
View Control: 
• Brightness & Contrast: Can be adjusted for each of  the 

presets to enhance the image. Clicking and dragging the 
mouse up/down on the 2D views increases/decrease the 
brightness. Clicking and dragging the mouse right/left on 
the 2D views increases/decreases the contrast. 

• Rendering Preset (drop-down list): The presets either load 
a brightness/contrast setting that is optimized for a 
particular tissue type or a color preset. 
• Dental and Grayscale options are available. 
• Color Presets: Allows better visualization of  certain 

anatomic structures, soft tissue profiles, airway, etc. 
The color rendering is only for visualization. The 
colors are based on densities but DO NOT represent 
the density value of  the bone.  

• Sharpening Filter: Applies the selected sharpening filter 
from the drop-down menu to the 2D slice renderers. 

• Slice Thickness: Uses ray sum when reconstructing the 
3D image along each orthogonal plane. 

Additional View: 
• 3D Volume: This option allows 3D volume rendering in 

the fourth corner of  the window. 
• Custom Section: This option allows for the creation of  a 

custom section. 

Custom Section:  
• Click Create to start a custom section. By clicking two points, a customized section can be created 

on any cross section to better visualize anatomy along that axis. The custom section can be 
navigated by clicking and dragging the arrows to rotate, the endpoints to lengthen, or the center 
point to drag the entire section freely.  

• Delete: Removes the custom cross section made in the rendering window. 

Style:  
• Explorer: Allows the user to freehand rotate and move the custom section. The custom section can 

be navigated by clicking and dragging the arrows to rotate, the endpoints to lengthen, or the center 
point to freely drag the entire section. The Explore button automatically rotates the custom section 
about its center at the designated RPM. 

• Line: Allows the custom section to be dragged along the 2D section renderer back and forth in only 
a direction perpendicular to the custom section. 

• Slice Thickness: Adjusts the slice thickness of  the custom section. Slice thickness can also be 
adjusted using the circular handles flanking the center of  the section. 
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3D Volume Clipping: 
• When 3D volume is enabled, this option clips the volume for viewing the internal anatomy. The 

clipping plane is synchronized with section cursors. 
Image Info: 
• Dimension, resolution, and field of  view size are summarized. 
Pointer Coordinates: 
• IJK or XYZ: coordinates give the user the ability to examine the coordinate of  the cursor upon the 

absolute coordinate system. 
• Scalar Value is the gray scale value of  the voxel pointed by the cursor pointer. H.U. or Hounsfield 

unit, is an approximate value of  the voxel calculated by “Rescale Slope” and “Rescale Intercept” in 
DICOM information. H.U. value approximations may not be as accurate if  the CT hardware calibration is off. 
Contact the hardware manufacturer for more information about H.U. accuracy. 

Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display 

Preferences section in Preferences (pg. 21) for more information on which settings are saved for 
this specific tab. 
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Section: Rendering Window 
This window allows viewing of  the X, Y, and Z sections (axial, coronal, sagittal) and custom sections or a 3D view 
simultaneously. This allows the clinician to have very accurate 2D visualization and 2D measurements. 

 

 
 
Scroll wheel: Move mouse pointer to the desired cross section. Use the scroll wheel to move the slice up 
and down. 
 
Cursor: Grab one of  the cursors (axial, sagittal or coronal). Move the cursor in the desired direction. The 
corresponding image is updated. 
 
Center Circle: Pick a point inside the center circle. Move the circle in the desired direction. The other two 
images is updated. 
 
Zoom: Click and hold the left-click mouse button on the image and the “Ctrl” key on the keyboard. Drag 
the mouse cursor up and down to zoom in and out. 
 
Pan: Click and hold the left-click mouse button on the image and the “Shift” key on the keyboard. Drag the 
mouse cursor to move the image. 
 
Brightness: Click on a slice in the axial, sagittal, and coronal views and drag the mouse to adjust the 
brightness and contrast. Dragging the mouse up/down increases/decreases the brightness. 
 
Contrast: Click on a slice in the axial, sagittal, and coronal views and drag the mouse to adjust the 
brightness and contrast. Dragging the mouse left/right increases/decreases the contrast. 
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Section: Light Box 

 

Change Layout has the option to 
change the Section view format to a 
“Light Box” style.  

• The Light Box is composed 
of  4-32 sections of  either 
axial, sagittal, or coronal 
views.  
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Airway View Features 
The Airway Tab visualizes and assesses the properties of  the patient’s airway and nasal cavity and provides additional tools for data 
export and presentations.  
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Airway: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Airway View Tab: 

 
 

  
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

  
¾ Left: Automatically orients the volume in a 45° left view. 

  
Front: Automatically orients the volume in a front view. 

  
¾ Right: Automatically orients the volume in a 45° right view. 

  
Right: Automatically orients the volume in a right sagittal view. 

  
Top: Automatically orients the volume in a top-down view. 

  
Bottom: Automatically orients the volume in a bottom-up view. 

  
Back: Automatically orients the volume in a posterior view. 

  

Distance Measurement: Select this option and mark two points in the view, and the distance 
appears. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. Control Panel features in Volume Render Tab allow the 
values to be projected to 2D, hidden, or exported to a report. 

  

Angle Measurement: Select this option and mark three points in the view and the angle between 
them appears. Clicking on their control points and moving the cursor can modify measurements. 
Click on the measurement and press the “delete” key to delete it. Control Panel features in Volume 
Render Tab allow the values to be projected to 2D, hidden, or exported to a report. 

  

Area Measurement: After selecting this tool, click multiple points along the boundary of  the 
desired area. Double-click or right-click to end the measurement. A number in millimeters squared 
is automatically display. Click on the measurement and press the “delete” key to delete it. 

  

Polyline Measurement: Select this option and mark any number of  points in the view. Right-click 
to end the measurement, and the total distance appears.  Clicking on the nodes and moving the 
cursor can modify points. Click on the measurement and press the “delete” key to delete it. Control 
Panel features in Volume Render Tab allow the values to be projected to 2D, hidden, or exported to 
a report. 

  
Reorientation: Click to change patient orientation.  

  
Arrow Notation: Allows an arrow to be drawn on the image. 

  
Circle Notation: Allows a circle to be drawn on the image. 
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Text Notation: Allows text to be written and edited on the image. 

  
Export Airway Data: If  an airway has been generated, this exports the airway model, graphs, slice 
data, and summary data to the selected folder. 

  
Airway Measurement: Trace the airway spline and calculate the volume, A-P and R-L distances, 
cross-sectional area, and minimum cross-sectional area. (See pg. 64.) 

  
Nasal Measurement: Trace the nasal cavity spline and calculate the volume, A-P and R-L 
distances, cross-sectional area, and minimum cross-sectional area. 

  

Airway Sculpting: Freely outline an area and remove the part of  the airway perpendicular to the 
plane of  the screen. The airway inside or outside the selection can be chosen by clicking in the 
respective areas. 

  
Toggle Cursor Visibility: Cycles through available cursor styles and turns cursor on and off. 

  
Information Display: Displays or hides case information embedded in the scan data. 

  
View Sequence: Allows for the creation of  custom camera sequences and AVI file movie 
capturing. Refer to the View Sequence description in the Volume Render View section (pg. 73) 

 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

  

mailto:support@osteoidinc.com
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Airway: Control Panel 

 

Layout: 
• Slice: Displays the axial and sagittal slices along with the 

3D airway model and graphs if  the selected profile is 
present. 

• 3D: Displays the sagittal slice and 3D volume rendering 
along with the 3D airway model and graphs if  the selected 
profile is present. 

Profile: 
• Create: Create a spline by clicking to place nodes along 

the direction of  the flow of  air. Right-click to finish the 
spline and generate the measurement. (See pg. 64.) 

• After creation, the profile can be modified by clicking on 
it and editing the spline in the sagittal slice. 

Airway: 
• Color Minimum: The minimum cross-sectional area that 

has color, starting with red. Any areas smaller than that 
are in black. 

• Color Increment: How quickly color changes with cross-
sectional area changes. 

• Threshold: The maximum H.U. threshold that the 
software detects as air. The value in the field defines the 
central threshold of  the slider.  

View Control:  
• Brightness & Contrast: Can be adjusted for each of  the 

presets to enhance the image.  
• Sharpening Filter: Applies the selected sharpening filter 

from the drop-down menu to the 2D slice renderers. 
• Slice Thickness: Uses ray sum when reconstructing the 

2D image along each orthogonal plane. 
 

3D Volume Clipping: 
• When the 3D layout is applied, this option clips the volume for viewing the internal anatomy. The 

clipping plane can be adjusted with the mouse scroll wheel. 
Flythrough: 
• Play: Create a flythrough simulation of  the airway. 
• Start/End: Jumps to the start or end position of  the simulation. 
• VIDEO Capture: Exports the flythrough simulation as a video file. 
• Reverse Playback: Reverses the direction of  the flythrough. 
• Perspective: Toggles on perspective projection. 
• Frames/View: Sets the number of  frames for each view. 
• See page 65 for more information. 
Pointer Coordinates: 
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• IJK or XYZ: coordinates give the user the ability to examine the coordinate of  the cursor upon the 
absolute coordinate system. 

• Scalar Value is the gray scale value of  the voxel pointed by the cursor pointer. H.U. or Hounsfield 
unit, is an approximate value of  the voxel calculated by “Rescale Slope” and “Rescale Intercept” in 
DICOM information. H.U. value approximations may not be as accurate if  the CT hardware calibration is off. 
Contact the hardware manufacturer for more information about H.U. accuracy. 

Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display 

Preferences section in Preferences (pg. 21) for more information on which settings are saved for 
this specific tab.  
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Airway: Rendering Window 
This window displays the axial and sagittal 2D slices along with the 3D volume, model object, and graph data 
depending on the layout selection and if  an airway or nasal cavity has been created. 

 

 
 
Slice view: Axial and sagittal slices are available. Airway measurement is created in the sagittal slice. Profiles 
are displayed after measurement creation. Clicking on the airway subsequently displays the edit widget. 
 
3D volume view: The 3D volume can be manipulated as in other tabs. If  an airway measurement is present, 
a 3D volume is displayed.  
 
Airway model view: The 3D airway object can be manipulated similarly to the volume rendering. Total 
volume and minimum area values are displayed. 
 
Graphs: Anterior-posterior and right-left measurements and the cross-sectional areas of  each slice of  the 
airway are graphed relative to position along the airway spline. Click on the area of  the graph to find the 
corresponding slice in the airway and display specific numerical data. 
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Airway: Airway Measurement 

 
Airway Measurement: Selecting the icon displays the dialog box below. Click OK to continue. 

 

 

 
Tracing the Profile: 

• Use the scroll-wheel to locate the mid-sagittal 
plane. 

• Pick points along the airway to define the 
measurement path with the left-click button. 

• Right-click when finished. 

 

Viewing the Volume Measurement: 
• TxSTUDIO converts the profile tracing into a 

volume rendering and superimpose it onto the scan 
data. 

• The minimum cross-sectional area and total volume 
are displayed next to the airway measurement. 

• The color range and threshold can be adjusted in 
the Control panel. 

• The measurement data can be hidden by checking 
the box for “Hide All Values” in the Control Panel. 

• The airway volume and measurement values can be 
deleted by left-clicking once on the volume, then 
pressing “delete” on the keyboard. 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of  the 
imaging, there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off  scale H.U. The 
software measurement tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the 
measurement value depends on threshold values; thus, user must set proper thresholds to get the best estimate of  the 
desired structure. The measurements must not be used as the sole metric for any treatment. 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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Airway: Flythrough 
After the creation of an airway or nasal cavity measurement, a flythrough simulation can be created. Click “Play” in the 
Flythrough section of the Control Panel. A view sequence following the airway spline is automatically generated. The 
sequence can be played and reversed, and the speed and smoothness can be adjusted through the Frames/View 
parameter. Perpective camera view can be toggled on if  desired. 

 

 
 
Once the sequence is adjusted, it can be exported as a video file through the “VIDEO Capture” button. 
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Volume Render View Features 
The Volume Render Tab shows the patient in three-dimensionally reconstructed views and allows for the exploration of  internal 
structures and never-before-seen views of  the patient. 
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Volume Render: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Volume Render View Tab: 

 
 

  
Reset: Resets the rendering window to the original view size. 

  
Left: Automatically orients the volume in a left sagittal view. 

  
¾ Left: Automatically orients the volume in a 45° left view. 

  
Front: Automatically orients the volume in a front view. 

  
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

  
Quick Zoom: Click the zoom icon, then the point on the volume to zoom in. Use Reset View icon 
to go back to normal size. 

  
Slice Explorer: Once activated, clicking on a point on the volume opens a 2D zoom window in 
that location. The zoom window can be scrolled through using the mouse wheel. 

  

Freehand Sculpture: Freely outline an area and remove the volume perpendicular to the plane of  
the screen. The volume inside or outside the selection can be chosen by clicking in the respective 
areas.  

  

Polygon Sculpture: Outline an area by placing a series of  points and right-clicking. The volume 
perpendicular to the plane of  the screen is removed. The volume inside or outside the selection can 
be chosen by clicking in the respective areas. 

  

Marker: Select this option to mark a point on the volume and X, Y, Z coordinates (axial, sagittal, 
vertical) appear. Clicking on the point and moving the cursor can modify points. Click on the point 
and press the “delete” key to delete it. Control Panel features allow the values to be hidden or 
exported to a report. 

  

Distance Measurement: Select this option and mark two points on the volume, and the distance 
appears. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. Control Panel features allow the values to be projected to 2D, 
hidden, or exported to a report. 

  

Angle Measurement: Select this option and mark three points on the volume and the angle 
between them appears. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it. Control Panel 
features allow the values to be projected to 2D, hidden, or exported to a report. 
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Polyline Measurement: Select this option and mark any number of  points on the volume. Right-
click to end the measurement, and the total distance appears.  Clicking on the nodes and moving the 
cursor can modify points. Click on the measurement and press the “delete” key to delete it. Control 
Panel features allow the values to be projected to 2D, hidden, or exported to a report. 

  
Volume Measurement: This button opens the volumetric measurement window. 

  
Quick Measurement: Click to activate a ruler at the tip of  the cursor. Click again to turn off. 

  
Reorientation: Change the patient orientation. See page 71. 

 
Comment Marker: Pick a point in the volume and enter comments. Type the desired text label and 
press OK. 

  
Grid: Toggles between four different grid layouts for simple assessment of  size, measurement, and 
spatial location. 

  
Information Display: Displays or hides case information embedded in the scan data. 

  
View Sequence: Allows for the creation of  custom camera sequences and AVI file movie 
capturing. Refer to the View Sequence description (pg. 73). 

  
Settings: Allows option to view either parallel or perspective views in 3D. 

 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

  

mailto:support@osteoidinc.com
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Volume Render: Control Panel 

 

Rendering: 
Different methods of  rendering can be selected as needed. 
• Method: “Performance” is fast but there are some 

rendering artifacts. “Quality” gives the highest level of  
detail, but response is slower. “Default” is in between the 
other two options.  

• Reconstruction: There are three possible reconstruction 
methods: Volume Rendering, Maximum Intensity, and X-
ray.  

View Control: 
• Color Presets: Gray Scale, Inverse, Soft Tissue 1, etc. allow 

better visualizations of  certain anatomic structures, soft 
tissue profiles, airway, etc. This is achieved by displaying 
specific densities with specific colors.  

• Opacity: Allows for the translucency/opacity to be 
adjusted. 

• Brightness & Contrast: Can be adjusted for each of  the 
presets to enhance the image.  

Clipping: 
• Click the “Enable Clipping” box to slice the image along 

the predefined anatomical planes (sagittal, axial, coronal, 
and arch). 

• Scrolling the mouse wheel or slider moves the clipping 
plane. 

• To switch a view to the opposite side, click “Flip.” 

Measurement: 
• Measurements can be projected as 2D values or hidden by 

clicking the appropriate box. 
• Delete All deletes all measurements within the rendering 

window. 
• Report exports the values and annotations to a .CSV file 

for viewing and/or performing computations as a 
spreadsheet. 

Annotation: 
• Edits selected comment/annotation in the text field. 
• You can toggle added comments on/off  by selecting “Visible.” 
• Layout: Sorts all added comments in the rendering window based on selected setting (Horizontal, 

Stick to Point, User Dragged, Vertical, Vertical Spread Straight, Vertical Spread Polynomial). 
Visibility: 
• Nerves, Stone Models, Implants, etc. visibility can be toggled on and off. 
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Volume Render: Rendering Window 
One of  the most powerful features of  TxSTUDIO is the remarkable rendering quality and speed at which the 
software works. The simplicity of  this window is that it only displays the volume, patient information (if  desired), 
and the opacity, brightness and contrast values. 

 

 
Please refer to Image Navigation (pg. 37) for information about controlling 
and adjusting these images. 

 
 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

 
 
  

mailto:support@osteoidinc.com
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Volume Render: Reorientation 
The reorientation tool provides the user a way to orient the volume using references lines as well as to reset the 
image to the default coordinate system. 

• After selecting the reorientation icon in the toolbar, left-click and drag each reference line to the 
approximate proper location on the volume (ex. Frankfort Horizontal in sagittal view).  

• If  the patient orientation had previously been adjusted, the tool provides the options to reset to the 
default orientation of  the scan or to adjust the current orientation. 

• Left-click and drag the rotation handles to rotate the volume to match the reference line. 

• Rotate the volume to visualize the rotation widgets on the other axes. 
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Volume Render: Volume Measurements 

 

The Volume Measurement tool can be used to estimate displaced volume (cc or cubic millimeters) of  a 
specific anatomical structure. The desired anatomical structure must first be isolated by sculpting.  

Then, press the Volume Measurement  button. A new window opens, and the volumetric 
measurement value is displayed. Finally, the threshold values can be adjusted to obtain desired 
measurements. The volume measurement function is linked to rendering; the Inverse rendering preset can 
be used to take volumetric measurements of  air. 
 
 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of  the 
imaging, there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off  scale H.U. The 
software measurement tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the 
measurement values depend on threshold values; thus, user must set proper thresholds to get the best estimate of  the 
desired structure. The measurements must not be used as the sole metric for any treatment. 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

 

 

mailto:support@osteoidinc.com
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Volume Render: Movie Capturing and Customized View Sequences 

 

 

  View Sequence: 
• Create sequences by clicking on Insert for each step 

the volume transitions through.  
o For a movie that spins the volume left to right, 

and then turns up for a submental view, a 
frame should be inserted for each major view, 
and the View Sequencer connects the positions 
in a seamless movie. 

• Multiple, different rendering presets can be 
integrated so that the sequence changes not only in 
position but also in colorizations. 

• Video sequences can be saved for future use and 
then loaded using the Load and Save As buttons 
under Sequence File. 

• Click on VIDEO Capture to open a dialog to 
customize and save the movie file. 

 

Movie Capture: 
The VIDEO Capture button allows for customization, capturing, 
and exporting of  an AVI (movie) file of  the volume rendering 
sequence. 
 
• Select Change to determine the AVI file name and 

save location. 
• Set the frames/view and frames/sec to desired 

values. 
o More frames/view make the video smoother. 
o More frames/sec make the video run faster. 

• Add an ending logo by selecting Browse and 
choosing an image file to display at the end of  the 
video. 

o Select “Add Logo” to add the ending image. 
o Set the duration and background color. 

• Click Capture once everything is set up to 
automatically export the video to the specified 
location with the specified name. 
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Implant View Features 
The Implant View Tab contains the full-featured implant planning module. 
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Implant: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Implant View Tab: 

 

 
Reset: Resets the rendering window to the original view. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume and distance 
appears. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. Control Panel features in Volume Render Tab allow the 
values to be projected to 2D, hidden, or exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle 
between them appears. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it. Control Panel 
features in Volume Render Tab allow the values to be projected to 2D, hidden, or exported to a 
report. 

 

Add Implant: Select the Tooth ID for the implant, mouse over the implant site, and left-click the 
mouse to place the implant. Note: specific manufacturers measure the implant from different 
points, so a measurement in the software might not be the same as the actual measurement of  the 
specific implant design. 

 
Toggle Move Widget: Toggles the implant orientation widget on and off. 

 
Implant Angle Dialog: Opens a window displaying all the angles between placed implants.If  an 
angle is clicked, the volume is rotated to view the angle, and the relevant implants are highlighted. 

 
Density Profile Control: Adjust the settings for the displayed density profile around planned 
implants. 

 

Treatment Lock: Locks the implants in place so that they are not accidentally moved when 
viewing the 3D images. 
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Check Sleeves: The program searches for collisions between the sleeves, instruments, and stone 
models. 

 
Bone Graft: Simulates a bone graft near the apex of  an implant and displays its volume. 

 
Change Model Visibility: Allows various models to be turned on or off  from view. 

 

Create Summary: Creates an Implant summary of  images that is added to the Gallery. Images 
contain ID (FDI), implant product, diameter, and length information in the lower right-hand corner 
of  the screenshot. The user is also given an option to print a reference chart which lists the implants 
placed (including implant site, manufacturer, product name, diameter and radius) for each arch. 

 
Layout: Toggles the rendering window layout. 

 
Grid: Toggles between two different grid layouts for use in the upper two section frames allowing 
quick assessment of  measurements and spatial location. 

 
Information Display: Displays or hides case information embedded in the data. 

 
View Sequence: Opens a dialog that provides view sequence presets to create a video. 

 
Settings: Adjust the tooth system type, clipping preferences, collision and surrounding parameters, 
rendering quality object colors, and implant library settings. 

 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

 

Warning: Any implants and restorations that are incorrectly visualized in Restoration Design Studio may lead to surgical 
complications or treatment delays. If  you notice any inconsistencies or software problems with implant or restoration planning or 
have further questions or concerns, please contact Osteoid support at (408) 333-3484 or email us at support@osteoidinc.com 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off  of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problems with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Osteoid support at (408) 333-3484 or 
email us at support@osteoidinc.com 

 

 

mailto:support@osteoidinc.com
mailto:support@osteoidinc.com
mailto:support@osteoidinc.com
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Implant: Control Panel 

 

Add Implant: 
• Select one or more implants for placement. 
• Maxillary and mandibular parallelism can be enabled. 
• Place each implant in in the 3D volume. 
• Adjust the implant orientation and placement using the 

move widget that appears on the selected implant. 

Planning Layout: 
• 3D Implant: Place and adjust individual implants on 3D 

volume and 2D slices. 
• Pano Implant: Click and drag implants into the panoramic 

image. Selective parallelism can be configured in this view.  

Restoration: 
• Add All: Adds default restorations to all the implants. 
• Remove All: Removes all restorations. 
• Edit: Transfers the current progress to the Restoration 

Tab for advanced crown placement and design. See the 
Implant: Advanced Restoration Design section (pg. 85) 
for more information. 

• Lock to Implant: When selected, the implant and 
restoration move as a single unit. 

View Presets: 
• Setup: Opens a dialog where the view presets can be 

configured. 
• Presets: Preset toggles that display the selected features as 

configured in the Setup. 
• Upper/Lower: Toggles the visibility of  the stone models 

if  present. 

View Control: 
• Rendering Types: Different settings allow for better visualization of  certain anatomic structures, 

soft tissue profiles, hard tissue, etc. This is achieved by displaying specific densities with specific 
colors. 

• Brightness & Contrast: Can be adjusted for each of  the presets to enhance the image. 
• Visible: Allows the 3D Volume Rendering to be turned on or off  from view. 
• Remove Crown: Only applicable with surgical guide-related modeling service options. 
• Tru-Pan™: This option enables the one-click volumetric pan that can be created from scans 

taken by an i-CAT© Cone Beam 3D system.  
• Sharpening Filter: Applies the selected sharpening filter from the drop-down menu to the 2D 

slice renderers. 
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Clipping: 

• Click the “Enable Clipping” box to slice the image along the predefined anatomical planes 
(sagittal, axial, coronal, and arch). Scrolling the mouse wheel or moving the slider moves the 
clipping plane. To switch a view to the opposite side, click “Flip.” 

Implant: 

• The implant section can be configured to only show specific implants as defined by the user. For 
more information, look at the Preferred Implant settings further in this section. 

• ID: Use the drop-down menu to select an implant to manipulate. The active implant appears 
lighter in color than the others. 

• Manufacturer, Product Name, Diameter, and Length: The default is generic, but the specific 
implant manufacturer, product, diameter, and length can be selected. 

Annotation: 

• Edits selected comment/annotation in the text field. 
• You can toggle added comments on/off  by selecting “Visible.” 

Save View Settings 

• Saves the current 2D view settings to be reloaded upon opening any case. See the Display 
Preferences section in Preferences (pg. 21) for more information on which settings are saved 
for this specific tab.  
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Implant: Rendering Window 

 
Used for more precise control and final detailed touches to implant treatment planning. Use the navigation 
features discussed below to visualize all aspects of  the implant in the 3D volume. For further information on 
implant position and sizing using the implant widgets, please refer to the next section of  the manual.  

Axial Section: Top left window. This section is the view from the top of  the implant. The yellow line passing 
through the axis creates the view seen in the sagittal view. Scrolling the mouse wheel after clicking inside the axial 
window, or clicking and dragging the line changes the cross section seen in the sagittal view as the line rotates 
about the axis of  the implant. Asymmetrical (STL) implants can be rotated about the long axis in this view (see 
the next section). 

2D Section: Middle left window. The A-B line passing through the implant creates the cross-section view that 
appears in the axial view and is set by default to be positioned at the level of  the implant emergence point. 
Scrolling the mouse wheel after clicking inside the sagittal window, or clicking and dragging the line changes the 
cross section seen in the axial view. The implant widget in this view allows for quick resizing of  implant length 
and diameter (see the next section). 

Density Profile: Lower left window when turned on. Displays a real-time visualization of  the volume density 
immediately surrounding the implant. 

Volume Rendering: Right window. This frame allows user to change the implant position and orientation with 
the orientation widget within the 3D volume rendering. 

 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off  of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problems with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Osteoid support at (408) 333-3484 or 
email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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Implant: View Preset Setup 
Visibility presets allow for easy switching between set views during implant planning. To configure these settings, 
click on Setup. These presets may also be modified in the Restoration Tab. 

 

• Edit Name: Click on any preset to select it. Type the 
new name into the field. 

• Visibility checkboxes hide or show features in the 
rendering window. 

• Implant Profile: Controls the visibility of  the solid 
implant cross section in the 2D renderers. When 
activated, the currently selected implant has a red profile 
and the unselected implants have blue profiles. When 
not activated, the selected implant shows an opaque 
cross section of  the implant, and the unselected 
implants show as blue profiles. 

• Abutment: Controls the visibility of  the abutment 3D model in the volume renderer or the colored 
profile in the 2D slice renderers. 

• Waxup: Controls the visibility of  the profiles in the 2D renderers and 3D models on the volume. 
Option is only available after they have been added by an Osteoid technician as part of  a surgical guide 
case workup.  

• Long Axis: Displays a colored rod running through the long axis of  the implant in the volume render. 
• Surrounding: Displays the surrounding volume around an implant. The collision zone is determined by 

the allowance defined in the preferences. 
• Trajectory: Displays the simulated trajectory of  the implant during surgical placement. 
• Sleeve: Controls the visibility of  the profiles in the 2D renderers and 3D models on the volume. Option 

is only available if  the mandibular and maxillary models are available as well as after the Check Sleeve 
action has been performed.  

• Nerve: Displays a 3D nerve in the volume render or a cross section of  the nerve in the 2D section 
renderers. 

• Angle: Controls the visibility of  the angle between the long axes of  adjacent implants as well as the 
angles of  the abutment for each implant. 

• Model: Controls the visibility of  the stone models. Varying degrees of  transparency can be obtained 
with the Opacity slider. 

• Restoration: Controls the visibility of  the 3D waxup models in the volume renderer and the colored 
profile in the 2D section renderer. The colored profile of  the selected restoration or restoration 
associated with the selected implant is red while the unselected restorations are pink. Varying degrees of  
transparency can be obtained with the Opacity slider. 

• Volume: Controls the visibility of  the volume render as well as the rendering type. 
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Implant: Model Visibility 

The  Change Model Visibility function opens the Model Object 
Settings dialog.  

• The “Mandible” and “Maxilla” checkboxes control all of  the model 
visibility options (except Profile Only and Density) and allow the 
user to turn off  the set of  models for each jaw independently. Note: 
The visibility checkboxes in Model Object Settings do not always match the 
checked/unchecked status of  the visibility checkboxes in the Control Panel. 

• The Stone Model and Waxup Opacities can be adjusted for both 
jaws. 

• The Sinus Graft option toggles the visibility of  the bone grafts 
present in the case.  

Implant: 3D Implant Widget 

The  3D implant widget is designed to optimize visibility in the 
renderer and provide a high level of  versatility in implant positioning. 
The linear, colored arrows can be dragged to reposition the implant 
transversely. These arrows only appear when the camera perspective is 
close to orthogonal. The implant may also be moved along these 
directions using the keyboard arrow keys. 

• The yellow arrow (not shown) is parallel to the A-B line. 
• The blue arrow is orthogonal to the green and yellow arrows. 
• The green arrow runs through the long axis of  the implant. 
• The rotation circle appears on the same plane as the two arrows that 

are close to orthogonal to each other and to the camera perspective 
and features eight handles for rotation. 

 

Implant: 2D Implant Widget 
The 2D implant widget is designed to optimize visibility in the slice 
renderer and provide a high level of  versatility in implant positioning and 
sizing. The implant may also be moved along its long axis or orthogonally 
with the keyboard arrow keys. 

• The rotation circle has eight arrows for implant rotation along the 
same plane as the currently displayed slice. 

• The two red handles can be selected and dragged toward/away from 
the implant to reduce/expand the diameter of  the implant 
sequentially through any available options for that implant model. 

• The two blue handles can be selected and dragged toward/away from 
the implant to reduce/expand the length of  the implant sequentially 
through any available options for that implant model. 

• The implant model itself  can be selected and dragged in any direction 
along the same plane as the currently displayed slice. 

• A rotation circle appears when the product cross section is selected 
that allows for implant rotation about the long axis of  asymmetrical 
(STL) implants in the top left section renderer. Please contact Osteoid 
for an updated list of  asymmetrical (STL) implants. 
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Implant: 3D Implant Planning 
 

• In the Control Panel, click the Add Implant button.  
• The implant ID dialog shows up (image below). 
• Select the implants to be inserted. Press OK, and an implant and its ID appear on the mouse pointer. 
• Drag and drop each implant in 3D view onto the surgical site. (It helps to have the volume rotated so that the 

surgical site is centered.) 
• In axial view, align the yellow line such that the lower cross-section view becomes the view along mesiodistal 

direction. 
• In cross-section view, re-orient and position the implant so that its angle is as desired. 
• In axial view, align the yellow line such that the cross-section view becomes the view along the buccolingual 

direction. 
• In cross-section view, re-orient and position the implant so that its angle is as desired. 
• Review the final implant position in 3D view. 

o To delete an implant, select the desired implant in the 3D view and press the “delete” key on the 
keyboard. The implant is removed. 

 
A similar procedure can be done to add anchor pins to the 3D volume. Select which anchor, and follow similar 
steps for adjusting its position. 

 

 

 

 

Warning: Automatic nerve canal estimation is an estimation of  the nerve canal and may not reflect the actual nerve. It is 
not intended for use in treatment planning, and collision detection is not applied to the automatic nerve. 
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Implant: Pano Implant Planning 

 

• Select Planning Layout: Pano Implant under 
the Control Panel in the Implant Tab. 

• Rendering window updates to pano view (left). 
• Adjust the ArchSection focal trough such that 

the middle profile passes through the 
dentition.  

• Drag implants to their desired locations and 
adjust their angles. 

• Click to select implants and manipulate them 
in the cross sections. 

• Click the nodes above the implant identification numbers and drag to connect them with other implants 
to create parallel implant groups. Remove the implants from these groups by clicking on the nodes again. 

• Repeat for all desired implants. 
• Select Planning Layout: 3D Implant to exit Pano-Mode and further adjust individual implants. 

 

 
 

  
 

Warning: Automatic nerve canal estimation is an estimation of  the nerve canal and may not reflect the actual nerve. It is 
not intended for use in treatment planning, and collision detection is not applied to the automatic nerve. 
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Implant: Bone Graft Simulation 

• Select the implant that requires a bone graft and click the Bone Graft tool . 
• The graft simulation tool appears as an arc that moves along the central axis of  the implant in the cross 

section. 
• Click to place the graft in the desired position. 
• The resulting graft appears in the 2D sections in blue and in the volume rendering in off-white. 
• The volume of  the graft is displayed in the volume rendering. 
• The graft can be deleted by clicking on it to select it and pressing the “delete” key on the keyboard. 

 

  

 

 

 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of  the imaging, 
there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off  scale H.U. The software measurement 
tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the measurement value depends on threshold 
values; thus, user must set proper thresholds to get the best estimate of  the desired structure. The measurements must not be used 
as the sole metric for any treatment. 

   

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or actual 
treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of  all measurement tools. Measurement accuracy depends on the image data and the hardware scanner 
that generated the image data. The measurement cannot be more precise than the resolution of  the image. Software reports the 
value based on user-picked points. Due to the nature of  medical imaging, the boundary is not always well defined. The apparent 
boundary depends on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to 
brightness and contrast. The user must understand the limitation of  the measurement value before applying to the patient. If  you 
notice any inconsistencies or software problems with measurements, or have further questions or concerns about using 
measurement tools correctly, please contact us at (408) 333-3484 or email us at support@osteoidinc.com 

  

mailto:support@osteoidinc.com
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Implant: Advanced Restoration Design 
TxSTUDIO features advanced restoration design functions located in the Restoration Tab (see the 
Restoration section for more information on this tab, pg. 130). Compatibility between files saved in 
different TxSTUDIO versions can cause certain behaviors that accommodate this new functionality, as 
described below: 
 
Scenario: 

1. Opening an Invivo file saved with implants 
from any earlier version, but no 
restorations: 

 

Consequence: 
1. The implant workup is loaded, and the user is 

able to add restorations from the Restoration 
teeth library. 

2. Opening an Invivo file saved in TxSTUDIO 
5.3 or a later version with an implant and 
restoration workup in earlier versions of  
TxSTUDIO: 
 

2. The earlier versions of  TxSTUDIO are not  
able to display the restoration crowns in the 
Implant or Model Tabs. 

3. Opening an Invivo file containing a 
restoration workup from any version prior 
to 5.3: 
 

3. All implants placed are present, but any 
restorations that were added will not be 
displayed. 

 
Implant: Adding Restorations 
 
Restorations can be added directly to all the implants 
using the Add All button. A default restoration is 
placed on each implant that does not yet have a 
restoration.  
 
The Remove All button removes all the placed 
restorations.  
 
Clicking on a restoration turns on a widget that 
allows for adjustment of  the size and angulation of  
the restoration. The restoration can also be clicked 
and dragged for repositioning. The Edit button 
presents the option to do further editing in the 
Restoration Tab. Locking the restorations to implant 
automatically moves the restorations when the 
implants are moved. Restorations may also be added, 
edited, or removed in the Restoration Tab (see 
Restoration section for more information, pg. 130). 
The Restoration Tab view is synchronized with the 
Implant Tab view for ease of  editing between the 
two tabs. 
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Implant: Check Sleeves 

 

The  Check Sleeves function can be performed to determine the position of  where sleeves would be if  a 
surgical guide was produced for implant placement. This function simulates possible collisions that may occur 
between: 

• Sleeves and other sleeves 
• Sleeves and the instrument 
• Sleeves and the stone model 
• Instrument and the stone model 

Interference: Demonstrated visually by a dark red-colored sphere. These interference indicators are not 
updated in real-time and are only rechecked after each instance that Check Sleeves is performed.  
 

 
Check Sleeve Interference: The user can 
change certain preferences to better simulate 
the actual procedure that will be performed, 
such as sleeve system, instrument, sleeve size, 
and drill. Solution options are to change 
implant planning, change sleeve preferences, 
or to allow a technician to try to resolve the 
interference. 
  

The option to check sleeves automatically appears when attempting to save Invivo Surgical Guide planning 
files.  
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Implant: View Sequencer 

 

 

• The  implant view sequencer is a movie-creating tool that contains both an axial and buccal (shown 
above) preset sequence of  view positions and rotations.  

• The sequence is adapted to be used with any case and immediately played as a preview. 
• A movie file (.avi) that resembles the preview can be captured. 
 

 

 
 
View Sequencer 

 

 
 
 
Animation 

• Animate: Set the sequence to animate the placement of  
implants, abutments, and restorations. 

• Clipping: Set the sequence to include the preset 
clipping actions. 

Camera 
• Orientation: Set the orientation to be axial or buccal. 
• Zoom: Set the zoom level of  the rendering window 

(None, 1.5X, 2.0X). 
View Sequence Player 

• Slider: Shows the current progress through the video 
while allowing navigation through the preview by 
clicking and dragging. 

• Stop: Stop the preview. 
• Play/Pause: Starts the video/pauses the 

video/resumes the video. 
• Playback speed: Speed of  playback (slow, medium, 

fast). 
• Frames per second: Sets the smoothness of  the 

preview playback. 
• Loop: Sets the preview to loop at the end of  playing 

the sequence. 
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Action 
The current view sequence can be captured into a movie file. 

Movie File Location 
Choose the location to save the file by clicking Change. 

Available Codecs Installed In This Computer 
Choose from a drop-down list of  the available codecs 
installed on the computer. Click Configure to choose from 
more recording options. 

Video Frames and Playing Time 
• Seconds/Implant: Length of  sequence for displaying 

each implant. 
• Frames/Sec: Smoothness of  the video. 
• Total Play Time: Calculates the total play time for the 

options selected. 
Ending Logo 

• Image File: Click Browse to select the location of  the logo file. 
• Add Logo: Select the checkbox to add in a logo segment to the movie. 
• Duration: Set the length of  time to show the logo. 
• Background: Set the background color for the logo segment. 

Capture 
Creates a video file from the selected sequence and video recording settings. Click Cancel to exit this 
dialog without recording the video. 
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Implant: Settings and Preferences 

Selecting the Setting tool  opens up a customization window within the Implant Tab: 

 

Tooth ID System: 

Set the ID to either the Universal or FDI (International) standard. 

Clipping Preference: 

Options for which models to include in volume clipping. 

Show Collision Warning: 

Define whether or not to display a proximity warning between implants at an allowed tolerance. 

Rendering Method: 

Choose the rendering method (Default, Performance, and Quality) to be used in the Implant Tab. 

Color Control: 

Set the various colors for the abutment, restoration, and collision colors. 

Detailed Implant Settings: 

Adjust default settings for individual implants. See more information below. 

Preferred Implants Settings: 

Used to modify which implants are displayed in the drop-down menus in the Control Panel. See more 
information in the Preferred Implant Settings section (pg. 90). 

Update Implant Library: 

Check STL implant library update availability and download them directly.   
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Detailed Implant Settings 
In Detailed Implant Settings, the default settings of each placed implants can be set. 

 

 
Clicking once anywhere in 
the region above activates 
drop-down menus for the 
various implant 
characteristics. Options do not 
appear for implants not in the 
preferred list (see below). 

 
Click OK to save these preferences and the designated implant will be selected automatically when choosing a tooth in 
the Add Single Implant menu. 
 
Preferred Implants Settings 
The user can hide certain implants from populating the lists to simplify the drop-down menus. By default, all 
implant manufacturers and types are selected as “preferred.” To remove an implant, select it in the list on the 
right-hand side and use the left arrow button to remove it from the list.  

 

These settings apply to drop-
down menu options for Detailed 
Implant Settings as well as in the 
Implant section of  the Control 
Panel. If  there is a case open with 
implants that are not in the 
preferred list, the implant will still 
show up correctly in the renderers 
and the Control Panel. However, 
the specific settings for this 
implant cannot be changed and 
implants of  the same type cannot 
be added. 

Adding implants to the preferred list can be accomplished by selecting the implant manufacturer on the list on the 
left-hand side, selecting the specific product in the middle column, and pushing the right arrow button to add.  

Certain manufacturers are divided into guided and non-guided subsets to indicate compatibility with the Invivo 
Surgical Guide kits. 
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Update Implant Library 
Due to the size of  STL implants, most implant library updates 
hosted online or within the installer do not contain these implants. 
This function allows the user to select specific STL libraries as 
desired. Available updates for the listed manufacturers are 
indicated in the Update column. Select the desired manufacturers 
and click Update to download the library into the software. 
Restart the software to apply the updates. 

 
 

Density Profile Control 

Select the Density Profile Control tool  to adjust the settings for the Density Profile. 
 

 

Visible: Toggles the visibility between the Density Profile and the 
third cross section. 

H.U.: Shows the bone density in Hounsfield units. 

Bone Density: Shows the density in Misch’s bone density units. 

Thickness: Changes the sampled volume located around the 
implant. 

Apical Space: Changes the sampled volume located at the apex of  
the implant. 

Cell Size: Changes how finely the voxels are sampled and 
displayed in the volume around the implant. 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
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contact us at (408) 333-3484 or email us at support@osteoidinc.com 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based off  of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problems with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Osteoid support at (408) 333-3484 or 
email us at support@osteoidinc.com 

 

  

mailto:support@osteoidinc.com
mailto:support@osteoidinc.com
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Restoration View Features 
The Restoration View Tab is an advanced tool that bridges the gap between implantology and restoration crown design. Users can 
register the stone models and add teeth directly or onto existing planned implants. With the model collision visibility options, numerous teeth 
libraries, and mesh editing features, this tab guides implant surgery toward perfect occlusion.  

 



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 94 of 256 UM-TXS-ENG-71 

Restoration: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Restoration View Tab: 

 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume, and the distance 
appears. Clicking on the point and moving the cursor can modify points. Click on the 
measurement and press the “delete” key to delete it. Control Panel features in Volume Render Tab 
allow the values to be projected to 2D, hidden, or exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and angle between 
them appears. Clicking on their control points and moving the cursor can modify measurements. 
Click on the measurement and press the “delete” key to delete it. Control Panel features in Volume 
Render Tab allow the values to be projected to 2D, hidden, or exported to a report. 

 
Comment Marker: Pick a point in the volume and enter comments. Type the desired text label 
and press OK. 

 
Show Collision: Turns on/off  the collision between teeth restorations and the 
opposing/working stone models or restorations. 

 
Show inter-arch collision: Turns on/off  the visibility of  collisions between the stone models. 

 
Area Drag: Turns on the area drag tool in the rendering and the single tooth renderer windows. 

 
Push mesh: Turns on the push mesh tool in the rendering and the single tooth renderer 
windows. 

 
Pull mesh: Turns on the pull mesh tool in the rendering and the single tooth renderer windows. 

 
Smooth mesh: Turns on the smooth tool in the rendering and the single tooth renderer windows. 
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Auto collision resolution: Turns on the auto collision tool in the rendering and the single tooth 
renderer windows. 

 
Plane Cutter: Activates a polygonal cutting tool to cut and close the mesh of  stone models in the 
rendering window. 

 
Cap Model: Applies a capping function to the available open mesh stone models. 

 
Tooth Extraction: Enables a polygonal mesh cutting tool for use on a stone model in immediate 
extraction cases. 

 
Adjust Occlusion: Turns on the stone model adjustment widget for manually moving the stone 
models and their dependent restorations in the rendering window. 

 
Articulation: Opens the Articulation dialog to open/close the jaws with a simulated biting 
motion. 

 
Fit to Custom Abutment: Opens a dialog to adjust the interface between a restoration and a 
custom abutment.  

 
Fit to Margin: Opens a dialog to adjust the interface between a restoration and a prepped tooth 
on the stone model. 

 
Custom Abutment: Opens a dialog that provides options for abutment design.  

 
Create Pontic with Gingiva: Opens a dialog to modify the base of  a pontic to fit to or offset 
from the stone model. 

 

Create Bridge Connector between Selected Restorations: Creates a bridge linking all of  the 
selected restorations. This bridge group can be deleted and converted back into the individual 
restorations. 

 
Export Restorations: Export restorations as a single STL or individual STL files. 

 
Layout: Toggles the rendering window layout. 

 
Grid: Turns on/off  the 2D grid for simple assessment of  size, measurement, and spatial location. 

 
Information Display: Displays or hides case information embedded in the data. 

 
Settings: Opens the Preferences dialog for selecting color, collision, and default tool size settings.  

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

  

mailto:support@osteoidinc.com
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Restoration: Control Panel 

 

Import Stone Models 
• Initiates a sequence of  steps to import and register a stone model. 

For more information, see the Restoration: Stone Model 
Registration section (pg. 99). 

Stone Model Registration 
• Opens the Register Stone Models to Volume dialog to restart the 

registration for the imported stone models. 
• Use Original Registration for Articulation: When the Articulation tool 

is active, this option toggles between the stone models’ default 
positions and the registered positions. 

Restoration Management 
• Add New…: Opens the teeth library for restoration selection 

and placement. 
• Edit…: Opens the teeth library to change the currently selected 

restoration. 
• Mirror: Duplicates and mirrors the selected restoration. 
• Change ID: Changes the ID associated with the restoration. 
• Delete: Removes the currently selected restoration from the 

rendering window. 
Restoration Editing 

• M-D Size (mm): Adjusts the mesiodistal dimension of  the 
restoration. 

• B-L Size (mm): Adjusts the buccolingual dimension of  the 
restoration. 

• Height Size (mm): Adjust the height of  the restoration. 
• Cuspid: Adjusts the cusp dimensions from low to high. 

Visibility 
• Maxilla: Adjust the visibility/opacity of  the maxilla. 
• Mandible: Adjust the visibility/opacity of  the mandible. 
• Restoration: Adjusts the opacity of  the restorations. 
• Setup: Opens a dialog where the view presets can be configured. 
• Presets: Preset toggles that display the selected features as 

configured in the Setup. 

Collision  
• Teeth: Turns on the visibility of  collisions between the restorations and the opposing/working stone 

model or restorations. 
• Arch: Turns on the visibility of  collisions between the stone models.  

 

Warning: Any implants and restorations that are incorrectly visualized in Restoration Design Studio may lead to surgical 
complications or treatment delays. If  you notice any inconsistencies or software problems with implant or restoration planning or 
have further questions or concerns, please contact Osteoid support at (408) 333-3484 or email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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Volume 
• Brightness & Contrast: Can be adjusted for each of  the presets to enhance the image. 
• Visible: Turns on/off  the visibility of  the DCM volume. 
• Axial Clipping: Turns on/off  axial clipping and the Axial Clipping widget. 
• Rendering (drop-down): Chooses the rendering preset between the options of  Teeth and Bone. 
• Flip: Flips the clipping direction. 
Lock Implant to Restoration: When selected, the implant and restoration move as a single unit. 
Annotation:  
• Edits selected comment/annotation in the text field. 
• You can toggle added comments on/off  by selecting “Visible.” 
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Restoration: Rendering Window & Mesh Manipulation 

 

Rendering Window:  
• Displays the stone models, restorations, patient volume, implants, and skin models.  
• The restoration can be moved by first left-clicking to select the tooth and then left-clicking and dragging 

the model to a new location from any view. The angle in which the tooth is viewed determines the plane 
on which the restoration translates.  

• All the mesh editing functions except Auto collision resolution function in this window. 
• Plane cutter, Cap model, Tooth extraction, Adjust occlusion, and Articulation can be performed in 

this window. 
 
Single Tooth Renderer: 
• The tooth model can be independently rotated and zoomed in this view. Clicking on the D (distal), M 

(mesial), B (buccal), or L (lingual) letters move the restoration in short steps in the selected direction 
within the rendering window. 

• The tooth library type and tooth number str displayed in the upper left. 
• The color scale at the bottom indicated the depth of  the collision with the opposing stone model when 

“Tooth collision” is activated. The interval for depth (mm) is set to 0.1 to 2 mm and can be changed in 
the Preferences.  

• All mesh editing functions including Auto collision resolution function in this window. 
 
Occlusal Renderer (Maxilla and Mandible): 
• These renderers display the STL models, restorations, and the collisions (depth or boundaries) between 

them. It is intended for viewing purposes and the models cannot be zoomed or rotated, but opacity 
changes do take effect. 

 
  

Single Tooth 
Renderer 

Occlusal 
Renderer 
(Maxilla) 

 

Occlusal 
Renderer 

(Mandible) 
 

Rendering 
Window 
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Restoration: Stone Model Registration 
The Import Stone Model function provides a step-by-
step through the importing and registration of  upper and 
lower stone models. If  stone models are already present 
in the workup, this function serves to replace the existing 
models. 
Step 1: Import Stone Models 
• Click Import Stone Models in the Control Panel. 
• Choose the .stl or .ply file in the Select Stone Model 

File dialog. 
• Select the type of  model as Upper (maxilla) or Lower 

(mandible). 
• Move onto the next step. At the end of  registration, 

click Import Stone Models once more if  the 
opposing stone model needs to be imported or if  a 
stone model registration needs to be redone. 

 

Step 2: Select Type of  Registration 
• Maintain Position: The software applies the 

transformation data from the registration of  the 
opposing arch to this STL. This option is useful if  a 
pair of  STLs (upper and lower) have been registered 
in another program (intraoral scans may have close 
bite registration data). In this case, after registering 
one STL to the DCM (see Register to CT), the second 
STL can be imported and be loaded so that the close 
bite registration is restored. This most likely results in 
an incorrect position relative to the DCM scan for the 
second STL, since many CBCT scans intended for 
implant/restorative workups are taken with open 
patient bites. 

 

 
 

 

• Register to CT: This initiates the first step in 
registering the STL file to the DCM. The dialog (right, 
lower) shows the three steps needed to complete the 
registration. The layout (Figure 1) shows the STL on 
the left of  the rendering window and the DCM on the 
right with the adjacent clipping tool. Click Help to 
read the embedded document describing how to 
register different cases. 

o Clean Scan: Check this option when the 
case has little to no scatter. The 
registration uses additional points where 
selected for a more accurate registration. 

o Restart: Resets the user back to Step 1 in 
the dialog. 

o Perform Registration: Matches the STL 
to the DCM based on the points selected. 

o Done: Closes the dialog. 
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Figure 1 

o After clicking Perform Registration, a new layout (Figure 2), which features 
two volume renderers and three grayscale slice renderers, loads. Use the yellow 
arrows in the DCM renderer to center the mid-point in the correct position at 
the front of  the scan. After verifying this point in the sagittal grayscale 
renderer, continue using the other widget arrows and slice renderers to rotate 
the STL around this mid-point and achieve the proper orientation. 

 

 

 
Figure 2 
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Restoration: View Preset Setup 
Visibility presets allow for easy switching between set views during implant planning. To configure these settings, 
click on Setup. These presets may also be modified in the Implant Tab. 

 

• Edit Name: Click on any preset to select it. Type the 
new name into the field. 

• Visibility checkboxes hide or show features in the 
rendering window. 

• Implants: Toggles the visibility of  the implants. 
• Abutments: Toggles the visibility of  the abutments. 
• Skin: Toggles the visibility of  the face photo wrap from 

the Invivo Model workup file or 3DAnalysis. 

• Stonemodels: Controls the visibility of  the stone models. Varying degrees of  transparency can be 
obtained with the Opacity slider. 

• Restorations: Controls the visibility of  the 3D waxup models in the volume renderer and the colored 
profile in the 2D section renderer. The colored profile of  the selected restoration or restoration 
associated with the selected implant is red while the unselected restorations are pink. Varying degrees of  
transparency can be obtained with the Opacity slider. 

• Volume: Controls the visibility of  the volume render as well as the rendering type.  
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Restoration: Abutment Planning 

 
 

• The abutment automatically connects the restoration model with the implant model in the 
rendering window. The currently selected abutment is displayed enlarged on the right side. 

 

Restoration: Abutment Planning Dialog 
Abutment Parameters 

 

 

Top Shape 
• Height: Adjusts the length of  the abutment. 
• M-D Angle: Adjusts the mesiodistal angle. 
• B-L Angle: Adjusts the buccolingual angle. 
• M-D Size: Adjusts the mesiodistal size. 
• B-L Size: Adjusts the buccolingual size. 
• Rounding: Adjusts the rounding of  the abutment. 
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Margin Shape 
• M-D Size: Adjusts the mesiodistal size. 
• B-L Size: Adjusts the buccolingual size. 
• Rounding: Adjusts the rounding of  the margin. 
• Shoulder: Adjusts the margin between the axial 

(abutment) tooth surface and finish line. 
• Extrude: Adjusts the size of  the finish line shape. 

 

Emergence Profile Shape 

• Upper Curve: Adjusts the shape of  the upper 
portion of  the abutment base. 

• Lower Curve: Adjusts the shape of  the lower 
portion of  the abutment base. 

 

• Screw Hole: Adds a screw hole that exits through 
the top and bottom of  the abutment. 

• Healing Abutment: Replaces the current abutment 
with a healing abutment. 

 

 

• Adjust Hex Index Angle: Inserts a new widget 
into the renderer to allow rotation of  the hex. 

• Finish Editing Hex Index Angle: Removes the 
widget from the renderer.  

 

• Delete Abutment: Removes the selected abutment. 
• Abutment Grouping: Opens a dialog where 

abutments can be grouped such that their insertion 
angles are parallel. 
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Restoration: Crown Types 
Crowns for prepped teeth or custom abutments 

When using the Fit to Margin tool  or the Fit to Custom Abutment tool , the Build Crown dialog 
appears. This dialog provides options to adjust the base of  the restoration to interface optimally with the prepped 
tooth or abutment. 

Cement Gap 
• Thickness (mm): The distance between the interior of  the 

restoration and the top surface of  the prepped tooth or 
abutment. 

• Distance To Margin (mm): The distance between the inner 
and outer edge of  the restoration at the shoulder. 

 

Undercut/Blockout 
• Show undercut regions: Highlights the undercut regions in 

red. 
• Blockout undercut regions: Removes undercut regions by 

adjusting the restoration. 
• Align insertion axis with tooth: This option is only 

available for prepped teeth. Select the appropriate tooth to 
align the insertion axis of  the restoration. 

Restoration Border 
• Width (mm): Width of  the restoration border at the 

shoulder. 
• Angle (deg): Angle of  the restoration border. 
• Edge (mm): Length of  the edge of  the restoration border. 
• Height (mm): Height of  the restoration border. 
Enable Margin Editing: This option is only available for prepped teeth. Adjust the margin tracing around the 
prepped tooth. 

Build Crown: Calculates and updates the shape of  the restoration base. 

Cancel: Exits the dialog. 

 
Pontics 

Pontic restorations sit a set distance above the stone model can either retain its original design shape or be fit to 
the stone model’s surface. Click to select the restoration of  interest and then click the Create Pontic with 

Gingiva tool . 
Offset from gingiva: Distance between the bottom of  the restoration and 
the stone model. 
Type: 
• Fitted: The bottom of  the restoration is reshaped to fit the contour of  

the stone model. 
• Scaled: The restoration size is scaled such that the bottom is the 

appropriate offset distance from the stone model.  
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Bridges 
Select a set of  restorations by “Ctrl” + right-clicking each restoration. Click the Create Bridge Connectors 

between Selected Restorations tool  to create a bridge.  

 

Choose Yes to create a bridge for reduced crowns. This bridge 
type has editable connectors.  

Choose No to create a bridge that links the restorations but does 
not have connectors. 

Restorations cannot be manipulated individually or moved after bridge creation. 
If  a bridge for reduced crowns was created, each connector may be edited individually. Click on the connector to 
select it and open the Bridge Connector Options and display the editable nodes. 

Bridge Connector Options 
Cross Section Shape: Choose the shape of  the cross section of  the connector. 

End Diameter: Set the diameter of  the ends of  the connector that contact the 
adjacent restorations. 

Middle Diameter: Set the diameter of  the middle of  the connector. 

 

 

Warning: Incorrect crown fitting may cause inaccurate crown shape and positioning. This may lead to surgical complications or 
delayed if  treatment planning. 
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Restoration: Articulation and Adjust Occlusion 
Articulation 
For best results, first adjust the occlusion using the 

Adjust Occlusion tool . The Articulation 
function determines a closed-bite orientation for 
the two STL models and define an occlusal plane. 
The STL models can then be opened, closed, or 
slid across each other to simulate anatomical jaw 
operations. (The closed-bite registration is 
determined by a best-fit of  the two STLs during 
specified interactions.) 
 
Activation of  this feature turns:  
• A widget for editing the position of  the 

condyles as well as displaying the occlusal plane. 
The condyle handles can be left-clicked and 
dragged to the correct positions. 

• The Articulation dialog box (below). 
 
Articulation Dialog 

 

 

Condyle Angle 
• This determines the angle of  the plane below the occlusal plane on 

which the mandible STL slides. (Example: if  the Condyle Angle is set 
to 0 deg, the mandible slides on the occlusal plane.) 

Movements 
• Open/Close Graph: Changes the angle of  “jaw” opening and degree 

of  rotation during the articulation animation. 
• Sliding on Occlusal: Slides the mandible along the occlusal plane with 

an adjusted angle determined by the Condyle Angle. 
• Left Condyle Sliding: Slides the left condyle forward along the occlusal 

plane with an adjusted angle determined by the Condyle Angle. 
• Right Condyle Sliding: Slides the right condyle forward along the 

occlusal plane with an adjusted angle determined by the Condyle 
Angle. 

• Show Occlusal Plane: Displays the blue frame of  the occlusal plane in 
the rendering window. 

• Use Original Registration: Returns the stone models to the original 
position when enabled. 

Close 
• Closes the dialog box and returns the STLs and restorations to the 

original registered position. 
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Restoration: Preferences 

Selecting the Setting tool  opens up a customization window within the Restoration Tab: 

 

Collision Depth Color Code 
• Min Depth: Sets the minimum mesh collision 

depth for detection and the color corresponding 
to minimal collision. 

• Medium Depth: Sets the color corresponding to 
the medium level of  collision based on the depth 
range. 

• Max Depth: Sets the level of  collision detected as 
maximal and the corresponding color. 

Other Settings 
• Restoration color: Sets the color of  the 

restorations. 
• Stone Model Color: Sets the stone model color 
• Grid Color: Sets the color of  the grid on the 

individual restoration renderer as well as the 
Toggle Grid tool. 

• Area Drag Outer Radius: Sets the default Area 
Drag tool’s outer radius of  effect. Area can still 
be adjusted using the mouse scroll wheel when 
the tool is in use. 

• Area Drag Inner/Outer Radius Difference: 
Defines the inner circle of  the Area Drag tool. 
The inner circle directly experiences drag 
whereas the area of  the outer circle gets 
subsequently deformed by the drag force. 

 
 

• Push Widget Radius: Sets the default Push Mesh tool’s radius of  effect. Area can still be adjusted using 
the mouse scroll wheel when the tool is in use. 

• Pull Widget Radius: Sets the default Pull Mesh tool’s radius of  effect. Area can still be adjusted using 
the mouse scroll wheel when the tool is in use. 

• Smooth Widget Radius: Sets the default Smooth tool’s radius of  effect. Area can still be adjusted using 
the mouse scroll wheel when the tool is in use. 

• Movement Step Size: Adjusts the amount the selected restoration moves using the arrow keys. 
Collision Settings 
• Off: Collision between the structures is not shown. 
• Boundary: Shows only the boundary of  collision in blue. 
• Shows the depth of  collision in the range of  colors set in the Collision Depth Color Code section. 
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Endo View Features 
The Endo View Tab allows for careful segmentation and examination of  a single tooth through various unique 3D volume 
renderings and 2D slice views. Working length measurements can be performed in this view to calculate root and endodontic file lengths. 
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Endo: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Endo View Tab: 

 
 

  
Reset: Resets the rendering window to the original view size. 

  
Left: Automatically orients the volume in a left sagittal view. 

  
¾ Left: Automatically orients the volume in a 45° left view. 

  
Front: Automatically orients the volume in a front view. 

  
¾ Right: Automatically orients the volume in a 45° right view. 

  
Right: Automatically orients the volume in a right sagittal view. 

  
Top: Automatically orients the volume in a top-down view. 

  
Bottom: Automatically orients the volume in a bottom-up view. 

  
Back: Automatically orients the volume in a posterior view. 

  

FreeHand Sculpture: Freely outline an area and remove the volume perpendicular to the plane of  
the screen. The volume inside or outside the selection can be chosen by clicking in the respective 
areas. This tool can only be used after Select Tooth is complete. 

  

Polygon Sculpture: Outline an area by placing a series of  points and right-clicking. The volume 
perpendicular to the plane of  the screen is removed. The volume inside or outside the selection can 
be chosen by clicking in the respective areas. This tool can only be used after Select Tooth is 
complete. 

  

Distance Measurement: Select this option and mark two points in the view, and the distance 
appears. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. 

  

Angle Measurement: Select this option and mark three points in the view and the angle between 
them appears. Clicking on their control points and moving the cursor can modify measurements. 
Click on the measurement and press the “delete” key to delete it. 

  

Area Measurement: Select this option and mark any number of  points along the boundary of  the 
desired area. Double-click or right-click to end the measurement. A number in millimeters squared 
is automatically display. Click on the measurement and press the “delete” key to delete it. 

  

Polyline Measurement: Select this option and mark any number of  points in the view. Right-click 
to end the measurement, and the total distance appears.  Clicking on the nodes and moving the 
cursor can modify points. Click on the measurement and press the “delete” key to delete it 

  Working Length Measurement: Select this option and mark the desired measurement endpoints 
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in the view. The working length is generated between the endpoints, and the total distance displayed. 

  
Arrow Notation: Allows an arrow to be drawn on the image. 

  
Circle Notation: Allows a circle to be drawn on the image. 

  
Text Notation: Allows text to be written and edited on the image. 

  
Layout: After clicking on the layout icon, a list of  various layout options appears. Click on the 
desired layout to apply it. 

  
Grid: Toggles between two different grid layouts for simple assesment of  size, measurement, and 
spatial location. 

  
Toggle Cursor Visibility: Cycles through available cursor styles and turns cursor on and off. 

  
Information Display: Displays or hides case information embedded in the scan data. 

 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

 

mailto:support@osteoidinc.com
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Endo: Control Panel 

 

Volume of  Interest: 
• Select Tooth: After clicking this button, click either on 

the 2D slices or 3D volume to create a box. In the 2D 
slices, click and drag the center of  the box to move it. 
Click on the nodes or borders to change the size. Click on 
the arrows to rotate the box. After the box is aligned with 
the desired tooth, right-click or click Apply to segment 
the region within the box into a volume of  interest (VOI). 

o If  a VOI has already been created, clicking 
Select Tooth provides the options to edit the 
current VOI or create a new one. 

• Cancel: Cancels the Select Tooth process. 
• Reset: Resets the current VOI to the original scan. 
Layout: Changes the right section of  the rendering window. 
• Volume: Displays the volume rendering of  the VOI if  

one has been created or the original scans. 
• Axial: Displays the 2D slices along the z-axis of  the VOI. 
• Lateral: Displays the 2D slices around the z-axis of  the 

VOI 
• Endoscopy: Displays a 3D slice along the z-axis of  the 

VOI. The rendering type is set in the View Control 
section. 

View Control: 
• Color Presets: Teeth, Pulp, Bone, etc. allow better 

visualizations of  certain anatomic structures, soft tissue 
profiles, airway, etc. This is achieved by displaying specific 
densities with specific colors. Certain options may not be 
available until the creation of  a VOI. 

• Threshold: Filters the H.U. values that are visible in the volume rendering 
• Brightness & Contrast: Can be adjusted for each of  the presets to enhance the image. 
• Sharpening Filter: Applies the selected sharpening filter from the drop-down menu to the 2D slice 

renderers. 
• Slice Thickness: Uses ray sum when reconstructing the 2D image along each orthogonal plane. 
• Rendering: “Performance” is fast but there are some rendering artifacts. “Quality” gives the highest 

level of  detail, but response is slower. “Default” is in between the other two options.  
Working Length: 
• Measurement: Creates a working length measurement. 
• Clear All: Deletes all working length measurements 

3D Volume Clipping: 
• When 3D volume is enabled, this option clips the volume for viewing the internal anatomy. 
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Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display 

Preferences section in Preferences (pg. 21) for more information on which settings are saved for 
this specific tab. 
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Endo: Rendering Window 
A 3D volume view and the axial, sagittal, and coronal slices are displayed by default. Other layouts exchange 
the 3D volume for additional slice or endoscopy views. 
 

 
 
Slice view: Axial and lateral slices are available. Scrolling along the z-axis or laterally can be applied.  
 
3D volume view: The 3D volume can be manipulated as in other tabs. 
 
Axial, Endoscopy layouts: These views display nine z-axis slices that can be scrolled through axially. Green 
lines corresponding to each of  the slices are visible in the sagittal and coronal slices. 
 
Lateral layout: These views display nine z-axis slices that can be scrolled through laterally. Green lines 
corresponding to each of  the slices are visible in the axial slice. 
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Endo: Volume of Interest  
Creating a volume of  interest (VOI) allows for focusing mainly on the tooth of  concern and removes any 
surrounding material that may obsure the view. This process creates a region oriented around a particular tooth 
and generates the corresponding 2D slices aligned with the tooth axes.  

To start, click on Select Tooth.   

 

The cursor transforms into a “+” shape, and clicking on a 2D slice or the 3D volume places a box. 

 

The box can be adjusted with the widget in the 2D slices. Click and drag the box to move it. Click and drag the 
yellow nodes to resize it. Click and drag the arrows to rotate it. Press the “a” key to realign the box to the slice.  

Once the box is positioned properly, click Apply or right-click to segment the VOI. Clicking on Select Tooth 
again allows for editing the current VOI or creating a new one. The Freehand Sculpture and Polygon Sculpture 
tools can be used to further sculpt out unwanted portions of  the volume. Reset restores the starting volume. 

 

The different View Presets can be applied to the volume by clicking on the desired preset: 
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Sculpted volume with Pulp View Preset. 
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TMJ View Features 
The TMJ View Tab displays two independent focal troughs generating cross sections of  each TMJ, along with corresponding coronal 
and axial views. The TMJ View Tab also displays the TMJ in 3D volume rendering options. 
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TMJ: Toolbar 
Shown below are the Toolbar and tools that are loaded with the TMJ View Tab: 

    

 
Reset: Resets the rendering window to the original view. 

 

Create Arch Spline: Select this tool to create or edit the spline. Left-click to place the first point and 
continue left-clicking along the structure. Right-click or double-click to finalize the spline. To modify 
an existing arch spline, drag the nodes to the desired positions. To move the arch while maintaining 
its shape, click and drag the central spline. 

 
Arch Spline Ruler: Places ruler along the arch spline for easy reference. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 
number in millimeters automatically displays. 

 
Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click 
the last point to create an angle. A number in degrees automatically displays. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of  the 
desired area. Double-click or right-click to end the measurement. A number in millimeters squared is 
automatically displayed. 

 
Reorientation: Adjust the patient orientation and the visible range of  the scan. 

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 

H.U. Measurement: Calculates the HU value of  an area within a bounding rectangle, circle, 
or ellipse. The measurements display alongside the shape and can also be repositioned by 
dragging. The information updates when the box is moved. 

 

Rotate Focal Troughs: This function will rotate the focal troughs 90 degrees in opposite 
directions. Warning: Sequence direction depends on focal trough direction. Medial and lateral 
may be flipped if  the focal trough angle is in the opposite direction. 

  

Slice Capture Mode: Opens the Slice Capture Manager to enable the capture of  slices or 
groups of  slices from a series of  cross sections. Requires the creation of  a slice group in the 
Report Tab and an activated Report module. 

 
Layout: After clicking on the layout icon, a list of  various layout options appears. Click on the 
desired layout to apply it. 

 
Grid: Toggles between two different grid layouts for use in all of  the section frames allowing 
quick assessment of  measurements and spatial location. 
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Toggle Cursor Visibility: Conceals or displays cursors. 

 
Information Display: Displays or hides case information embedded in the data. 

 
View Sequence: Opens a dialog that provides view sequence presets to create a video. 

 

 

 

  

 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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TMJ: Control Panel 

 

Layout 
• Change Layout: Switch to different layout options. 
• “Print Out”  mode shows the image in life size and 

allows for capturing and printing in life size if  captured 
to Gallery tab. 

Lateral Slices 
• “Width” changes the width of  the slices. 
• “Interval” changes the interval between the cross-

sectional slices. 
• “Thickness” adds multiple slices together for ray sum 

visualizations.“Width” allows you to change the width 
of  the slices. 

• “Interval” allows you to change the interval between the 
cross-sectional slices. 

“Thickness” allows you to add multiple slices together for ray 
sum visualizations. 

Frontal 
• Change the visualizations of  the coronal slices of  the 

TMJ. 
o Slice – Gray Scale rendering 
o X-ray – X-ray rendering 
o Vol1 – Teeth rendering 
o Vol2 – Bone rendering 

• Use the Thickness drop-down to create a ray sum view. 
View Control 
• Brightness & Contrast allow you to adjust the image. 
• The “All” drop-down allows you to adjust brightness/contrast in different areas independently. 
• Color Presets can be used to view the images in different colors. 
• Sharpening Filter: Applies the selected sharpening filter from the drop-down menu to the 2D slice 

renderers. 

Focal Trough 
• Click on the “Symmetry” box to keep the focal trough angles symmetrical. 

Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display 

Preferences section in Preferences for more information on which settings are saved for this 
specific tab (pg. 21).  
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TMJ: Rendering Window 

 

Please refer to Image Navigation (pg. 37) for information about controlling 
and adjusting these images. 
 
Arch Spline (Focal Trough) Navigation 
 

• Endpoints: Clicking and dragging either endpoint of  the focal trough can shorten/lengthen the 

focal trough or rotate the focal trough, depending on the direction that it is dragged.  

 
Warning: Sequence direction depends on the focal trough direction. Medial and lateral may be flipped if  the focal trough 
angle is in the opposite direction. 

• Cross Section Indicators: Clicking and dragging the stack of  green lines will scroll the cross sections 

through the focal trough in that direction. 

• Focal Trough Box: Clicking and dragging any one of  the lines forming the shape of  the focal trough 
will move the entire focal trough. 
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TMJ: Layout 
 

 
 
Many of  the various layout options of  the TMJ Tab feature frontal views of  the condyle. Some layout 
features include: 
 

• Two frontal volume views for each condyle, as seen above. 

• Free rotation of  the volumes after Vol1 or Vol2 have been activated. 

• Sculpting operations carry over from Volume Render: The condyles can be segmented out using 

sculpting tools in the Volume Render Tab. These operations are carried over automatically to the 

TMJ Tab. 

  



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 122 of 256 UM-TXS-ENG-71 

Super Pano View Features 
The Super Pano View Tab can construct and display an enhanced version of  a panoramic radiograph, take measurements, and 
utilize several image enhancement features. It also has the ability to render a pano into a volumetric 3D image that can be rotated for greater 
visual advantages. 
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Super Pano: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Super Pano View Tab: 

 

 
Reset: Resets the rendering window to the original view. 

 

 

Create Focal Trough: Sets the boundaries of  the Super Pano. A focal trough is automatically set 
but can be adjusted or recreated entirely. Use the yellow dots to stretch, widen, or reshape the focal 
trough. The focal trough selects only the desired anatomy and excludes others such as the spine, 
which traditionally appears in panoramic radiographs as background noise. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 
number in millimeters automatically displays. 

 
Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click 
the last point to create an angle. A number in degrees automatically displays. 

 
Grid: Toggles between three different grid layouts for use in all of  the section frames allowing quick 
assessment of  measurements and spatial location. 

 
Information Display: Displays or hides case information embedded in the data. 

 
Comment Marker: Pick a point in the panoramic and enter comments. 

 

  

 

 

  

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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Super Pano: Control Panel 

 

Create Pano 
• The upper-lower limit is adjusted by left-clicking on a 

green line and dragging with the mouse. It specifies the 
vertical dimension of  the pano that is being created. 

• The focal trough is adjusted by left-clicking on the 
yellow points and dragging with the mouse. The length, 
width, and shape of  the focal trough are adjusted to 
specify what appears in the pano. 

• A preview is also shown in the rendering window. 
• The Create Pano button should be pressed after the 

upper-lower limit and focal trough are first adjusted. 

Gray Scale Threshold 
• This threshold sets the density limit in the pano. 
• For noisy images, adjust the threshold so that the noise 

does not contribute to the pano. 
• Threshold is usually set slightly below bone density. 

View Controls 
• Pano can be rendered in multiple visualizations. 
• Enhanced Gray sharpens Gray Scale rendering. 
• By default, Enhanced Gray is selected. 
• Brightness & Contrast: Can be adjusted to enhance the 

image. 
• Inverse: Switches the background to white (switches 

coloring for Gray Scale Rendering). 
• Sharpening Filter: Applies the selected sharpening filter 

from the drop-down menu to the 2D slice renderers. 

• Tru-Pan™: This option enables the one-click volumetric pan that can be created from scans taken by 
an i-CAT© Cone Beam 3D system. See more information in the Tru-Pan™ section of  the manual. 

3D Settings 
• Enable 3D: Select this feature to render the pano as a volumetric 3D image. The pano can be rotated, 

clipped, etc. like other volumes. (See Image Navigation, pg. 37.) 
• Quality: Select this to give the highest level of  detail for the generated pano. 
• A traced nerve or placed implant can be toggled on/off  with the “Nerve” and “Implant” boxes. 
Clipping 

This option is only applicable when 3D Pano is available. Clipping hides some part of  the image so that the 
internal structure can be visible. 

Axial Setup 
The slice mode box sets how the focal trough is shown. 

Annotation:  
• Edits selected comment/annotation in the text field. 
• You can toggle added comments on/off  by selecting “Visible.” 
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Super Pano: Rendering Window 
Upper-Lower Limit: The lower left box where the vertical parameter of  the Super Pano is set. The green lines 
indicate the vertical limits. They can be dragged to set the desired upper and lower limit of  the Super Pano. When 
“Slice Mode” is selected, the red line indicates where the focal trough plane is and can also be adjusted. 

Focal Trough: The focal trough is adjusted in the lower middle box. Whatever is contained within it appears in 
the Super Pano allowing the construction of  a panoramic x-ray with minimal background noise. The yellow dots 
can be left-clicked and dragged to adjust the length, width and shape of  the focal trough. The focal trough can be 
adjusted by dragging the focal trough control points, or a new trough can be created by clicking the trough icon on 
the toolbar. 

Preview: A preview of  the Super Pano is displayed in the lower right box before creating it. This feature allows a 
Super Pano to be efficiently made with fewer or no adjustments needed afterward. 
 

 
 
How to make a good Pano?  
• Make a U-shaped, narrow focal trough encompassing the arches by adjusting points on the focal trough. 
• Adjust Gray Scale threshold to filter soft tissue, so that the image is not too dark or too light. 
• Refer to Image Navigation (pg. 37) for information about controlling and adjusting these images. 
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Super Ceph View Features 
The Super Ceph View Tab gives the ability to construct and view an enhanced version of  a cephalometric radiograph, take 
measurements, and utilize several image enhancement features, all of  which dramatically increases its diagnostic value. 
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Super Ceph: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Super Ceph View Tab: 

 

 
Reset: Resets the rendering window to the original view. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 
number in millimeters automatically displays. 

 
Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click 
the last point to create an angle. A number in degrees automatically displays. 

 
Text Notation: Allows text to be written and edited on the image. 

 
Grid: Toggles between two different grid layouts for use in all of  the section frames allowing quick 
assessment of  measurements and spatial location. 

 
Information Display: Displays or hides case information embedded in the data. 

 
Change Layout: Toggles between different Super Ceph layouts. “Set Orientation” must be enabled 
to allow toggling between layouts. 

 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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Super Ceph: Control Panel 

 

Create Ceph 
• The Create Ceph button should only be clicked after 

the orientation of  the patient’s volumetric image is 
adjusted in the rendering window. 

• The “Set Orientation” box resets the orientation if  a 
ceph was created incorrectly. Once the image is 
orientated correctly, press the Create Ceph button 
again. 

Layout: 
• “Screen” layout is optimized for viewing the image on 

the computer screen. “Print Out” layout is optimized 
for printing the image on paper. With Print Out layout, 
the exact screen display is printed on the paper in life-
size. First, capture to Gallery, then print from Gallery to 
ensure the image is life size. 

Traditional Gray Scale Ceph 
• Brightness and Contrast can be adjusted to enhance the 

image. 
• The “Enhanced” box can be left-clicked on or off  to 

sharpen and enhance the quality of  the image. 
• Range Setup sets the side of  the patient’s head the ceph 

is created from. Thickness controls the width of  the 
range. 

• When the Range Setup is changed, the ceph image must 
be recreated using the Create Ceph button. 

• Sharpening Filter: Applies the selected sharpening filter 
from the drop-down menu to the 2D slice renderers. 

Volume Ceph 
• Increase the Opacity slider to superimpose the volume 

rendering onto the generated ceph. 

• Various enhanced views of  the ceph can be added; each has different advantages: 
• Bone highlights hard-tissue landmarks. 
• Soft+Bone emphasizes the soft-tissue on the ceph 
• Opacity, brightness, and contrast can all be adjusted for image enhancement. 
• Inverse switches the background to white. (Gray Scale coloring switches black/white.) 
• Range Setup sets the side of  the patient’s volume that is superimposed. 
• Projection provides options to switch between parallel views of  the cephalometric images and 

perspective views which resemble the magnification found in traditional cephalometric radiographs. 
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Super Ceph: Rendering Window 
This window is where the volumetric image of  the patient is orientated to create a ceph and where the ceph is 
viewed after creating it. 
 
Before clicking on the Create Ceph button in the Control Panel, the patient’s volumetric image must be correctly 
orientated. The easiest way to do this is to line up the left and right angles of  the mandible. If  the ceph is created 
with an improper orientation, it can be adjusted using the “Set Orientation” box in the Control Panel. 
 

 
 
Please refer to Image Navigation (pg. 37) for information about controlling 
and adjusting these images. 
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Superimposition View Features 
In the Superimposition View Tab,  open two different scans at once, view them side by side, and superimpose them. This is 
especially useful for assessing pre- and post-treatment scans. 

  



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 131 of 256 UM-TXS-ENG-71 

Superimposition: Toolbar  
Shown below are the Toolbar and tools that are loaded with the Superimposition View Tab: 

 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume, and the distance 
appears. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. Control Panel features in Volume Render Tab allow the values 
to be projected to 2D, hidden, or exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle 
between them appears. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it. Control Panel 
features in Volume Render Tab allow the values to be projected to 2D, hidden, or exported to a 
report. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of  the 
desired area. Double-click or right-click to end the measurement. A number in millimeters squared is 
automatically displayed. Control Panel features in Volume Render Tab allow the values to be 
projected to 2D, hidden, or exported to a report. 

 
Text Notation: Allows text to be written and edited on the image. 

 
Comment Marker: Pick a point in the volume and enter comments. Type the desired text label and 
press OK. 

  

Point Registration: This icon is used to register the original volume to the second volume. Four or 
more anatomical points are chosen from each scan to properly align both scans at common, stable 
landmarks. 

  Volume Registration: This icon is used to open the Volume Registration interface for automatic 
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superimposed volume registration. Users define a VOI (Volume of  Interest) Box as a reference for 
automated superimposition. 

  
Manual Registration: This icon is used to make adjustments to better align the two volumes that 
are superimposed. 

  
Layout: Toggles the rendering window layout. 

  
Grid: Toggles between two different grid layouts for use in the upper two section frames allowing 
quick assessment of  measurements and spatial location. 

  
Toggle Cursor Visibility: Toggles on/off  the cursor lines in the 3D volume rendering. 

 

Information Display: Displays or hides case information embedded in the data. 
 
 
   

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

  

 

mailto:support@osteoidinc.com
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Superimposition: Control Panel 

 

Superimposition Target: 
• Select Import New Volume to import a second 

volume. Superimpose either an Invivo file (.inv) or 
DICOM (.dcm) scan set. Multiple scans can be loaded. 

• Toggle on Enable for registration to use either Manual, 
Point, or Volume registration tools to align the scans or 
select the corresponding tools from the toolbar. 

• Select Mirror Own Volume to mirror the patient's 
anatomy to check for asymmetries. 

• Synchronized Layout can be toggled to display the 
volumes side by side. 

Volume 1 and Volume 2: 
• Imported and mirrored volumes are added into the 

drop-downs. 
• Visible turns on/off  either volume independent of  each 

other. 
• View Control sets different visualization presets for the 

volume. 
• Models allow the visualization or hiding of  the models 

available to the respective volume. Model coloring 
differs between Volume 1 and Volume 2 models for 
visibility. 

• The Brightness and Contrast in the volume renderings 
can be adjusted independently and improve the image. 

Clipping: 
• Select “Enable” to slice the image along predefined 

anatomical planes (sagittal, coronal, axial). 
• Select “Flip” to switch the view to the opposite side. 
• Control Clipping with the scroll mouse or slider. 

Visibility Toggle: 
• Volume: Adjust the opacity of  the original volume and superimposed volume. Set the slider in the 

middle to visualize both volumes in equal opacity. Set the slider to one side to visualize only one 
image. 

• Slice: Adjust the opacity of  the original gray scale slice and superimposed one. Set the slider in the 
middle to visualize both volumes in equal opacity. Set the slider to one side to visualize only one 
image. The Slice Color button displays the available slice color options. 

Load Superimposition: 
• Reload saved superimposition data. 
• Select Load and choose the correct .vdata file. 
• The superimposition file is reloaded with the saved volume. 
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Save Superimposition: 
• Save the superimposition data into an external file. 
• In the dialog that appears, choose where and what filename to save. 
• Invivo saves two files: .vdata and .odata 
• .vdata: stores the registration points and superimposed volume information 
• .odata: stores the original scan's volume orientation information 
Annotation:  
• Edits selected comment/annotation in the text field. 
• You can toggle added comments on/off  by selecting “Visible.” 
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Superimposition: How to Superimpose Two Volumes 
TxSTUDIO provides easy-to-use tools for superimposition. Although they are easy to use, superimposition is a 
technique-sensitive procedure with the most critical step being the registration of  the new scan via the selection of  
stable landmarks in both scans. The proceeding sections discuss how to superimpose two scans step by step. 
 
Step 1: Open First File. Open one of  the files for superimposition. Files do not need to be opened in a specific 
order, but starting with the pre-treatment scan may be recommended for sake of  organization. See DICOM and 
Invivo File Loading (pg. 27) section for instructions on opening an Invivo file. 
 
Step 2: Import Volume. Go to the Superimposition Tab and from the Control Panel, click on the Import New 
Volume option to select the second file to open. The File Manager appears for loading either a DICOM file or an 
Invivo file. 
 
Step 3: Select the Point Registration tool. It can be found in the Superimposition Toolbar. 
 

 
 
Step 4: Registering the Two Scans to Each Other. In order to superimpose the scans as correctly and precisely 
as possible, strict attention must be placed in selecting at least four matching and stable landmarks in both scans. 
• To select landmarks on each volume: 

o Press down on the center scroll-wheel of  the mouse. 
o Or, position the mouse over the landmark and press the space bar on the keyboard. 

• Select the first stable landmark on one scan using either method above. 
• Select the matching stable landmark on the other scan using either method above. 

o Each point shows up as either a blue or red dot. 
o Points are numbered for easy reference. 
o Points can be undone by pressing Ctrl + Z. 

• The volume can be rotated using the left-mouse button as before. 
• The volume can be clipped by selecting Clipping: “Enable” in the Control Panel. 
• The volume rendering presets can be adjusted using the Preset button. 
• Use caution in setting the Brightness and Contrast settings. 

o Be sure the Brightness and Contrast settings for the original and imported volumes are 
similar. 

o Be sure to use the similar Preset settings when registering points. 
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The image above shows a registration point (Registration Point 1) located on the anterior point of  the right 
zygomaticofrontal suture. The point has been added to both the original scan (white, left) and the new scan (blue, right). 

 
 
Step 5: Save Points and Finish Registration. Once all points are plotted one by one, click the right-mouse 
button to register the two scans. Practice registration by superimposing the same scan before trying to 
superimpose two different scans. The precision of  the superimposition can be assessed by examining the two 
registered scans overlap using the 2D and 3D toggle tools. 
 

  

(a) (b) 

(a) The above image on the left is of  two identical data sets that are registered to each other precisely. Notice 
there are no overlapping areas of  different colors. 
(b) The image on the right is of  two volumes not registered precisely. Notice the blue and white skeletal 
boundaries do not line up, and the presence of  double images. 

 
 



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 137 of 256 UM-TXS-ENG-71 

Superimposition: Using Registration Widget for Fine Adjustments 
After finishing the landmark registration, the other tools provided in the Superimposition Toolbar can be used to 
make final adjustments to the superimposition. 
 

  
To make the cross sections bigger, use the Layout icon from the Toolbar 

  
To move the volume manually, use the Manual Registration icon from the Toolbar to display 
the move widget on the superimposed volume 

 
The above tools are available for use prior to using the Landmark Selector; however, it is strongly recommended 
to first use the Point Registration tool before using the Manual Registration tool. 
 
 
Check the cross sections for accuracy by adjusting the Layout (Layout icon) and the 2D Gray Scale Toggle 
slider. The superimposition is shown in 3D as well as in the cross sections. Make the necessary adjustments. 
 
 

 

For example, notice in the sagittal section shown to 
the left that the superimposed volume is not totally 
overlapped. Using the Manual Registration tool, 
move the volume in the anterior-posterior direction 
until the sections align by clicking on the yellow arrow 
in the move widget and dragging it forwards or 
backwards. 
 
One should go through each anatomical plane to 
check for precision. The cranial base should match up 
perfectly because it is stable; however, the vertebrae 
are usually off  because the patient's head is always 
tilted somewhat differently in each scan. 
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Superimposition: Using Volume Registration for Fine Adjustments 
After finishing the landmark registration, the other tools provided in the Superimposition Toolbar can be used to 
make final adjustments to the superimposition. 
 

  
To make the cross sections bigger, use the Layout icon from the Toolbar 

  
To fine-tune the registered volumes, use the Volume Registration icon from the Toolbar to 
open the Volume Registration interface 

 
The above tools are available for use prior to using the Landmark Selector; however, it is strongly recommended 
to first use the Point Registration tool before using the Volume Registration tool. 
 
 
Select the Volume Registration icon in the toolbar to open the Volume Registration interface. 
 
Left-click on any of  the 2D cross sections to place the center of  the VOI (Volume of  Interest) Box. The VOI 
box can be moved at any time by clicking and dragging it to another location in one of  the 2D cross sections. 
 

 

Target Volume Size: 

• R-L Size: defines the lateral width (mm) of  the 
VOI Box. 

• A-P Size: defines the anterior-posterior width 
(mm) of  the VOI Box. 

• H-F Size: defines the inferior-superior height 
(mm) of  the VOI Box. 

• Press Update Size to show the updated VOI 
Box size in the rendering window. 

• The bounding box may also be edited in the 
2D view by clicking and dragging either the 
boundary lines or the corner nodes. 

 
Select Perform Registration to run the automatic registration process for the VOI Box selected. The 
process time is based on the computer's hardware components; however, in general, the larger the VOI 
Box, the more time is required to complete the automatic registration. 
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The following images show the VOI Box applied near the cranial base of  a pre- and post-surgery 
superimposed scan (top image) and the results of  the automatic registration process (bottom image). 
Notice that the two cranial base profiles line up exactly following the automatic registration process. The 
VOI Box used is the default (x, y, z) = 50mm x 50mm x 40mm. 
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Superimposition: Difference Between .vdata Files and .odata Files 
After successfully registering a different scan to the original volume data, Invivo can save the superimposition data 
using the Save Superimposition button. This section looks to further define the difference between the output 
files (.vdata and .odata) and how to use them. 
 
.vdata 

Information stored in the .vdata file includes the registration points and the path for finding the superimposed 
scan data. After  re-opening the original scan, in the Superimposition Tab, press the Load Superimposition 
button and load the desired .vdata file. This loads the superimposed image in the correct position without 
having to re-register the landmarks. 

 
.odata 

Information stored in the .odata file includes the orientation information of  the original scan data (not the 
superimposed scan). With this information, the specific orientation can be set for other cases as well. 
 
To import a new orientation, go to File in the Menu Bar and select “Import Orientation.” Choose the desired 
.odata file, and the case automatically reorients itself. 
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Gallery View Features 
The Gallery View Tab archives images that have been captured from other tabs. Additionally, images can be imported into Invivo or 
exported to a desired filepath. Comments or notes can be added to describe images that have been captured. 
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Gallery: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Gallery View Tab: 

 

  
Crop Image: Crop captured images to save as new images or replace the original. 

 

Gallery: Control Panel 

 

Images: Gives a list of  all captured images.  

• Each of  these images has a “Name” and “Type” which can be 
renamed by double-clicking on the text. 

• Move Up/Down: Moves the selected image up or down on the list. 
• Crop Current: Crop the currently selected image within Invivo. 

Image Operation 

• All/Selected: Applies operation to all or a subset of  the images from 
the list. 

• Remove: Removes images from the Gallery. 
• Export: Export the images in the Image List to a path specified in 

the dialog box that opens or to PACS if  configured. Local files can 
be saved as one of  the following formats: .jpg, .bmp, or .png. PACS 
files are stored as DICOMs. 

• Email: Email the images in the Image List as attachments from the 
set email account to the recipient’s email address. An email subject 
line and message can be included. 

Import Images: 

• Select to import images (.jpg, .bmp, .png) from an external source 
into the Gallery Tab. 

• Using this, patient photographs or 2D DICOMS can be imported 
into the TxSTUDIO software for storage within the Invivo file once 
saved. 

Comments: 

• Text box displays comments about the image displayed in the rendering window. 
• Add or change comments by editing the text in the Comments Box. 

2D Image Options: 

• Controls settings for 2D images. See more information in Gallery: 2D Image Options. 
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Gallery: Rendering Window 
This window allows the viewing of  captured and imported images. The Gallery is particularly useful for creating a 
workup of  a particular case. Remember that the Gallery’s images are only saved if  the file is resaved; otherwise, 
any captured images will be lost. 

 

 
 
Please refer to Image Navigation (pg. 37) for information about controlling 
and adjusting these images. 
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Gallery: Adding Images to the Gallery 
Capture any single image to the Gallery. A single image within any view can be captured without including 
the other parts of  the rendering window. When the Capture to Gallery function is used, a dialog appears on 
the screen providing the user with options regarding which parts of  the rendering window to capture.  
 
The options provided by each dialog varies according to which Invivo tab is currently displayed; the 
following example is the dialog that appears within the ArchSection Tab: 
 

 
Ex. ArchSection Capture to Gallery 

Capture to Gallery Dialog: 

• Whole View – Captures a screenshot of  
the rendering window 

• Axial – Captures the axial slice view and 
no other parts of  the rendering window 

• Pano – Captures the pano view and no 
other parts of  the rendering window 

• Cross Sections – Captures a series of  
slices that are within the rendering 
window 

 
Options within each Select Image to Capture Dialog: 

Note: Some options appear gray (disabled) in the Select Image to Capture dialog. The choices available are 
determined by the specific layout as well as the view tab. 

 

Section  Whole View 
 Axial, Coronal, Sagittal Slices 
 Custom Section 

Volume 

Volume Rendering No Dialog 

ArchSection  Whole View 
 Axial 

 Pano 
 Cross Sections 

Super Pano  Whole View 
 Pano 
 Front Volume 

 Axial 
 Preview Pano 

Super Ceph  No Dialog 

Implant  Whole View 
 Main Volume 
 Axial 
 Cross Section 1 
 Cross Section 2 

 

 Density 
 Pano 
 Arch Volume 
 Front Volume 



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 145 of 256 UM-TXS-ENG-71 

Restoration  Whole View 
 Volume 
 Single Restoration 
 Upper Model 
 Lower Model 

Airway  Whole View 
 Axial 
 Sagittal 

 Airway 
 Volume 

Endo  Volume Layout  Whole View 
 Volume 
 Axial 
 Sagittal 
 Coronal 

 Axial Layout  Whole View 
 Axial Slices 
 Axial 
 Sagittal 
 Coronal 

 Lateral Layout  Whole View 
 Lateral Slices 
 Axial 
 Sagittal 
 Coronal 

 Endoscopy Layout  Whole View 
 Endoscopy 
 Axial 
 Sagittal 
 Coronal 

TMJ  Whole View 
 Axial 
 Left Frontal 
 Left Frontal 2 

 Left Cross Sections 
 Right Frontal 
 Right Frontal 2 
 Right Cross Sections 

Superimposition  Whole View 
 Main Volume 
 Axial 

 Coronal 
 Sagittal 
 Imposed Volume 
  

Model Normal Layout No Dialog 
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Occlusal Layout  Whole View 
 Lower Occlusional 
 Upper Occlusional 

Composite Layout  Whole View 
 Composite 1-9 

Consultation  No Dialog 

 

Capture to Gallery Dialog: 

 

 

 Name: Image label 
Note: Image name must be unique from any 
other captured image in the Gallery and 
must not contain any special characters. 
 

 Type: Image type – can be set from 
the drop-down to “Captured” or 
“Photo.” 

  
 Comments: Additional comments 

about the image can be added in this 
section. 
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Gallery: 2D Image Options 
The Gallery Tab is compatible with 2D DICOM images and has several features that allow it to handle this image 
format better. 

Opening 2D DICOM 

When instructed to open a 2D DICOM image, TxSTUDIO automatically enters a mode that disables 
3D functionality. Only the Gallery Tab is available within the software, and the DICOM appears as a 
Gallery image. 
 
If  a 2D DICOM is associated with a 3D volume as a scout image, opening the volume automatically 
imports that scout image into the Gallery Tab. 
 

 
Grayscale Image Options 
 

For grayscale images in the Gallery, the user has the 
option to adjust several settings such as Gray Scale 
Threshold, Brightness, Contrast, and Sharpening.  
 
The updates to these images are saved and always 
reflect the updated settings when the image is selected 
in the Gallery and also after it has been 
saved/exported and then opened/imported back into 
TxSTUDIO.  
 
 

 

 
Export to DCM/JPG/PNG/TIF/BMP 
 

An image in the Gallery can be exported into any of  
the above formats when using the Export… button. 
When saving individual Gallery images to file, the 
following image formats are available (JPG, PNG, 
BMP).  
 
An image in the Gallery can also be exported to PACS 
as a series.  
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Consultation View Features 
The Consultation View Tab features preconstructed videos for various dental procedures that are played through Invivo for 
presentation and education purposes. Additional manipulation of  model objects can be performed to obtain custom views. 
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Consultation: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Consultation View Tab: 

 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 
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Consultation: Control Panel 

 

Case: 
• Select a video set by dental specialty. 

Patient Consultation: 
• Displays list of  videos available under the selected specialty. 
• Select the desired video to view. 
• Click on the star icon to favorite the video.  
Video Tools: 
• Progress bar: Indicates the current frame of  the animation. 

This bar moves automatically when the video is played but can 
also be clicked and dragged to a specific frame for viewing 

• Speed options: Set animation speed from 0.5x to 2.0x. 
•  Start: Jumps to the starting frame of  the animation. 
• Play: Plays the selected video 
• Play Camera: Plays the selected video in the current camera 

perspective. The rendering window can be manipulated to play 
the animation from different angles and zoom levels. 

• End: Jumps to the final frame of  the animation. 

Clipping: 
• Select “Enable Clipping” to slice the image along the 

predefined anatomical planes (sagittal, axial, coronal). Control 
the clipping with the scroll mouse or the slider. 

• To switch a view to the opposite side, select “Flip.” 
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Model View Features 
The Model View Tab allows the user to see the patient's Invivo Model or 3D photograph and create surgical or orthodontic 
simulations, as well as 3D soft tissue predictions. An Invivo Model is a 3D digital study model that is made by Osteoid on a case-by-case 
service. The DICOM data of  the patient is sent to Osteoid where it is modeled to create the most advanced digital study model available. 
Invivo Models contain anatomy such as roots, developing teeth, impactions, alveolar bone, and more, while other models merely show the 
crowns of  teeth. The 3D photograph service that Osteoid offers is also viewed here. Osteoid developed the technology to combine a frontal 
photo of  the patient and the CT scan to create a 3D model that overlays the scan data. 

Any nerve tracing, implant planning, or superimposition that has been done is also visible in the Model Tab. Each item can be 
independently turned on/off  to see how all these systems come together with the scan data. 

 

For additional information about the Invivo Model service, please contact Osteoid at (408) 333-3484 or email us at 
info@osteoidinc.com. 

mailto:info@osteoidinc.com
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Model: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Model View Tab: 

 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

  
Slice Explorer: Once activated, clicking on a point on the volume opens a 2D zoom window in 
that location. The zoom window can be scrolled through using the mouse wheel. 

 

Marker: Select this option to mark a point on the volume and X, Y, Z coordinates (axial, sagittal, 
vertical) appear. Clicking on the point and moving the cursor can modify points. Click on the point 
and press the “delete” key to delete it. Control Panel features allow the values to be hidden or 
exported to a report. 

 

Distance Measurement: Select this option and mark two points on the volume, and the distance 
appears. Clicking on the point and moving the cursor can modify points. Click on the 
measurement and press the “delete” key to delete it. 

  

Angle Measurement: Select this option and mark three points on the volume and the angle 
between them appears. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it. 

  

Polyline Measurement: Select this option and mark any number of  points in the slice view. 
Right-click to end the measurement, and the total distance appears. Clicking on the nodes and 
moving the cursor can modify points. Click on the measurement and press the “delete” key to 
delete it. 

  
Comment Marker: Pick a point in the volume and enter comments. Type the desired text label 
and press OK. 

  
Model Color: Allows for the model color to be changed. 
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Grid: Toggles between four different grid layouts for simple assessment of  size, measurement, 
and spatial location. 

  
Information Display: Displays or hides case information embedded in the data. 

  

View Sequence: Allows for the creation of  custom camera sequences for movie capturing. Refer 
to the Volume Render Tab: View Sequence (pg. 73) section for additional information and 
description. 

  
Settings: Change the camera project in 3D, the composite layout type, life size display, annotation 
layout, and model visibility. 

 

  

  

 

 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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Model: Control Panel 

 

Layout: 
• Normal shows the digital models in the normal patient 

orientation along with the volume rendering if  desired. 
• Occlusal shows both arches from the occlusal perspective. 
• Composite shows a composite of  multiple views of  the model 

all at once. 

Models: 
• Models: The individual, digital models (implants, abutments, 

restorations, nerves, teeth, superimposition) can be turned on 
or off  in the rendering window.  

• Selected models’ colors can be changed by right-clicking to 
open the Model Color dialog. 

• Skin Opacity: Controls the opacity of  the Skin model from the 
Invivo Model service or from 3DAnalysis. 

• Jaw Opacity: Controls the opacity of  the alveolar bone/ ABO 
base from the Invivo Model service. 

• The Airway checkbox toggles the visibility of  the airway 
measurement if  one has been generated in the Airway Tab. 

• Show All and Hide All toggle the visibility of  all the listed 
models. 

• Settings: Control settings for items in the Models list. A 
model must first be selected in this list before the button is 
pressed. 

Volume: 
• Select “Visible” to toggle the volume rendering on or off  with 

the digital models. 
• The View Control buttons allows volume rendering options, 

such as Soft Tissue, Teeth, etc.  
• The Brightness & Contrast of  the images can be adjusted with 

the slider. 

Clipping 
• Select “Enable Clipping” to slice the image along the predefined anatomical planes (sagittal, axial, 

coronal). Control the clipping with the scroll mouse or the slider. 
• To switch a view to the opposite side, select “Flip.” 
View Presets: 
• Preset toggles that display predetermined views. A custom view can also be set. 
Simulation: 
To create a new simulation: 
• Select either the TeethMovement or JawMovement simulations, or press Edit to create a new 

simulation. 
• Move the slider to the right to indicate the ending point. 
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• Click on a digital model to move it (either individual teeth or whole arches) with the move widget.  
• After the final position is reached using the 3D move widget, press Start to go back to frame one. 
• Press Play to view the simulated movement. 
• Manage Keyframes lists the frames that compose the simulation for the selected model. (See page 

158.) 
• Press Soft Tissue Prediction to create a simulation of  the soft-tissue prediction. This is only 

possible with the use of  a 3DAnalysis face photo or Invivo Model Skin. 
Annotation: 
• Edits selected comment/annotation in the text field. 
• You can toggle added comments on/off  by selecting “Visible.” 
• Layout: Sorts all added comments in the rendering window based on selected setting (Horizontal, 

Stick to Point, User Dragged, Vertical, Vertical Spread Straight, Vertical Spread Polynomial). 

  
 

Warning:  Soft tissue prediction is an approximation and may not reflect actual results. 
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Model: Rendering Window 

 

This window allows the viewing of  Invivo Models, 3D photographs, and simulation, all of  which are services that must be ordered per 
case for this feature to work. These services provide excellent diagnostic data and case presentation material. 

 
Please refer to Image Navigation (pg. 37) for information about controlling 
and adjusting these images. 
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Model: Custom View Preset Setup 
Visibility presets allow for easy switching between set views. Each option can be adjusted by the user. To configure 
these settings, click on Setup. 

 

• Visibility checkboxes hide or show features in the 
rendering window. 

• Skin Opacity: Controls the visibility of  the face photo 
wrap from the Invivo Model workup file or 
3DAnalysis. Varying degrees of  transparency can be 
obtained with the slider. 

• Jaw Opacity: Controls the visibility of  the jaw models. 
Varying degrees of  transparency can be obtained with 
the slider. 

• Volume: Controls the visibility and rendering type of  
the 3D Volume 
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Model: Simulations 
Simulations may be created using any of  the model objects in the software, such as implants and restorations, as 
well as models created by the Invivo Model service. 

 

Adding and Deleting Simulations 
• Click Edit to open a list of  all simulations. 
• In the Name field, input the name of  the new simulation and click 

Add. The new simulation appears on the list. 
• To delete a simulation, click on the simulation on the list to select it, 

then click Delete Selected. 
• Initial Selected sets the current view state as Frame 0 for the 

selected simulation. 
• If  “Edit 0 Frame” is checked, then the initial frame of  the 

simulation becomes editable. 

 

Creating Simulations 
• Move the slider to Frame 100. This is the end state of  the model. 
• Select a model and the move widget should appear.  
• The move widget can be repositioned along the model by using Ctrl 

+ click and drag. 
• Use the move widget to adjust the final position of  the model. 
• Moving the slider (Frame 0 to 100) moves the model between the 

initial and final positions. 
• To adjust intermediate model positions, move the slider to an 

intermediate frame (between Frame 0 and 100). Use the move 
widget to adjust the model position. 

• Moving the slider (Frame 0 to 100) moves the model from the 
initial position, through intermediate positions, and to the final 
position. 

 

Managing Keyframes 
• Any animation frame in which a model position was adjusted 

becomes a keyframe. 
• Keyframe management allows for preexisting keyframes to be easily 

identified, edited, or deleted as well as the creation of  new 
keyframes. 

• Click on Manage Keyframes to display a list of  the keyframes for 
the selected model. 

• The position of  the model at existing keyframes can be edited by 
selecting the appropriate frame and repositioning the model. 

• To insert keyframes, move the slider to the desired frame number 
and then click Insert. The model may then be moved to create a 
new state for that frame. 

• To delete keyframes, click on the keyframe on the list and then click 
Delete. 

Note: Manage Keyframes does not apply to skinwrap. 
Please see page 162 for more information on Invivo Models and simulations.  
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Common How to Tasks 
How to Trace a Nerve 

• Go to the ArchSection Tab. 

• Make sure the pano is in Slice Mode (not X-ray mode). 

• Adjust focal trough such that the nerve pathway is visible in pano image. 

• Move pointer to the pano image. 

• Review the nerve pathway while using scroll wheel.  

• If  the nerve pathway is not clearly visible, adjust the focal trough. 

• When the nerve pathway is identified through the pano image, press New Nerve in the Control 

Panel. 

• Starting from the mandibular foramen, click point by point. 

• If  the nerve pathway is not clearly visible, use the mouse scroll wheel to find the nerve pathway and 

continue picking. 

• Near the mental foramen, move the mouse to cross-section view. 

• Use the scroll wheel to find the exit of  the nerve. 

• Pick points connecting the nerve exit. 

• Press Done in the Control Panel to finish the nerve. 

• For information on automatic nerve tracing, see page 47. 

 

 

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of  the nerve can lead to surgical 
complications if  diagnosis, treatment plans and/or actual treatment is based off  of  the incorrect tracing. It is critical for 
the end user to learn how to properly perform nerve tracings correctly. If  you notice any inconsistencies or software 
problems with nerve tracing or have further questions or concerns about nerve tracing, please contact Osteoid support 
at (408) 333-3484 or email us at support@osteoidinc.com 

 
 
 

mailto:support@osteoidinc.com
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How to Create Reports in Life Size 

• Go to ArchSection Tab. 

• Select Reorientation button in the toolbar 

• Adjust upper and lower limit by dragging green lines and then click Reorientation button to exit. 

• Adjust focal trough (arch spline) or re-draw arch spline by the clicking the Create Arch Spline button. 

• Change Layout Mode to “Print Out.” 

• Change to a desired layout using the Change Layout button. 

• Adjust cross-sectional width and interval. 

• Move cursor to set cross section in desired location. 

• In Print Out mode, user cannot zoom the image since it is set to life size. 

• If  desired structure is not visible in cross section, adjust axial cursor or focal trough. 

• Switch pano image to X-ray mode and turn on the ruler. 

• Turn on the Arch Spline Ruler and turn off  arch spline control points. 

• Turn off  the cursor if  necessary by clicking Toggle Cursor Visibility. 

• Go to the View menu and choose “Capture to Gallery” or press Ctrl + G 

• Go to Gallery Tab. 

• See Print Preview in the File menu and print out a test page. 

• To change the format, go to “Print Layout Setup” in the File Menu. 

• To use a personal logo, replace the “printLogo.bmp” file in installation folder. This folder is typically in 

“C:\Program Files\Anatomage\InVivoDental” 

• If  the Print Layout Setup is changed, choose Print Out mode before recapturing the image. Otherwise 

the image could still be in the previous Print Layout Setup. 

Other View Tabs with Life-Size Printing 
• Non-whole view, full-screen Section render (double-click a renderer to make full screen) 
• TMJ in Print Out mode (Axial slice is not life-size) 
• Pano in Super Pano 
• Super Ceph in Print Out mode 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 333-3484 or email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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How to Create a Positive Airway View 

• Go to Volume Render Tab. 

• Select the Inverse View Control. 

• Reduce the opacity such that the internal structures start to appear. 

• Change the viewpoint to Top View (Press Top button in toolbar). 

• Use Freehand Sculpture or Polygon Sculpture to remove the undesired parts of  the volume. 

• Change the viewpoint and repeat sculpting operations. 

• After the desired airway is isolated, increase the opacity. 

• Adjust Brightness and Contrast to set the right visualization. 

• (The Airway Measurement tool in the Airway Tab also shows a positive airway view that is color coded 

based on area. This inverse method shows the airway without color coding.) 
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How to Create an Invivo Model Simulation and Video 
Simulations require the use of  the Invivo Model service provided on a case-by-case basis from Osteoid. The Invivo Model service may 
include some or all of  the following features: 
• Individually segmented, digital models of  patient dentition 
• Segmented digital models of  patient mandible and maxilla 
• 3D photograph overlay on the patient soft-tissue profile 
For additional information about the Invivo Model service, please contact Osteoid at (408) 333-3484 or email us at 
info@osteoidinc.com. 

• Go to Model Tab. 
• Control Panel: Simulation, from the drop-

down menu choose an existing simulation 
(TeethMovement, JawArticulation) or create 
a new one (select Edit). 

• Move the slider to the very end (Frame 100).  

 

• Select a model adjust and the move widget should appear.  
• Use the move widget to adjust the final position of  the model. 
• Moving the slider (Frame 0 to 100) moves the model between the initial and final positions. 
• To adjust intermediate model positions, move the slider to an intermediate frame (between Frame 0 and 

100). Use the move widget to adjust the model position. 
• Moving the slider (Frame 0 to 100) moves the model from the initial position, through intermediate 

positions, and to the final position. 
• The position of  the models set on the frames can be edited through the Manage Keyframes option. 
 

mailto:info@osteoidinc.com
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 View Sequence: 
• To create a video of  the simulation, select the View 

Sequence button from the Model Toolbar to open the 
View Sequencer Window. 

• Much like the Volume Render View Tab (pg. 73), frames 
with various volume orientations, clippings, colorizations, 
etc. can be inserted. 

• Adjust rendering window image to desired settings 
(orientation, volume colorization, etc.) and move the 
Simulation slider to Frame 0. 

• Press Insert in View Sequencer window. 
• Adjust rendering window image to desired settings 

(orientation, volume colorization, etc.) and move the 
simulation slider to Frame 100. 

• Press Insert in View Sequencer window. 
• Test the video using the Start, Play, and End buttons in 

the View Sequencer window. 

 
Movie Capture: 
• If  needed, make any necessary changes (Insert new views 

or Modify/Delete existing views) until the simulation is as 
desired. 

• Once the  view sequence is finalized, select VIDEO 
Capture to open the Movie Capture Window.Please refer 
to Volume Render Tab: View Sequence Section (pg. 73) 
for additional descriptions. 

• Capture the view sequence to save the simulation as an 
AVI movie file. 
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TxSTUDIO7 Additional Modules 

 
 

  
 
 
 
 
 
 
The following modules are sold separately. To find out more information about these modules, please 
contact Osteoid at (408) 333-3484 or at info@osteoidinc.com 
  

mailto:info@osteoidinc.com


T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 165 of 256 UM-TXS-ENG-71 

3DAnalysis Module Features 
The 3DAnalysis View Tab shows the patient in three-dimensional, reconstructed views and allows for exploring the internal 
structures and never-before-seen anatomy of  the patient. With 3DAnalysis, the user can construct various landmarks and profiles, 
calculate 3D and 2D measurements, and report analytical results. 

 

 
Warning: 3DAnalysis module is not a medical device and should be used as a reference or presentation tool only. 
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3DAnalysis: Toolbar 
Shown below are the Toolbar and tools that are loaded with the 3DAnalysis View Tab: 

 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Marker: Select this option to mark a point on the volume and X, Y, Z coordinates (axial, sagittal, 
vertical) appear. Clicking on the point and moving the cursor can modify points. Click on the point 
and press the “delete” key to delete it. Control Panel features allow the values to be hidden or 
exported to a report. 

  

Distance Measurement: Select this option and mark two points on the volume, and the distance 
appears. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. 

  

Angle Measurement: Select this option and mark three points on the volume and the angle 
between them appears. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it. Control Panel 
features allow the values to be projected to 2D, hidden, or exported to a report. 

  

Polyline Measurement: Select this option and mark any number of  points in the slice view. Right-
click to end the measurement, and the total distance appears.  Clicking on the nodes and moving the 
cursor can modify points. Click on the measurement and press the “delete” key to delete it. 

  

Arc Widget: Places an arc visual on the volume displaying the arc angle and radius of  the circle 
containing the arc. Requires the placement of  three points, the first marking the center of  a circle 
and the last two marking the endpoints of  the arc. 

  
Reorientation: Click to change patient orientation. 

  
Tracing Tasks: Perform and edit the tracing tasks defined through series of  picking landmarks 
and/or drawing profiles. (Refer to 3DAnalysis: Tracing Tasks for more information, pg. 174.) 
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Create Face Photo: Opens the Create Face Photo Wrapping dialog. The dialog provides guided 
steps to producing a 3D photo wrap of  the scan volume using textures from a photograph. 

  

Superimpose Tracing: Opens the Tracing Superimposition dialog. The user can select a case and 
configure landmarks within this window to perform a landmark-based superimposition. This dialog 
also contains the Superimposed Tracing Visibility Controls. 

  

3D Surgery: Opens 3D Surgery dialog. Surgical cuts, bone movement, and rotations can be 
simulated. The post-surgery volume can be further analyzed based on the analysis and the soft-
tissue prediction. 

  

Profilogram: Opens Profilogram dialog, converting the the pre- and post-surgery tracings (if  
available) to profilograms. Certain visibility options are available, and the registration settings can be 
changed. 

  

Visual Preference: Change color preference and define displaying type (For more information 
refer to 3DAnalysis Settings, pg. 195.) 

  
Information Display: Displays or hides case information embedded in the data. 

  
View Sequence: Allows for the creation of  custom camera sequences and AVI file movie 
capturing. Refer to the View Sequence description. 

  
Settings: Define and change definitions of  landmarks, measurements, references, analysis, norms, 
and soft tissue deformation ratios. Define and change other preferences related with 3DAnalysis. 

  
Save Information: Opens a dialog containing commands for managing the 3DAnalysis 
configuration files, saving/exporting tracing data, and for building measurement norm data. 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. The software reports the value based on user-picked points. Due to the nature of  the medical 
imaging, the boundary is not always well defined. The apparent boundary depends on the current brightness and 
contrast setting. The boundary may shift as the user makes adjustments to brightness and contrast. The user must 
understand the limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or 
software problems with measurements, or have further questions or concerns about using measurement tools correctly, 
please contact us at (408) 333-3484 or email us at info@osteoidinc.com 

mailto:info@osteoidinc.com
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3DAnalysis: Control Panel 

 

Create Tracing: Perform and edit the tracing tasks that are 
defined with some series of  picking landmarks and/or drawing 
profiles. (Same as Tracing Tasks button on toolbar. For more 
details refer to 3DAnalysis: Tracing Tasks, pg. 174.) 
Layout: Configure layout options for the rendering window. 

• Slice Locator: Aid for picking landmark location. 
• Text View: Provides visibility options and values for 

landmarks, measurements, reference planes, and analysis 
configurations. 

• Print Out: Changes rendering window to a life-size printer-
friendly version of  the volume and tracing. Not compatible 
with slice locator view. 

View Control: 
• Visible: Allows the 3D volume rendering to be turned on or 

off  from view. 
• Quality: Box can be clicked on or off  to further enhance the 

quality of  the image. 
• View Presets: Different settings allow for better visualization 

of  certain anatomic structures, soft tissue profiles, hard tissue, 
etc. This is achieved by displaying specific densities with 
specific colors and transparencies.  

• Brightness & Contrast: Can be adjusted for each of  the 
presets to enhance the image. 

Clipping: Click the “Enable Clipping” box to slice the image along 
the predefined anatomical planes (sagittal, axial, coronal, and arch). 
Scrolling the mouse wheel or moving the slider moves the clipping 
plane. To switch a view to the opposite side, click “Flip.” Fine clipping 
is activated by scrolling with the mouse scroll wheel while the “Ctrl” 
key is pressed. 

Models: 
• Visible: Allows the 3D models to be turned on or off  from view. 
• Visibility Control: Select individual 3D Models to be turned on or off  from view. 
Skin: 
• Show Skin: Turns either pre- or post-surgery skin on or off. 
• Wireframe: Converts the skin to a wire-mesh form. 
Tracings: 
• Toggles the visibility of  the pre-and post-surgery tracings. 
Model Animation:  
• Create, edit, or play model simulations within the rendering window. 
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3DAnalysis: Coordinate System 
 
Context: 

The coordinate system is very important for any three-dimensional (3D) system. It defines the structure for 
subsequent measurements and analyses. Even though the absolute measurements such as linear distance or 
angular measurement are invariant to the coordinate system, any projected measurement, such as the angle 
projected to mid-sagittal plane is significantly influenced by the coordinate system. Thus, it is essential to establish 
a sound coordinate system before any measurements or analysis can be done. 

There is a coordinate system for 2D images, too. However, given its simplicity, one may not realize it as a 
coordinate system but more or less direction. In general, for a two-dimensional system, one simply needs to 
determine a single axis and the other is often determined as orthogonal to the first. In traditional 2D 
cephalometrics, the Frankfort horizontal plane could serve as the horizontal axis. By default, the vertical axis is 
defined from this Frankfort plane. 

In a 3D coordinate system, however, it is more complicated. One has to define three axes, and (for a typical 
Cartesian coordinate system) they must be orthogonal to one another. Additionally, the origin of  the coordinate 
system could be anywhere but preferably lying on an anatomical feature. The challenge is that anatomical 
landmarks and coordinate axes are not necessarily aligned; a line connecting two landmarks may not serve as the 
correct coordinate axis. 

From a mathematical perspective, any coordinate system based on finite number of  3D coordinates is relatively 
simple linear algebra. Thus, any desired coordinate system can be established by a linear combination of  the 
landmark coordinate values. Such definitions may be difficult to understand for clinicians and may not have 
anatomical meaning or agree with existing analysis schemata. 

 

In this software, we propose a coordinate system construction scheme with the following essential goals: 

1. Support for existing clinical concepts 

2. Freedom to establish user-defined coordinate system(s) 

3. Interface that is easy to set up and understand 

  



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 170 of 256 UM-TXS-ENG-71 

Coordinate System: Click to change coordinate system.  

 

 

• No Coordinate System for Tracing: 
Do nothing to define the coordinate system. Use 
current coordinate settings. 

• By Move Widget: Use Move Widget to define the 
coordinate system before performing tracing tasks. 

• By Picking Landmarks: Define the coordinate 
system by picking landmarks predefined on the 
Define Coordinate System dialog (below). 

• Reset to Image Coordinate System: Cancel the 
current coordinate system definition and return to 
the original patient coordinate system. 
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Defining the Coordinate System by Picking Landmarks: 

Two methods of  defining the coordinate system by landmarks are available in 3DAnalysis. Switch between the 
methods in the Define Coordinate System window by pressing the Coordinate System button in the toolbar, 
selecting “By Picking Landmarks” and pressing Change. Alternatively, the Define Coordinate System window can 
be accessed in a similar manner but through the Tracing Guide window. The images above show the orientation 
of  axes and anatomical terms of  location. 

Step 1: Define Origin 

Irrespective of  which method is chosen when defining the coordinate system, a landmark must be selected to 
serve as the origin for measurements, references, and the analysis. 

Next, choose the method of  determining the coordinate system: 

• Mid-sagittal plane-oriented coordinate system 
• Horizontal plane-oriented coordinate system 

 
Step 2: Define Plane for Coordinate System (Mid-Sagittal Plane Method) 

The mid-sagittal plane can be established by two methods: 

1. Use 3 Points Defining: Define two additional points. With the origin defined (Step 1), a total of  three points 
defines the mid-sagittal plane. 
 Ex: Origin – nasion, two points – anterior nasal spine and basion. 

2. Use L-R Vectors and a Point of  Origin: Choose two points on either side of  the volume (left and right sides) 
to create a vector. The mid-sagittal plane is set normal to the vector and intersects the origin. 
 Ex: Origin – nasion, two points – left and right porion. 

The origin must be located on the mid-sagittal plane. Step 3 determines the perpendicular axes. 

 

R L 

I 

P A 

X-Axis Z-Axis 

Y-Axis 

S 



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 172 of 256 UM-TXS-ENG-71 

Step 3: Define Axis for the Perpendicular Plane (Mid-Sagittal Plane Method) 

From the mid-sagittal plane, the X-axis is defined as normal to the plane. The perpendicular Y- and Z-axes (sitting 
on the plane) can be determined by projecting a vector onto the mid-sagittal plane to define one and setting the 
other as normal to this plane. There are two manners of  determining the Y- and Z-axes using this method: 

1. Define A-P Axis (Horizontal Plane): choose two landmarks to connect anterior to posterior and serve as the 
horizontal plane. 
 Ex: Point 1 – right orbital, Point 2 – right porion → Frankfort horizontal plane 

2. Define F-H Axis (Frontal Plane): choose two landmarks to connect head to foot and serve as the vertical 
plane. 
 Ex: Point 1 – nasion, Point 2 – anterior nasal spine → frontal plane 

 

*  *  * 

 

Step 2: Define Plane for Coordinate System (Horizontal Plane Method) 

The horizontal plane can be established using three landmarks. 
 Ex: Point 1 – right orbitale, Points 2, 3 – left and right porions 
        Defines the 3D Frankfort horizontal plane 

The origin must be located on the horizontal plane. Step 3 determines the perpendicular axes. 

Step 3: Define Axis for the Perpendicular Plane (Horizontal Plane Method) 

From the horizontal plane, the Z-axis is defined as normal to the plane. The perpendicular X- and Y- axes (sitting 
on the plane) can be determined by projecting a vector onto the horizontal plane to define one and setting the 
other as normal to this plane. There are two manners of  determining the X- and Y-axes using this method: 

1. Define A-P Axis (Mid-Sagittal Plane): choose two landmarks to connect anterior to posterior and serve as the 
mid-sagittal plane. 
 Ex: Point 1 – basion, Point 2 – nasion 

2. Define L-R Axis (Frontal Plane): choose two landmarks to connect laterally and serve as the frontal plane. 
 Ex: Point 1 – left porion, Point 2 – right porion 

 

When Steps 1-3 are completed, press the OK button to save the settings and close the Define Coordinate System 
window. 
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Note: 

In traditional 2D cephalometry, the sagittal direction is constructed between porions. In 3D cephalometry, there is 
a dilemma in that the sagittal axis (porion to porion) and the mid-sagittal plane (nasion, anterior nasal spine, sella) 
cannot be achieved simultaneously. 

If  porion-to-porion is chosen to be the sagittal axis, the orientation of  the mid-sagittal plane is defined by the axis 
and one landmark could define it completely. Consequently, the other landmarks may sit close but not exactly on 
the mid-sagittal plane. 

Alternatively, if  the mid-sagittal plane is constructed using three landmarks (nasion, anterior nasal spine, sella) then 
the sagittal axis is defined from the mid-sagittal plane. This axis may not be parallel to the vector connecting the 
two porion points. 

Using 3D cephalometrics allows for more accurate measurements and analysis. However, there are discrepancies 
with traditional 2D analysis (such as the one listed above, so caution should be used in defining the coordinate 
system, landmarks, references, etc. to minimize these differences. 
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3DAnalysis: Tracing Tasks 
Now that the patient coordinate system is established, start picking points. The first set of  points are the 
coordinate-system associated landmarks, followed by other landmarks and profiles.  

Note: If  placing points on the volume due to the predefined rendering, angle, and clipping settings is challenging, 
please refer to the 3DAnalysis: Tracing Guide section (pg. 206) to edit the view states. 

Tracing Tasks:  
To begin tracing the rendered volume, press either Create Tracing in the Control Panel or the Tracing 
Tasks button in the toolbar.  
 
The Tracing Tasks window should open and list the order of  Tracing Tasks to be performed. By default, 
the window opens in editing mode. (See Tracing Tasks – Editing Mode). Once a tracing task has 
been started, pick points on the rendered volume to define landmarks and profiles. 
 

 

Start: Starts the first listed undefined tracing task. The tracing tasks 
required for defining the coordinate system are done first and prefixed 
with “Coord_sys.” After defining the coordinate system Tracing Tasks, 
double click to start specified tracing tasks or selecting them  and 
pressing the Start button. The currently selected tracing task is marked 
with a cross-hair symbol  and completed tracing tasks are marked 
with a check . 

• Close: Stops current tracing task and closes the Tracing Task 
window. 

• Stop: Stops current tracing task and returns to the editing mode 
in the tracing task window. 

• Setup: Opens the Tracing Guide window. 
• Restart All: Discards completed tracing tasks and restarts from 

the first tracing task. 
 
Tracing Tasks – Editing Mode: 

To enter Editing Mode simply open the Tracing Tasks window 
by clicking on Create Tracing. When in editing mode, one can 
modify completed landmark positions and profile lines. 
Landmark positions and profile points are highlighted on the 
volume in the rendering window. Move the mouse over the 
landmark or profile point. Left-click and drag the landmark or 
profile point to the new desired location. Releasing the left-
button finalizes the new position of  the landmark or profile 
point on the volume. Selecting a landmark or profile point also 
highlights the point on the Slice Locator, where the point can be 
further adjusted. This technique helps move and adjust profile 
lines quickly without re-tracing the entire structure. 
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Tracing Task Examples and Tips 
 
Notes About Landmarks/Profiles:  
 

• Many common landmarks are associated with profile tracings. These landmarks therefore only show 
on the volume and have a coordinate value when the corresponding profile tracing is completed (ex. 
Condyle point Co_R with the Right Mandibular Profile). Contact Osteoid Support and see the 
section Default Tracing Tasks and Landmarks (pg. 208) for more information about these 
automatic definitions. 
 

• Users can pick points for landmarks or profiles on models. These models can be in the form of  Skin 
or Tooth Invivo Models as well as models created and/or imported into the Model Tab from MD 
Studio. (MD Studio is an add-on module for TxSTUDIO7.) 

 
 
The following pages demonstrate profiles and associated landmarks that are integrated into the default 
configuration file from the initial installation. 
 
 

  

 

Warning: Results produced by the software's diagnostic and planning tools are dependent on correct selection of  
landmarks by the user in the 3D volume. The software reports values based on these user-picked points. Due to the 
nature of  medical imaging, the boundaries are not always well defined. The apparent boundaries depend on the current 
brightness and contrast settings. The boundaries may shift as the user makes adjustments to brightness and contrast. The 
user must understand the limitations of  the measurement values before applying to the patient. If  you notice any 
inconsistencies or software problems with measurements, or have further questions or concerns about correctly using 
measurement tools correctly, please contact us at (408) 333-3484 or email us at support@osteoidinc.com 

mailto:support@osteoidinc.com
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Mandibular Profile 
Be sure to include the profiles of  
the condyle, mandibular notch, and 
corpus. Follow the curve to include 
the gonion and antegonion. The 
antegonion, condyle, and gonion 
locations are determined in the 
software through the profile. Always 
verify the location of  the 
antegonion; open the tracing task to 
activate Edit mode and drag to 
modify. 
 
Structure contains: 
Co –  Condyle 
Go – Gonion 
Ag – Antegonion 

 

 
Maxillary Profile 
Start the profile near the anterior 
interface of  the upper incisor and 
follow the profile of  the maxilla 
back to the posterior interface of  
the incisor. Adjust the brightness 
and/or contrast levels to show the 
anterior nasal spine (ANS) and 
include that in the tracing profile. It 
is recommended that a profile point 
is placed at or very near the ANS. 
Note: Using the default user-picked 
ANS replaces the automatically-
defined profile ANS. The Pr point is 
placed at the location of  the first 
click. 
 
Structure contains: 
ANS – Anterior Nasal Spine 
PNS – Posterior Nasal Spine 
A – A point 
Pr – Prosthion 
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Orbital Profile 
Trace the most anterior part of  the 
ridge usually noticeable based on the 
brightness (whiteness) of  the bone 
around the orbit. Follow this ridge 
from the zygomatic suture to about 
the medio-orbital. If  the orbitale is 
included as a landmark (ex: for 
Frankfort horizontal), it is 
recommended to include this point 
as a profile point in the tracing. A 
user-defined Or_L or Or_R 
landmark overrides the automatic 
Or landmarks. 
 
Structure contains: 
Or – Orbitale 

 
 
Soft-tissue Profile 
(Upper) 
Adjust the brightness and/or 
contrast of  the image to see the 
soft-tissue profile. Trace it from the 
top of  the head to the lips. The 
upper soft-tissue should include the 
profile of  the upper lip. 
 
Structure contains: 
Soft N – Soft Tissue Nasion 
Pn – Pronasale 
Ls – Labrale Superius 
Sts – Stomion Superius 
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Soft-tissue Profile 
(Lower) 
Adjust the brightness and/or 
contrast of  the image to see the 
soft-tissue profile. Trace it from the 
lips to below the chin. The lower 
soft-tissue should include the profile 
of  the lower lip. 
 
Structure contains: 
Sti – Stomion Inferius 
Li – Labrale Inferius 
Ils – Soft-tissue B point 
Soft Pog – Soft-tissue Pogonion 
 

 
 

 
 
 
 

 
 
Symphyseal (Mandible) Profile 
The profile should start near the 
anterior interface of  the lower 
incisor, follow the curvature of  the 
symphysis and finish at the posterior 
interface of  the lower incisor. The 
Id point is placed at the location of  
the first click. 
 
Structure contains: 
Id – Infradentale 
B – B point 
PM – Protuberance Menti 
Pog – Pogonion 
Gn – Gnathion 
Me – Menton 
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Teeth (Molar) 
Place the first point at the tip of  the 
anterior root for the molar. Place the 
next point at the tip of  the anterior 
cusp. Place the final point at the tip 
of  the posterior cusp. This 
procedure is applicable to the upper 
and lower molars (only lower molar 
shown at right). 

 
 

 
 

 

  
 
Teeth (Incisor) 
Place the first point at the tip of  the root for the incisor. Place the next point at the tip of  the crown. Place 
the final point on the most labial side of  the tooth. This procedure is valid for both the upper and lower 
incisors (only upper is shown). 
 
Frontal Incisor Profiles require an additional fourth point, located at the most mesial point of  each central 
incisor. When performing the tracing task, trace the first three points using the sagittal view and then use 
the frontal view to place the fourth point. Use the toolbar orientation buttons to rotate the volume during 
a tracing task. 
 
Note: When adding the Frontal Incisor Profiles to the current tracing task list, first ensure that the frontal lateral 
profiles are no longer on the list before they can be added. The two types of  frontal incisors are not intended to 
be used simultaneously. 
 



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 180 of 256 UM-TXS-ENG-71 

3DAnalysis: Text View 
 
Once the landmarks have been defined on the volume, visualize the results of  the analysis. Most of  the data is in 
the Text View, available under the Layout section of  the Control Panel. Once Text View has been checked, a pane 
appears on the right side of  the screen. If  any of  the contents extend beyond the bottom of  the screen, use the 
mouse wheel to scroll down the list. Text View includes the following tabs:  

 

 

Landmark: List of  currently traced landmarks and 
the respective position values. Clicking the landmark 
line can set the display of  the landmark name 
On/Off  on the volume. Clicking the group line can 
set the display of  all landmarks in that group 
On/Off  at the same time. 

 

 
Measurement: List of  respective values of  available 
measurements defined in the analysis. Clicking the 
measurement line can set the display of  the 
measurement name, value, and reference line 
On/Off  on the volume. Clicking the group line can 
set the display of  all the measurements of  the group 
as On/Off  at the same time. When measurements 
are calculated and projected onto a plane, a '*' is 
shown in the unit column. 

 

 

 

Reference: List of  currently available references. 
Clicking the reference line/plane can set the display 
the name and line/plane of  the reference line/plane 
On/Off  on the volume. Clicking the group line can 
set the display of  all references of  the group as 
On/Off  at the same time. 
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Analysis: Report and wigglegram of  currently 
available measurements in the specified analyses. 
Display current ethnic norm group. Click the norm 
group name to change the default ethnic norm 
group. 
 
Clicking the analysis name (“Default” in the left 
example) makes all measurements within that 
analysis visible in the rendering window. Clicking an 
analysis subgroup name turns on visibility for all 
measurements under that subgroup. 
 
 
For VCA analyses, clicking the analysis name turns 
on visibility for any VCA-configured measurements 
in the rendering window. Clicking an analysis 
subgroup name turns on visibility for any VCA-
configured measurements under that subgroup. 
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Colored Wigglegram 

 

The wigglegram features a user-customizable color 
gradient to convey analysis results. The color 
corresponds to the number of  standard deviations 
the measurement value differs from the norm.  
Ex. Values that differ between 0 and 1 SD show up 
as a blend of  green and yellow.  
 
Configure visibility settings in the Visual Preferences 
dialog: 
 

Features: 
 

• (Color) Visibility On/Off 
 

• Customizable 4-Color Gradient 
 

• Color Correlation with VCA Color Indicators 
 

• Compatible with Frontal Analysis Wigglegram 
(see below).  

 

 

Warning: The analysis results are dependent on the norm values that are configured within each configuration file, which 
may contain predefined as well as user-defined data. The predefined norms that are available upon installation may or 
may not be based on accepted clinical values for the respective measurements. Users must verify the validity of  norm 
values that will be used before applying this function on patient data. For further questions regarding the function, 
configuration, and validity of  norm data, please contact the Osteoid Support Department at (408) 333-3484 or 
support@osteoidinc.com. 

 
 
 
 
Frontal Analysis Mode:  
 
The measurement values and wigglegram take a new 
format when an analysis is configured to be of  a 
“frontal” variation. Refer to the 3DAnalysis: 
Advanced Analysis Configurations section  
(pg. 187) for more information. 
 

 

Right Values Left Values “Symmetry” 
Wigglegram 



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 183 of 256 UM-TXS-ENG-71 

3DAnalysis: VCA Mode 
3DAnalysis capitalizes on the fact that a large part of  an analysis can occur visually. With the introduction 
of  VCA (Visual Craniometric Analysis) colored indicators, an analysis can be customized to reveal an overall 
picture of  a patient’s clinical state by providing only the necessary level of  numerical detail without 
overburdening the user. While the quantitative information is still available, the colored indicators draw 
attention back to the most necessary part of  the analysis – the volume – while also saving time and effort. 
 

 

How It Works: VCA colored ball indicators are tethered to individual measurements. When these measurements 
are selected in the Analysis Tab (by subgroups or analysis name), the VCA ball indicators will appear in the 
rendering window with a color that is dependent on the deviation of  the measurement value from the norm. The 
proper configuration can allow the user to determine the areas that require attention without needing to see the 
exact measurement values. 

Configuring a VCA: 

• Change the name of  the analysis to indicate a VCA configuration 
 

• Configure individual measurements values to have VCA landmarks 
 

• Trace the case, turn on VCA landmarks in the Text View 
 

Continue on in the section for more details on these tasks.  
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Choose An Analysis/Rename to VCA Configuration: 

Any analysis can be configured to include VCA indicators. Open the 3DA Setup dialog with the  icon and 
navigate to the Analysis Tab. 

  

1. Left click on the name of the desired 
analysis. “Default” chosen in this 

example. 

2. Click the Edit button. 

3. The Define/Edit Analysis window 
appear. Change the name to end in 

“_VCA”. 

4. Click OK to exit the Define/Edit Analysis 
window. Then, click OK to exit 3DA Setup 

completely. 



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 185 of 256 UM-TXS-ENG-71 

Configure Individual Measurements: 
 

Open the 3DA Setup dialog with the  icon and navigate to the Measurement tab of  this window (third 
from the right). For this step, it would help to have a list of  measurements handy as a reminder of  which 
ones to configure. 
 

  

1. Left-click on the line of the 
measurement to be configured. 

2. Click Edit. 

3. Click drop-down next to VCA 
Landmark; choose a landmark (does 

not have to be part of the 
measurement definition). 

4. Click OK to exit the window. 
Repeat for additional measurements. 

(Note: Multiple measurements 
cannot be configured to the same 

VCA landmark.) 
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Trace the Case/Turn on VCA Landmark Visibility: 
 
Trace the case so that the necessary landmarks are completed for the analysis as well as for the VCA 
landmarks. Alternatively, a pre-traced case can be opened. 
 

 
 
 
If  the VCA landmarks fail to appear, causes may be: 
 

• The analysis name is not properly configured. (See pg. 187.) 

• The VCA landmarks configured to the measurements are not properly configured or traced. (See pg. 187.) 

• There is no available norm data for the measurement. 

 
 
 
 

Additional VCA Settings (  Visual Preferences) : 
 

• VCA indicator color settings are tethered to the Wigglegram Polygon Color. Change the settings for the 

colored wigglegram to change the color of  VCA indicators. 

• VCA indicator ball radius can be set to between 2 and 9 mm. 

• VCA indicator ball opacity can be changed to an opacity percentage preset (0, 25, 50, 75, 100). 

 

  

Click the analysis name to show ALL 
VCA Landmarks within that analysis. 

Click the subgroup name to show 
only VCA landmarks within that 

subgroup. 
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3DAnalysis: Advanced Analysis Configurations 
3DAnalysis can be configured to become a more effective tool for certain analyses. Currently, additional 
features are supported for “frontal” analyses as well as the Sassouni Analysis. 
 
 
Configuring a Frontal Analysis 
 
The wigglegram features a special “Frontal Analysis” 
mode to support frontal analyses. The benefit of  this 
mode is a more succinct format of  measurement 
presentation. Both the measurement values and 
wigglegram adapt to show the left and right values of  
a certain measurement on the same line. 

 
Two Aspects to Configure: 

• Measurement pairs that are identical except for a 
“_R” or “_L” to indicate the left and right side 
(ex. Co_R to MSP, Co_L to MSP) 

• The analysis name must end in “_Frontal”.  
 
NOTE: A frontal analysis can only contain pairs of  symmetry 
measurements (_L, _R). If  the analysis contains measurement 
pairs AND singular measurements, the analysis must be split. 
The singular measurements should be in a separate analysis 
without the “_Frontal” suffix. 
 
 

 
 

 

 
Configuring a Sassouni Analysis 
 

A special feature exists that creates an automatic 
Sassouni O-Point if  the appropriate data is present. The 
O-Point definition is based on the generally accepted 
Sassouni principle that states it is the midpoint of  the 
shortest vertical line segment that contacts all four 
prerequisite planes. 

To Automatically Generate O-Point: The following 
four default planes must be traced: Parallel, Mandibular, 
Maxillary, and Occlusal Plane R. After tracing these 
planes, open/close to refresh the Create Tracing window 
to activate the O-Point. The Sassouni O-Point is a 2nd 
Tier landmark. 

 

  
NOTE: The Parallel Plane requires the Supraorbitale Plane 
to be defined. The following Sassouni-specific landmarks 
are therefore required: Si, RO, Cl. 

 
  

Right Values Left Values “Symmetry” 
Wigglegram 
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3DAnalysis: Create Face Photo 
3DAnalysis allows the user to wrap a common digital photograph over the patient’s soft tissue. This creates 
a realistic 3D “skin” that takes the texture of  the photograph and can be used to great effect in performing 
soft tissue simulations and patient demonstrations. The steps to creating a face photo wrap are as follows:  

Click the  Create Face Photo to open the dialog. There are two methods available. 
Generate face from photo: 

 

 

The objective is to move the 
slider until a smooth soft tissue 
frontal profile is visible. This 
setting determines what level of  
tissue is used when creating the 
face model. Click Create Face 
Model when the correct setting 
is found. The face model is 
created and automatically 
smoothed. 
 
“Optimize for Simulation”: 
When checked, the software 
automatically reduces the 
number of  triangles used in the 
model to 40,000. This is the 
optimal setting for soft tissue 
simulations. 

 

 

Click Apply Cutting. Use three 
cuts to trim away unnecessary 
parts of  the face (that may cause 
distortion when the photo is 
applied). The first cut goes 
through the face coronally just in 
front of  the ear. The second cut 
falls under the jaw line, making 
sure the cutting plane aligns with 
the mandibular plane. The third 
cut goes axially across the top of  
the skull. Use the arrows to 
move the cutting plane and click 
the right mouse button to 
perform the cut. Click Finish 
Cutting when all unnecessary 
sections have been removed. 
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Click Load Photo and choose 
the appropriate photo from the 
file browser. Check to turn on 
“Make Face Model Transparent” 
and “Show Registration Grid” 
(intersections indicate 
registration points) and use 
image navigation tools to align 
the photo, taking special care in 
the lip and nose regions. Click 
Apply Photo Wrapping when 
the correct alignment is found. 

Load Face (.obj): 

 

 

Load the 3D object file and the 
corresponding texture file. 

 
 

The textured skin model can now 
be aligned to the volume either 
manually using the widget tool or 
automatically if  the soft tissue 
profiles of  the case have been 
traced. The automatic alignment 
process involves placing 
landmarks onto the textured skin 
model. 
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3DAnalysis: Landmark-Based Superimposition 
A superimposition can be performed on the current tracing using any saved tracing or case (.inv,.ctr, or 
.dcm) file and user-configured landmarks. This feature combines the visual analysis aspect of  volume 
superimposition with the quantitative details provided by a cephalometric analysis.  
 

 
 

 
Features: 
 

• View measurements from both volumes in the same window with easy toggle switching 
 

• Visibility On/Off  for superimposed volume, tracing, or data 
 

• Automatic superimposition of  volumes after one-time landmark configuration setup 
 

• Allows for a template-based analysis (with superimposed saved tracing) 
 

• Compatibility with VCA and frontal configurations 
 

• Orientation synchronization with the Superimposition Tab 
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Performing Landmark-Based Superimposition 
 

Click the  Superimpose Tracing icon to open the 
dialog. 
After tracing a case in 3DAnalysis, the user can select 
another traced case (.inv) or tracing file (.ctr) to 
superimpose over the original.  

• Click Select Traced Case... to browse for the file. 
Select the case or saved tracing and click Open to 
close the browser. If  an untraced case is chosen, an 
error appears indicating that there is no tracing data. 

• Click Configure… to open the Configure Landmark 
Superimposition window:  
 

 
 

• Select a minimum of  four landmarks from the 
current landmark list and click Add to move them to 
the left. The selected landmarks are checked with the 
superimposed tracing. If  they have been traced, these 
landmarks are used to register the two scans. Click 
Remove Landmark to remove landmarks from the 
superimposition registration. Click Save to Exit.  

• Verify the available landmarks. If  the configured 
landmarks do not appear in this section, there is no 
tracing data available for those landmarks in the 
selected case.  

• Click Perform superimposition and exit to 
perform the registration with the current 
configuration. This window automatically closes. 

• Revisit this window to perform superimposition with 
another case (deleting the current superimposition), 
reconfigure the superimposition landmarks, and to 
toggle the following visibility options (“Superimposed 
Volume,” “Superimposed Tracing,” and 
“Superimposed Data”). 

Tip: For performing a template-based analysis, the user can 
superimpose the saved tracing template to the patient scan 
using mid-sagittal plane landmarks.  
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Superimposition Text View 
 
After a superimposition has been performed with a traced case, the Text View can be toggled to show either 
the tracing/analysis data for the current or superimposed case.  
 
The Text View can be toggled by: 
 
• Checking/unchecking the box next to “Show SuperImposed Data” in the Superimpose Tracing dialog. 
• Clicking the “Superimposed” or “Default Tracings” banner above the text data to toggle data sets.  
• Pressing “s” on the keyboard.  

  
 
The yellow “Superimposed” text indicates which data set the Text View is currently displaying. The 
Measurement tab includes the differences in coordinates for the shared landmarks. Clicking the 
Superimposed banner toggles the measurement, analyses, and colored wigglegram between the original and 
superimposed cases, allowing the user to easily compare the two sets of  data. 
 
If  toggling reveals a discrepancy in the available measurements, landmarks, or references, then check to 
make sure that the two cases contain the same traced landmarks and profiles.  
 
Other than the profile line color, visual preferences are locked for the superimposed case – only the visual 
preferences for the current case can be changed. Alter these settings to help differentiate between the two 
data sets, such as angle and line color. Superimposed tracing color is yellow by default.  
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How Does 3DAnalysis Work with the Superimposition Tab?  
 
3DAnalysis landmark-based superimposition and Import Volume within the Superimposition Tab achieve 
the same basic purpose with some differences only in the available tools and method of  superimposition. 
The compatibility of  the two methods of  superimposition is explained below. 
 
 
Only one superimposition can be supported at a time 

• Users can either choose to import a saved tracing using the Import New Volume function of  
Superimposition tab or the Superimpose tracing function of  3DAnalysis. The volume will be visible in 
both views, with additional tracing data visible in 3DAnalysis if  it exists.  

• Trying to superimpose an additional case in either tab with a superimposition already performed 
overwrites the currently superimposed case. Mirror Own Volume also overwrites the current 
superimposition. 

• Changes in orientation performed in one tab affect the other tab. The benefit of  this is that a user can 
superimpose to landmarks in 3DAnalysis and then move to the Superimposition tab and perform an 
additional volume-based registration to fine-tune the location of  the superimposition. 

 
 

The following settings must be performed in the Superimposition Tab (to take effect in 3DA): 
• Clipping 
• Volume rendering presets 
• Brightness and contrast settings 
• Volume Registration 
• Adjustments by Move Widget 
 
 

The following settings overlap between the two tabs: 
• Superimposed volume on/off 
• Landmark registration (in 3DA, this is performed automatically with preconfigured landmarks) 
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3DAnalysis: Layout Options 

 

Slice Locator: This three-paned window allows the user to adjust the placement of  points using multiple viewing 
angles of  the same location: axial, coronal, and sagittal. This tool is important for placing landmarks that require 
increased accuracy, such as the top of  the condyle head. The panes are zoomed-in to provide additional accuracy. 

 
Text View: Contains visibility controls and values for landmarks, measurements, reference planes, and analysis 
configurations. 
 

Print Layout: This layout loads preconfigured 
visibility options that are printer-friendly so the 
user can easily share or save a physical copy of  
the analysis results. In this layout mode, 
capturing to Gallery and printing puts the 
volume in life-size. 

Zoom-in and zoom-out features are disabled to 
maintain a life-sized volume, and all text and tracing 
are be black by default. Both the volume and colored 
wigglegram maintain color unless configured differently. 

 

 

Slice Locator 

 

Text View 

Print Out 
View 
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3DAnalysis: 3DAnalysis Settings 
 

Press the 3DAnalysis  Settings icon and a window appears for creating and/or defining any of  the following: 
 

• Tracing Tasks 

• Landmarks 

• Measurements 

• References (Lines, Planes) 

• Analyses 

• Groups 

• Population Norm Data 

• Visual Preference 

• Soft Tissue Ratios 
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Tracing Task: This tab shows the definition list of  current tracing task series. The tracing tasks are 
performed in the order displayed on this list. To change the tracing task order, press the Edit button in the 
bottom left corner of  the window. According to the definition of  coordinate system, the appropriate 
coordinate system defining tasks are always the starting tasks and added automatically. 

 
 

• Edit: Opens “Tracing Guide” dialog to edit the tracing task list or adjust the view states for individual 
tracing tasks. For more information, refer to 3DAnalysis: Tracing Guide (pg. 206). 
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Landmark: This tab shows the definition list of  all available landmarks that can be used for defining 
measurements and references. Each landmark has a unique name and is displayed within the rendering window. 
Landmarks have a group definition for sorting when Text View is activated. User-defined landmarks are marked 
with a star (*) in column 'U.' Predefined landmarks cannot be deleted. User-defined landmarks cannot be deleted 
when used by measurements or references. 
 

 
• Add: Create a new landmark 
• Edit: Edit currently selected landmark 
• Delete: Delete currently selected user-defined landmark 

 
  



T X S T U D I O 7 ®  –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  
 

ANA003 Rev A. 06 DEC. 2023  Page 198 of 256 UM-TXS-ENG-71 

Special Landmark Properties 
 
Underneath the group list, there are two landmark 
properties that can be modified using the adjacent 
checkboxes: 
 
On Mid-Sagittal Plane 
Projects a landmark on any part of  the volume directly to 
the defined mid-sagittal plane. Cannot be used to define 
the coordinate system. 
 
Midpoint 
Automatically creates a midpoint between two landmarks 
when both are traced; there is no tracing task option. 
Clicking the checkbox brings up a Define 2nd Tier 
landmark submenu with two drop-down boxes for 
selecting the parent landmarks. 2nd Tier indicates that the 
placement of  the landmark is dependent on the placement 
of  other landmarks. Midpoints can be used to define the 
coordinate system. 
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Measurement: This tab shows the definition list of  all available measurements. Every measurement has a unique 
name and is be displayed within the rendering window. Measurements have a group definition for sorting when 
Text View is activated. Measurements can be defined in several ways using default and/or user-defined landmarks, 
reference lines, and reference planes. Measurements can be in 3D or projected to a specified reference plane for 
supporting 2D measurements. Measurements cannot be deleted when used in an analysis. 

 

 
• Add: Create a new measurement. 
• Edit: Edit currently selected measurement. 
• Delete: Delete currently selected measurement. 
• Search Landmark: Search for measurements by landmark. 
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Reference: This tab shows the definition list of  all available references. Every reference has a unique name and is 
displayed within the rendering window. References have a group definition for sorting when Text View is activated. 
Reference lines and reference planes can be defined in several ways using landmarks and/or other reference lines 
and planes. References cannot be deleted when used to define other measurements, references or the coordinate 
system (ex: mid-sagittal plane and frontal plane). 
 

 
• Add: Create a new reference line or reference plane. 
• Edit: Edit currently selected reference. 
• Delete: Delete currently selected reference. 
• Search Landmark: Search for references by landmark. 
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Analysis: This tab shows the definition list of  all available analyses. Analyses include existing 2D analysis 
standards (ex: McNamara, Ricketts, Steiner). A custom analysis can be created using default and/or user-defined 
measurements. Only checked analyses are reported within the Text View, and only default analyses can be 
compared to existing data using norm data (compared visually using wigglegram). User-defined analyses can be 
compared to existing data if  the data is added manually (see the Norm Data section, pg. 203). 
 
The tracing tasks required for all of  the measurements of  the selected analysis are displayed under Required 
Landmarks but may need to be manually added into the Tracing Tasks list (see 3DAnalysis: Tracing Guide,  
pg. 206). 
 

 
• Add: Create a new analysis. 
• Clone: Make a copy of  the currently selected analysis. 
• Edit: Edit currently selected analysis. 
• Delete: Delete currently selected analysis. 
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Group: This tab shows the definition list of  all available groups used for landmarks, measurements, and norm 
data. By default, four predefined user Norm Data Groups (My African American, My Asian, My Caucasian and 
My Latin) are automatically generated within the definition list. A user-defined Norm Data Group can reference 
an external norm data file or CSV file. This file can be an accumulated measurement archive file. 
 

 
• Add: Create a new group. 
• Edit: Edit currently selected group. 
• Delete: Delete currently selected group. 
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Norm Data: This tab shows the norm data (mean and standard deviation of  measurements) list of  all available 
ethnic Norm Data Groups that can be used for analysis and displayed graphically using the wigglegram. The 
norm data can be changed at any time in 3DAnalysis to compare the patient's tracings with data from several 
ethnic groups. The default Norm Data Group is Caucasian, but 3DAnalysis includes norm data for other well-
known ethnic groups. Custom Norm Data Groups can be defined using external norm data files (see Group 
section, pg. 202). The mean and standard deviation of  new measurements can also be defined manually within the 
Norm Data tab. 
 

 
• Add: Create a new norm data. 
• Edit: Edit currently selected norm data. 
• Delete: Delete currently selected norm data. 
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Visual Preference: This tab contains options for changing the colors and attributes of  3DAnalysis objects and 
selecting color usage for Print Layout. Select Projection can select projection type of  light source from volume 
object with parallel projection set by default. When “Use Foreground Color” is unchecked, all 3DAnalysis objects 
(landmarks, measurements, references, etc.) are displayed in color on Print Layout. 
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Soft Tissue Ratios: This tab contains the soft tissue deformation ratios across different axes for 3D Surgery 
manipulations. Checking “R-L Matches A-P” matches the R-L values to the A-P values of  the respective 
landmarks automatically. Reset to Defaults reverts the values to the ones shown below.  

 

 
 

 
 
 
  

 
Warning:  Soft tissue prediction is an approximation and may not reflect actual results. 
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3DAnalysis: Tracing Guide 
 
To open the Tracing Guide window, press either the Setup button from the Tracing Tasks window or Edit from 
the Tracing Tasks tab within Settings. 
 

 
 

Tracing Guide: The Tracing Guide window shows a list of  the current Tracing Tasks (left list box) and a list of  
available Tracing Features (right list box). Within the window, Tracing Tasks can be added, moved, or reordered. 
The coordinate system can be changed. The best view settings for specific Tracing Tasks can be redefined.<: Add 
the highlighted Available Tracing Feature to the Current Tracing List. All available landmark definitions and 
predefined profile Tracing Tasks currently not in use are listed in Available Tracing Features box.   

• >: Remove the highlighted tracing task from the Current Tracing List. Coordinate system tracing tasks 
and respective landmarks cannot be removed. 

• Up: Change order to move up that selected tracing task. Tracing tasks near the top of  the list take priority 
when creating tracings. Tracing tasks do not take priority over coordinate system tracing tasks and so 
cannot move above coordinate system tracing tasks. 

• Down: Change order to move down that selected tracing task. Coordinate system tracing tasks cannot 
move below normal tracing tasks. 

• Coordinate system change: The coordinate system options are “No Coordinate System,” “by Moving 
Widget,” or “Picking Landmarks.” Select Change to change which landmarks define the coordinate 
system. Select Change to change which landmarks define the coordinate system. (See 3DAnalysis: 
Coordinate System, pg. 169.) 
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• Use Current View Settings: The default view state of  a tracing task can be changed. Highlight a tracing 
task under the “Current Tracing List.” Set the Rendering Window to a preferred view by adjusting the 
brightness, volume visibility (if  tracing on models for certain tasks), orientation, clipping, etc. (relative to 
the current patient coordinate System). Press Use Current View Settings to save the current view state. 
During tracing, the highlighted tracing task automatically sets the volume to the saved view state.  

 
Note: Before adding the frontal incisor profiles to the current tracing task list, you must first ensure that the lateral 
profiles are no longer on the list. The two types of  incisor profiles are not intended to be used simultaneously. 
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3DAnalysis: Default Tracing Tasks and Landmarks 
 

Name Definition Description 

A A-Point Deepest midline point on the premaxilla between the anterior nasal 
spine and prosthion. Point is determined within the software from the 
maxillary profile. 

Ag_L Left Antegonion Highest point of  the concavity of  the lower border of  the ramus where 
it joins the body of  the mandible (left side). Point is determined within 
the software from the left mandibular profile. 

Ag_R Right Antegonion Highest point of  the concavity of  the lower border of  the ramus where 
it joins the body of  the mandible (right side). Point is determined within 
the software from the right mandibular profile. 

ANS Anterior Nasal Spine Anterior point of  nasal spine defined by the maxillary profile. 

B B-Point Deepest midline point on the mandible between infradentale and 
pogonion. Point is determined within the software from the symphyseal 
profile. 

Ba Basion Anterior point of  foramen magnum. 

Co_L Left Condyle Most posterior superior point on the condyle of  the mandible (left side). 
Point is determined within the software from the mandibular profile. 

Co_R Right Condyle Most posterior-superior point on the condyle of  the mandible (right 
side). Point is determined within the software from the mandibular 
profile. 

Coord_sys ... Coordinate System 
Defining Point 

The landmark (preceded with “Coord_sys”) are used to define the 
coordinate system for subsequent landmarks and tracing tasks. 

Custom Profile Custom Profile Using points with connecting lines, a custom profile can be made to 
highlight a certain anatomical feature. 

Gn Gnathion Point on chin between the menton and pogonion. Point is determined 
within the software from the symphyseal profile. 

Go_L Left Gonion Most outward point on the angle formed by the junction of  the ramus 
and the body of  the mandible (left side). Point is determined within the 
software from the mandibular profile. 

Go_R Right Gonion Most outward point on the angle formed by the junction of  the ramus 
and the body of  the mandible (right side). Point is determined within 
the software from the mandibular profile. 

Id Infradentale Point of  transition from the crown of  the most prominent mandibular 
medial incisor to the alveolar projection. Point is determined within the 
software from the mandibular profile. 

Ils Soft-tissue B Point Deepest midline point on the mandible between the infradentale and the 
pogonion projected onto the soft tissue. Point is determined within the 
software from the lower soft tissue profile. 

Left Mandibular 
Profile 

Left Mandibular 
Profile 

Trace the left-side mandibular profile with a series of  points (double-
click or right-click to finish tracing). Include the coronoid process, 
mandibular notch, condyle, and ramus profiles. 

Li Labrale Inferius Most anterior point of  lower lip. Point is determined within the software 
from the lower soft tissue profile. 

Ls Labrale Superius Most anterior point of  upper lip. Point is determined within the 
software from the lower soft tissue profile. 
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Lower Left Incisor 
Profile 

Lower Left Incisor 
Profile 

Define the profile of  the lower left incisor using 3 points: 
1. Root of  lower incisor (LIroot_L) 
2. Crown of  lower incisor (LIcrown_L) 
3. Labial point of  lower incisor (LIlabial_L) 

Lower Left Molar 
Profile 

Lower Left Molar 
Profile 

Define the profile of  the lower left molar using 3 points: 
1. Anterior root of  lower molar (LMroot_L) 
2. Anterior cusp of  lower molar (LMcusp_L) 
3. Posterior cusp of  lower molar 

Lower Right Incisor 
Profile 

Lower Right Incisor 
Profile 

Define the profile of  the lower right incisor using 3 points: 
1. Root of  lower incisor (LIroot_R) 
2. Crown of  lower incisor (LIcrown_R) 
3. Labial point of  lower incisor (LIlabial_R) 

Lower Right Molar 
Profile 

Lower Right Molar 
Profile 

Define the profile of  the lower right molar using 3 points: 
1. Anterior root of  lower molar (LMroot_R) 
2. Anterior cusp of  lower molar (LMcusp_R) 
3. Posterior cusp of  lower molar 

Lower Soft Tissue 
Profile 

Lower Soft Tissue 
Profile 

Trace the profile of  the lower soft tissue with a series of  points (double-
click or right-click to finish tracing). The lower soft tissue is defined as 
including the lower lip. 

Maxillary Profile Maxillary Profile Trace the profile of  the maxilla with a series of  points (double-click or 
right-click to finish tracing). 

Me Menton Lowermost point of  the mandibular symphysis. Point is determined 
within the software from the symphyseal profile. 

N Nasion Central point along the nasofrontal suture. 

Or_L Left Orbitale Bottom ridge of  the orbitale on the maxilla (left side) 

Or_R Right Orbitale Bottom ridge of  the orbitale on the maxilla (right side) 

PM Protuberence Menti Point above pogonion at top of  crest of  the symphysis or at the point 
of  recess of  the anterior symphyseal curvature. Point is determined 
within the software from the symphyseal profile. 

Pn Pronasale Most anterior point of  the nose tip. Point is determined within the 
software from the soft tissue profile. 

PNS Posterior Nasal Spine Midpoint of  the base of  the palatine bones at the posterior margin of  
the hard palate. Point is determined within the software from the 
maxillary profile. 

Po_R Porion (right) Upper ridge of  the porion (right side) 

Po_L Porion (left) Upper ridge of  the porion (left side) 

Pog Pogonion Most anterior point on the symphysis of  the mandible. Point is 
determined within the software from the symphyseal profile. 

Pr Prosthion Most anterior point of  the maxillary alveolar process in the midline. 
Point is determined within the software from the maxillary profile. 

Right Mandibular 
Profile 

Right Mandibular 
Profile 

Trace the right-side mandibular profile with a series of  points (double-
click or right-click to finish tracing). Include the coronoid process, 
mandibular notch, condyle, and ramus profiles. 

Sella Sella Turcica Center of  sella turcica 
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Soft N Soft-tissue Nasion Deepest point on the concavity of  the soft tissue profile overlying the 
area of  the frontonasal suture. Point is determined within the software 
from the soft tissue profile. 

Soft Pog Soft-tissue Pogonion Most anterior point on the soft tissue chin in the mid-sagittal plane. 
Point is determined within the software from the soft tissue profile. 

Sti Stomion inferius Most superior point located on the lower lip. Point is determined within 
the software from the lower soft tissue profile. 

Sts Stomion superius Most inferior point located on the upper lip. Point is determined within 
the software from the upper soft tissue profile. 

Symphyseal Profile Symphyseal Profile Trace the profile of  the symphysis with a series of  points (double-click 
or right-click to finish tracing). 

Upper Left Incisor 
Profile 

Upper Left Incisor 
Profile 

Define the profile of  the upper left incisor using 3 points: 
1. Root of  upper incisor (UIroot_L) 
2. Crown of  upper incisor (UIcrown_L) 
3. Labial point of  upper incisor (UIlabial_L) 

Upper Left Molar 
Profile 

Upper Left Molar 
Profile 

Define the profile of  the upper right molar using 3 points: 
1. Anterior root of  upper molar (UMroot_L) 
2. Anterior cusp of  upper molar (UMcusp_L) 
3. Posterior cusp of  upper molar 

Upper Right Incisor 
Profile 

Upper Right Incisor 
Profile 

Define the profile of  the upper right incisor using 3 points: 
1. Root of  upper incisor (UIroot_R) 
2. Crown of  upper incisor (UIcrown_R) 
3. Labial point of  upper incisor (UIlabial_R) 

Upper Right Molar 
Profile 

Upper Right Molar 
Profile 

Define the profile of  the upper right molar using 3 points: 
1. Anterior root of  upper molar (UMroot_R) 
2. Anterior cusp of  upper molar (UMcusp_R) 
3. Posterior cusp of  upper molar 

Upper Soft Tissue 
Profile 

Upper Soft Tissue 
Profile 

Trace the profile of  the upper soft tissue with a series of  points (double-
click or right-click to finish tracing). The upper soft tissue is defined as 
including the upper lip. 
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3DAnalysis: Save Information 
 
Whenever the file is saved through Invivo, the .inv file saves any tracing tasks and measurements made within 
3DAnalysis. The next time this .inv file is loaded, the measurements, references, etc. are all loaded from the 
previous session. 
 
 

In addition, 3DAnalysis can save tracing data to an external file. Press the Save Information  button to bring 
up the following options: 
 
 

• Build Norm Data 
• Export Measurements 
• Export Landmarks 
• Export Tracing 
• Save Current Configuration As 
• Load A Configuration 
• Reset to Default Configuration 

 

 

 
Build Norm Data 

In the drop-down menu, choose to which norm data file to add the new measurements and press OK. 
 

 Ex. Select “My Caucasian” to add the measurements to the “Caucasian” norm data files (without overwriting the 
“Caucasian” norm data). The Analysis tab of  the Text View now contains the data from the “Caucasian” norm data and 
the measurement data from this specific patient. The means and standard deviations are updated accordingly. 

 

Press Create New Norm to create a new norm data file. When the Define Group window opens, fill in an 
appropriate name and description of  the new norm data file and press the User Define button to open up the 
User Define Norm Data window. Browse to where the new norm data file is stored and press Open. Press OK 
on the Define Group window to finish and close the window. Press OK in the Save Information window to 
import the new norm data set.  
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Export Measurements 
 
Select the “Export Measurements” option and press OK to export the current measurements of  the patient. 
Choose the filepath and the name of  the file. Press Save, and all the current measurements will be saved as a .csv 
file. If  an existing .csv measurement file is selected, the data is appended to the end of  the document. Using the 
preferred spreadsheet viewing program, the .csv file can be opened to show all measurements in a spreadsheet 
format for further analysis. The delimiters for columns are commas (,). 
 
Export Landmarks 
 
Exports the landmark names and coordinate data to a .csv file that can be opened by a spreadsheet program. The 
delimiters for columns are commas (,). 
 
Export Tracing 
 
Select “Save Tracing” and press OK to export the position of  the current landmark positions and profile drawings 
in a customized XML format. Choose the location and name of  the XML file in the Save Tracing Data window. 
 
Save Current Configuration As 
 
Saves the current configuration to a user-selected location. The configuration file name can be entered into 
either the blank box before clicking OK or chosen during the actual save to location process. The Current 
Configuration field indicates which configuration file is currently being used. 
 
Load a Configuration 
 
Opens a file browser to select a configuration file to be loaded. The program provides a warning explaining 
that the current configuration will be overwritten. It is recommended that the user save the current 
configuration as a backup before continuing with the load. The Current Configuration field indicates which 
configuration file is currently being used. 
 
Reset to Default Configuration 
 
Resets the 3DAnalysis configuration to the installation settings. 
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3DAnalysis: 3D Surgery Tool 
3DAnalysis allows the user to simulate surgical cuts and adjustments to better assess the surgical procedures 
necessary to achieve facial harmony. 

 

 
Warning: 3D Surgery tool’s intended use is for patient consultation and statistical analysis only. For diagnoses, use TxSTUDIO. 

 

Certain tracing tasks must be completed before performing certain surgical cuts or visualizing soft tissue 
deformation.  

Maxilla Cut Mandible Cut Soft Tissue Deformation 

ANS Menton Upper Soft Tissue Profile 

PNS Left Gonion Lower Soft Tissue Profile 

Upper Right Incisal Crown Right Gonion  

Upper Right Molar Cusp Upper Right Incisal Crown  

 
Upper Right Molar Cusp 

 
Lower Right Incisal Crown 

Subsequent adjustment of  the tracing after using the 3D Surgery tool undoes the surgical simulations performed. 
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To begin, click on the 3D Surgery tool   to open the 3D Surgery window.  

 Maxilla, Mandible, Chin Cut: Automatically 
calculates a surgical bone cut when checked. 

Adjust Cut: Adjust the size and angle of  the 
cut by manipulating the volume of  the cut. 
Adjusting the cut after the segment has been 
moved or rotated will reset its position. 

Move: Moves the bone separated by the cut 
either through the widget tools that appear 
when the button is toggled on or by inputting 
values in the Move and Rotate fields. 

Cut Type: Choose from Dal Pont, T&O, and 
Hunsuck cuts for the mandible. 

Volume:  
• Show Volume: Toggle the volume on or 

off  and switch between the pre- and 
post-surgery states.  

• Color Cuts: Colors the cut volumes 
distinctly from the rest of  the volume.  

Tracings: Toggle the visibility of  the pre- and 
post-surgery tracings. 

Skin: Toggle the visibility and adjust the 
opacity of  the pre- or post-surgery skin if  
applicable. The “Wireframe” option converts 
the skin to a wire mesh form when selected. 

Reset: Resets all move and rotate values to 
zero. 

Export Tracing: Exports post-surgery 
tracing. An exported tracing can be 
reimported as a superimposed tracing. 
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By moving the widget tools or entering values directly into the window, the bone sections can be manipulated. A 
post-op tracing is created, reflecting the changes. Once the post-op tracing is finalized, close the 3D Surgery dialog. 
If  Text View is selected, the data of  the pre- and post-op scans can be toggled by pressing the “s” key on the 
keyboard or click on the “Superimposed” or “Default Tracing” header below the Text View Tabs. To export the 
tracing, use Export Tracing in the 3D Surgery dialog.  
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3DAnalysis: Profilogram 
The profilogram is a simplified representation of  the profile tracing based on a few landmarks. The required 
landmarks are:  

 

Once the above tasks are traced, click the Profilogram  icon. The graphic is automatically generated. If  3D 
Surgery was performed on the patient or if  a tracing was superimposed, the original tracing’s profilogram is drawn 
with a solid line, while the superimposed tracing is drawn with a dashed line. 

 

Additional visibility options on the left allow the user to hide or display labels, lines, and the ruler. 

By default, the profilogram is registered on the sella and superimposed about the Frankfort horizontal plane, but 
this is customizable in the Profilogram dialog.  

Sella 
Right Orbitale 

A-point 
Upper Right Incisal Crown 

Pogonion 
Right Gonion 
Right Porion 

Nasion 
ANS 

B-point 
Lower Right Incisal Crown 

Menton 
Right Articulare 

Left Porion 
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Report Module Features 
The Report View Tab allows for the creation of  templates containing images and text. A template can be applied to any case using 
this tab. In this picture, the page background is black and represents the page. Several types of  items can be placed within this page to create 
a detailed report for the patient. 
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Report: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Report View Tab: 

 

 
Add Image: Adds a control to add a single image. 

 
Add Slices: Adds a control to add single slices or a group of  slices. 

 
Add Text: Adds a control to add text. 

  
First Page: Navigates to the first page of  the report. 

  
Previous Page: Navigates one page back. 

  
Next Page: Navigates one page forward. 

  
Last Page: Navigates to the last page of  the report. 

  
Insert Page: Inserts a page after the current page. 

  
New Page: Adds a page to the end of  the report. 

  
Remove Page: Deletes the current page. 

  
New Template: Creates a blank template. 

  
Export PDF: Saves the report as a PDF file. 

  
Export to PACS: Saves the report as a DICOM onto the PACS server. Requires PACS 
configuration beforehand. 

  
Preferences: Opens preferences for default colors, default image type, default page setup, grid 
alignment, and the template save path. 
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Report: Control Panel 

 

Template 
• Template drop-down: Lists the available templates. 
• Manage: Displays all of  the preset templates. 

Templates can also be loaded, renamed, and removed in 
this dialog. See pg. 233. 

• Save: Saves the current template. Templates are stored 
locally and show up on the drop-down. 

Add New Control 
Text: 
• Edit Phrases…: Opens a dialog for managing 

common phrases to be added to text controls. See pg. 
223. 

• Add Text: Adds a control for text. 
Slice Group: 
• Slice Group Management: Allows creation and 

management of  image groups. 
• Add Slice Group: Adds a control for 2D slices. 
Single Image: 
• Add Single Image: Adds a control for one image. 
Current Control 
• Name drop-down: Shows the name of  the currently 

selected control from a list of  controls on this page. 
Each control can be selected from the drop-down menu 
instead of  clicking the control. 

• Image Refresh: Updates the image according to the 
changes in the source image. 

• Properties: Opens the Properties window for the 
current control. 

• To Background: Puts the selected image behind other 
images. 

• To Foreground: Puts the selected image in front of  
other images. 

Page Control 
• Print Page: Enables the current page to be printed. 

• Page Setup: Opens page setup for setting printer, paper size, margins, and background/border 
properties of  the page. 

• Page Information is displayed showing the current settings. 
• Previous/Next Page: Page navigation controls. 
• Delete Page: Removes the current page. 
• Insert Page: Inserts a page after the current page. 
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Report: Rendering Window 

 

The rendering window displays the report page and is the main area for designing and viewing reports and 
templates. The page navigation buttons in the toolbar allow the user to switch between pages in a multi-page 
report to choose which is displayed in the rendering window. 

Adjusting the position and zoom of  the report within the rendering window uses the same keyboard and mouse 
combinations as in other TxSTUDIO tabs: 

Zoom – Ctrl + Left-Click + Drag Mouse 

Pan – Shift + Left-Click + Drag Mouse 
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Report: Controls 
Controls are boxes that display text or image data. 

 

Adding and Sizing 
• Navigate the mouse cursor to the Control Panel on the 

left and select the button labeled Add Text, Add Slice 
Group, or Add Single Image.  

• Size the control: The image on the left shows the 
control rectangle during creation. The control is created 
by two separate points and does not show up until after 
the first point has been placed.  

 

Warning: If  the control is created outside of  the page 
borders, an error message is displayed, and the 
control is not created. 

 

Resizing and Customization 
• After creation, the control looks like the image on the 

left.  
• Resize the control: Click and drag the green squares or 

the borders. Alternatively, set the height and width from 
the Properties window. 

• Move the control: Click and drag with the left mouse 
button or use the arrow keys on the keyboard after 
clicking inside the control. 

• Select a control: Click on the control or select it from 
the Name drop-down on the Control Panel. Pressing 
the Delete key deletes the control. To see the control's 
properties, press the Properties button while it is 
selected. Double-clicking the control also shows its 
properties. 

• Select multiple controls: Click more than one control 
while holding the “Ctrl” key on the keyboard. 
Supported multi-control operations are movement and 
deletion. 

• Copy and paste controls: Select a control, press Ctrl + 
C, then press Ctrl + V to paste it at another location. 
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Report: Adding Text Controls 
Text Controls contain text that is manually typed in or drawn from the Case Info. 

Adding a Text Control: 
• Click the Add Text button. 
• Properties can be changed by clicking Properties in the Current Control section of  the Control Panel. 

 

 

Text Box Dialog 
This dialog can be opened by double-clicking on a text 
control or selecting the control and clicking Properties 
on the Control Panel. 
Text 
• Alignment type: Select the text alignment type. 
• Font Options: Family, size, color, alignment, bold, and 

italics can be changed. 
• Text Input Box: Enter text to be displayed in this text 

box. 
• Insert Case Info: Inserts the selected data based on 

the case information or Gallery comments where the 
cursor is in the Text Input Box. 

• Insert Text Phrase: Inserts the selected text phrase 
where the cursor is in the Text Input Box. 

• Edit Phrases: Opens the Text Phrases dialog (See pg. 
223). 

 

Box 
• Size and color: Determines the size of  the text control. 

Unchecking “Transparent” shows the chosen color 
instead of  the report’s background color. 

• Border: Set the border style, color, and thickness. Style 
can be dashed, solid, or none (not displayed). 

 

Save As 
• Choose the name of  the control. 
Show on Every Page 
• Check this option to show the text in the control on 

every page of  the template. 
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Text Phrases 
Text phrases store common phrases within the 
software to be inserted into text controls. This dialog 
can be opened by click on Edit Phrases. 
• Search: Searches for the term in the list of  stored 

phrases. 
• Add: Opens a dialog for creating a new phrase. 
• Edit: Opens a dialog for editing the selected 

phrase. 
• Remove: Removes the selected phrase. 
• Insert: Inserts the selected phrase into the text 

control. 
• Text Input: If  a text control is selected, type 

directly into the box to update the text control 
on the report. 
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Report: Slice Group Management 
Groups are created in the Report Tab and used in slice controls. The groups are populated from ArchSection and 
TMJ Tabs only. 

 

Slice Group Management: To add/modify groups, 
click the Slice Group Management button in the Page 
section of  the Control Panel. 

Add/Edit Group Name: Name of  the new group or the 
new name of  the selected group. 

Slice Type: Type of  slice for this group. 

• Arch Axial Slice: ArchSection Tab’s axial slice 
mode 

• Arch Cross Slice: ArchSection Tab’s cross-section 
slice mode 

• TMJ Left Cross Slice: TMJ Tab’s left cross slices 
• TMJ Right Cross Slice: TMJ Tab’s right cross 

slices 
 

 

Description: Optional description for group. 

Add Group: Adds the new group to the template's 
groups. 

Edit Group: This replaces the selected group with the 
new group. If  the slice type changes, all of  the slices will 
be removed. If  any slices in this group are not in other 
groups, they will also be removed from the case file. 

Remove Group: This permanently deletes the currently 
selected group from the current template. If  any slices in 
this group are not in other groups, they will also be 
removed from the case file. 

Selected Group: This holds all of  the existing groups on 
the template. Can be selected for Edit and Remove 
operations. 

The image on the left displays the corresponding slices for this 
particular Slice Group. 
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Adding Slices to a Group 
Note: Only the ArchSection and TMJ Tabs allow for capturing slices to a slice group. 

ArchSection and TMJ Tabs have a toolbar button (shown below) that enables the slice-capturing mode. While in 
this mode, all captured slices for a selected group are visible. Slices can be added or removed from the slice group. 

  
Slice Capture Mode – This opens a dialog for capturing slices to a group. 

Capture Slices Dialog: 

 

Capture Target: Allows selection of  group to 
add/remove slices. All parameters are read-only here. 
The selection of  slices can be modified in the Slice 
Group Properties in the Report Tab. 

• Name: Name of  the current group 
• Type: The group's slice type 
• Description: Optional description for this group 
Action: Description of  the capture slice options 
(discussed in more detail in the next section). 

Select Range: Allows use of  the pano or frontal image 
to capture the slices. Press the Select Range button 
then pick two points on the pano to mark the start and 
end slices. All of  the slices in between are added to the 
group. The number of  slices depends on the slice 
interval and slice thickness set. 

 

Status: Allows viewing of  all slices in this group. 

• Number of  Captured Slices: List of  all slices in 
the current group with a count of  the total 
number 

• Remove Slice: Remove the selected slice(s) 
• Remove All: Removes all captured slices 

The image on the left displays the corresponding slice that would be 
captured with this Slice Group. 

Management 
• Manage Slice Groups: Opens the Slice Group Management dialog. 
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Capturing Slices 
There are three ways to capture a slice in the capturing mode in the ArchSection or TMJ Tabs. All captured slices 
for the current group have their borders highlighted in green in the source tabs. Their locations are also marked on 
the pano and frontal images. Arch axial slices are not marked on the pano. Note: For the arch axial slice type, 
ArchSection layout must be in lightbox mode with axial sections chosen for capturing. Slices outside the selected 
group's slice type cannot be captured. 

Slice Capture 

• Single Slice Capture: Hold the “s” key on the keyboard and left-click any slice to capture it. The 
selected slice is highlighted. Note: Repeating this deselects the slice. 

• Group Slice Capture: Hold the “a” key on the keyboard and left-click any slice to capture it. Click on 
another slice, and all slices in between the two slices are captured including the second slice clicked. 

• Select Range: This captures slices within a range designated in the pano or frontal images depending on 
the view. Note: This is not available for arch axial slices. 
 

 

The image above shows the configured slice range on 
the ArchSection pano. 

Note: If  slices have already been captured to the Report 
Tab, white lines denoting these slices are visible on the 
pano even before the Select Range function is used. 
Use the Toggle Visibility tool to hide these lines. 

Select two points on the pano in ArchSection or the 
frontal images in TMJ. 

• After clicking once on the image, a red line 
appears. This is the starting slice of  what is 
captured.  

• When clicked a second time, all slices between 
the red line and the second point are captured. A 
second red line marks the end slice. White lines 
denote every captured slice as defined by the 
cross-section parameters. See image to the left. 

• A gallery image with the slice group name of  the 
pano or frontal is be added. If  one already exists, 
it will be replaced. Note: This automatically 
replaces any other image with the same name 
regardless of  how it was captured to Gallery. 
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Report: Adding Slice Group Controls 

Slice Group Controls can hold a single slice or a series of  slices. (See Report: Slice Group Management,  
pg. 227.)  

Note: If  no slice groups exist, the dialog prompts to create one. 

Adding a Slice Group: 
• Click the Add Slice Group button.  
• Properties can be changed by clicking Properties in the Current Control section of  the Control Panel. 

 

Warning: When resizing a Slice Group Control, note that the slice numbers may disappear if  the control 
is downsized past a limit (approximately the size that the numbers can no longer fit within each 
respective slice). 

Slice Group Box Properties 

 

Source 
• Sync to Source: Select to update the image automatically if  it is 

changed. If  disabled, images can be refreshed with the Image 
Refresh button. 

• Slice Groups or Selections: Determines if  slices are added by group or 
individually by slice. See the next page for more information on Slice 
Image Source. 

Layout 
• Columns/Rows: Determines the arrangement of  slices within the 

control.  
• Note: If  there are not enough rows and columns for the number of  

chosen slices, some slices are not displayed. 
Display Mode 
• “Fit” stretches the image to fit the control while maintaining aspect 

ratio. “Clip” uses clipping to fill the control space. 
• Image Alignment: Determines how the image is oriented within the 

control. 
• See Image Alignment on pg. 231 for more details. 

Box 
• Size and color: Determines the size of  the text control. Unchecking “Transparent” shows the chosen 

color instead of  the report’s background color. 
• Border: Set the border style, color, and thickness. Style can be dashed, solid, or none (not displayed). 
• Ruler: Set which borders rulers are displayed and the color. 
Save As 
• Choose the name of  the control. 
Show on Every Page 
• Check this option to show the content on every page of  the template. 
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Slice Image Source Details: 
Images can be added to Slice Group Controls by group or by manual selection: 

 

Slice Groups: Displays slices from a single 
group. Refer to Report: Capturing Slices (pg. 
233) for more information on the restrictions 
and functionality of  slice range. 
• Selected Group: The slice group to use as the 

source. 
• Start Slice: First slice to be displayed from the 

group.  
• End Slice: Last slice to be displayed. 
• If  “All” is checked, all of  the slices from the 

selected group are displayed. 

  

 

Selections: Manually add captured slices one by 
one to be displayed.  
• Available Slices: All slices captured in the 

current case file. 
• Selected Slices: All slices chosen to be 

displayed in this control. 
• > Button: Moves selected Available Slice(s) to 

Current Slices for display. 
• < Button: Moves selected Current Slice(s) to 

Available Slices to no longer display. 
• If  “All” is checked, all of  the captured slices 

are displayed. 
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Slice Control Selection Details 
Start and end slice are determined by their slice numbers. This number can be seen on each slice in the upper 
right. This is only enabled for single groups. When selecting the range of  slices to be displaced, the number 
indicates which slice in the series is shown and does not correspond to the slice number itself. 

• Start Slice: What slice in group to start displaying. 0 defaults to the first slice. 
• End Slice: What slice in group to stop displaying. 0 defaults to last slice. 

 
Slice Range Examples: 

• The first two slices can be shown by setting Start Slice to 1 and End Slice to 2. The next two can be 
shown by setting the start to 3 and the end to 4.  

• All slices can be shown by setting Start and End Slice to 0.  
• If  Start Slice > End Slice, only the End Slice is shown. 
• If  Start Slice > Number of  slices and End Slice = 0 or End Slice ≥ Number of  slices, then only the last 

slice is shown. 
• If  either parameter is blank, it defaults to 0. 
• If  End Slice > Number of  slices, the last slice is the End Slice. 
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Report: Adding Single Image Controls 
Control that holds a single image from a selected source view. 

Adding a Single Image Control: 

• Click the Add Single Image button.  
• Properties can be changed by clicking Properties in the Current Control section of  the Control Panel. 

 
Single Image Box Properties 

 

Source 
• Determines the exact image to be displayed 

from the source view (Note: Images are not  
available until the specified source view has 
been “visited” to provide an image to load. See 
Report: Image Type Definitions, pg. 232, for 
details on dynamic images.) 

 Sync with Source, Display Mode, Image 
Alignment, Box dimensions and properties, Save 
As, and “Show on Every Page” control the same 
properties as for Slice Groups (see Report: 
Adding Slice Group Controls, pg. 227). 

 
Warning: Bitmaps under 24 bit 
may not display correctly. 
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Report:  Image Alignment 
For Slice Group Controls and Image Controls, images may be aligned to the control boundaries by two methods.  

• Fit: Resizes the image to fit within the borders of  the control as determined by the Image Alignment 
settings.  
 

This example is done with a bottom left fit alignment position with a white background.  

 

The image originates from the bottom left and shows the background above it or to the right when it does not fill 
the control. 

 

 

• Clip: The original image size is maintained. The control may need to be resized in order to display the 
full image.  
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Report: Image Type Definitions 
Dynamic Images: 

These images can always be up-to-date with the latest changes performed on them if desired. When adding an 
image to a control, the user can choose not to auto-update the image, keeping the current image until the auto-
update setting is changed or the image is manually refreshed. There are two types of dynamic images. 

Note: Capturing images from specific layouts requires that the layout is currently selected when leaving the aforementioned view tab and 
reloading the Report Tab. Ex. The pano screen in the Implant Tab is not captured unless the Pano layout is on when leaving the view. 

Single image view sources except Gallery and external images are dynamic. 

• To populate the image source with images, go to a view tab. After leaving the view, images for that 
view are captured. 

• After an image has been added to a control, it updates when changes are made in that view. For 
example, if  a measurement is added to Section Tab's axial view, the image in the Report Tab now 
displays that measurement. 

• These images are saved with the case file. 
• Slice images 

• These are captured manually. 
• These are the input for the Add Slice Control. 
• They have the same dynamic update behavior as above. 
• These images are saved with the case file. 

 
Static Images:  

These images never change without manually change the source image. There are two sources of  static images. 

• Gallery 
• All images in the Gallery are either captured from other tabs or imported by using the Import 

Images function. They may not always be life size. 
• These images are saved with the case file. 

• From a File 
• These images come from the local computer or another source. They are never life size. 
• These images are saved with the template. 
• If  an image that already exists in the template is added, the software prompts whether to replace the 

image or keep using the older one. 
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Report: Managing Templates 
Once a report layout is created, it can be saved and reloaded in other cases as a template. Templates are saved 
locally in the file path designated under “Template Path” in the Preferences dialog. These saved templates 
automatically appear in the drop-down menu. To display a preview of  all the available templates or to edit them, 
click on Manage… on the Control Panel. 

 

Manage Preset Templates 
• All of  the saved templates are shown here. 
• Each color represents a different type of  control: 

• Blue: Text control 
• Red: Image control 
• Yellow: Slice group control 

• Templates may also be loaded from this window by 
left-clicking on them. 

• Previous/Next: Goes to the previous or next page of  
templates, respectively. 

• Edit List: Opens a dialog for editing template 
properties. 

• Close: Closes the dialog. 

 

Edit Template Presets 
• Add: Load an existing template that was saved 

elsewhere. 
• Rename…: Rename the selected template. 
• Remove: Remove the selected template. 
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Report: Preferences 

 

Default Control Colors: Colors for border, 
background, font, and rulers. 
Default Image Type: Choose between “Fit” or “Clip” 
display modes. 

Default Page Setup: 
• Printer: Printer in current use. This changes the 

available paper sizes. This list includes all of  the 
printers available to the computer. 

• Paper Size: Uses the printer drivers to set the 
height and width of  the page. 

• Orientation: Portrait or landscape setup. 
• Margins: Margins (in inches) for the template. 

Used for where controls can be placed. 
• Background: Color and transparent options. 
• Border: Color, thickness, and style options for 

the border. Styles are solid line, dotted line, or no 
line at all. 

• Margins: Margins for the border. This can differ 
from the page margins. 

Behavior: Specifies behavior of  the template during 
design. 
• Enable Alignment Grid: If  checked, all controls 

attach to their top left corner to the nearest grid 
point. If  unchecked, they are placed wherever the 
user drags them. 

• Display Numbers on Print: If  checked, the 
report page number is displayed in the printout. 

Alignment Grid: 
• Grid dot spacing: Defines the distance between grid dots. 
• Grid dot color: Set the color of  the grid dots. 
• Hide Grid: Toggles the visibility of  the grid. 
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Report: Page Setup 
This displays and allows configuration of  the page settings. These are the settings the template uses. When 
printing, the correct printer and paper size must be chosen from the print setup.  

Note: The first time the software loads, the default printer configuration is used to set the printer and paper size 
for the report. Report defaults can be changed from the Preferences menu. 

 

 

Page Setup: 

To modify page settings, click the Page Setup button 
in the Control Panel. 

Page Configuration:  

• Printer: Printer to use for this template. 
• Paper Size: Current paper size. Only displays 

paper sizes for the currently selected printer. 
• Paper Orientation: Portrait or landscape 

orientation. (Note: Margins do not change, so 
paper may appear to have different proportions 
when switching between portrait and landscape.) 

• Margins: Margins (in inches) for the page.  

Background: 

• Checking transparent shows the chosen color 
instead of  the background. 

Border: 

• Set the border color, thickness, and style. 
• Style can be dashed, solid, or none (not 

displayed). 
• Margins: Location of  the borders. 
 

Page information of  the chosen configuration is always displayed 
in the Page section of  the Control Panel. 
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Stitching Module Features 
The Stitching View Tab provides the ability to merge two DICOM data sets. This provides the ability to utilize CBCT machines 
with smaller fields of  view fully. 

 
+ 

 
|| 

 

 
Warning: Stitching module is not a medical device and should be used as a reference or presentation tool only. 
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Stitching: Toolbar 
Shown below are the Toolbar and tools that are loaded with the Stitching View Tab: 

 

  
Reset: Resets the modeling window to the original view size. 

  
Left: Automatically orients the volume in a left sagittal view. 

  
¾ Left: Automatically orients the volume in a 45° left view. 

  
Front: Automatically orients the volume in a front view. 

  
¾ Right: Automatically orients the volume in a 45° right view. 

  
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

  
Bottom: Automatically orients the volume in a bottom-up view. 

  
Back: Automatically orients the volume in a posterior view. 

  
Layout: Toggles the rendering window layout. 

  
Grid: Toggles between different grid layouts on the volume, allowing quick assessment of  
measurements and spatial location. 

  
Point Registration: This tool is used to register the original volume to the imported volume. Four or 
more anatomical points are chosen from each scan to properly align them.  

  
Adjust: This tool is used to make adjustments to align the two volumes better.  

  

Information Display: Displays or hides case information embedded in the data. 
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Stitching: Control Panel 

 

Import New File: Import the second volume by opening an invivo 
file (.inv) or DICOM (.dcm). 

Original Volume and Imported Volume: Different viewing 
options, such as visibility, rendering type, brightness, and contrast 
for each volume can be selected or adjusted independently. 

3D Volume Clipping: Click the “Enable Clipping” box to clip the 
image along the predefined anatomical planes (sagittal, axial, coronal, 
and arch). Scrolling the mouse wheel or moving the slider moves the 
clipping plane. To switch a view to the opposite side, click “Flip.”  

New Volume Slices: The Opacity slider adjusts the opacity of  the 
superimposed volume. The Color button changes the color of  the 
superimposed volume. 

Adjust Final Stitched Image Size: This feature sets new boundaries 
for the stitched scans. If  the stitched volume does not fit into the 
window or is off  centered, this feature can be used to adjust the 
boundaries. 

Save Stitched Image File: This button saves the stitched  
volumes into an Invivo file. Upon saving, the two volumes are merged 
and open as a regular Invivo file. 
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Stitching: How to Stitch Two Volumes 
TxSTUDIO provides an easy-to-use tool that combines two volumes to create a larger field-of-view scan. 
Although it is easy to use, it is a technique-sensitive feature with the most critical step being the registration of  the 
scans by selecting stable landmarks. The next section shows how to stitch two scans step by step. 

Step 1. Save DICOM Files as Invivo Files.  

Both scans are recommended to be saved as Invivo files (.inv) before proceeding. See the section on Invivo File 
Saving for saving DICOM files as Invivo files.  

Step 2. Open the First Invivo File.  

Open the first Invivo file. The cases do not need to be opened in a specific order.  

Step 3. Import Volume.  

Go to the Stitching Tab. Click on the Import New File button on the Control Panel to select the second scan: 

 
 

 

Step 4. Registering the Two Scans to Each Other.  

In order to stitch the scans correctly, strict attention must be exercised in selecting at least four matching and stable 

landmarks in both scans. Use the Point Registration function:   
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Select the first landmark on one scan, and then select the exact matching landmark on the other scan. The 
landmarks are selected by pressing the center scroll wheel of  the mouse or by the space bar on the keyboard. Each 
point shows up as blue or red pixels (above). The image can be rotated with the mouse as usual.  

Because the points are plotted on the volume, careful attention must be taken so that the brightness is not too 
high; otherwise, the point could be offset from the point intended. Clipping the scan may make the selection of 
the exact point easier and potentially more precise.  

Once at least four points are plotted and matched, click the right mouse button to register the two scans.  
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The above image is of an upper and a lower field of view. The blue outline from the second scan closely overlaps 
the original bone-colored scan in the shared region. 

The following image is of  two volumes imprecisely registered. The blue and orange skeletal boundaries do not line 
up, leading to the presence of  double images: 
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Step 5. Making Adjustments for Precision.  

The next step is to check the cross sections for accuracy and make the necessary adjustments. The stitching is 
shown in 3D as well as in the cross sections.  

To enlarge the cross sections, use the Layout icon on the toolbar:   

 

If the stitch is not completely precise in one of the sections, the volume or the cross sections can be moved 

for better alignment using the Adjust tool:   

Each anatomical plane should be checked for precision. The cranial base should match up perfectly because 
it is stable; however, the vertebrae may not because the patient's head is usually tilted differently in each 
scan.  
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Step 6. Saving Final Stitched Scan 

Use the “Adjust Final Stitched Image Size” tool to set the boundaries by dragging the white handles of  the 
bounding box. Make sure the entire volume range is included. 

 

When the bounding box has been adjusted to the size desired, turn off  the “Adjust Final Stitched Image Size” 
function and click the Save Stitched Image File button on the bottom left. 

 This saves an Invivo file (.inv) with the two scans together as one. 
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TxSTUDIO Software Troubleshooting 

Category Error Solution 

General Error Message: 
TxSTUDIO Application has encountered a problem and needs to close. We are 
sorry for the inconvenience. 
 

 Click the “Don't Send” button. 
 Check if  there are old versions of  optional plug-ins: remove 

them or upgrade them to be compatible with TxSTUDIO. 
 Launch the TxSTUDIO application again. 

Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Cannot launch TxSTUDIO  Open Task Manager and check if  multiple instances of  
TxSTUDIO are already running. 

 Close other TxSTUDIO processes. 
 Launch the TxSTUDIO application again. 

Computer failure Launch the TxSTUDIO application again. 
Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Installation Error Message: 
Server is not Responding 

 Check Internet connection. 
 If  Internet is connected, try again later. 

Error Message: 
Please run as administrator to activate software 

Run the installer/application as administrator. 

Error Message: 
Failed to verify the license code! 

Check the license code and try again. 
Check Internet connection and try again. 

Error Message: 
Wrong License Code! 

Check the license code and try again. 

Error Message: 
Invalid Authorization code 

Check the license code and try again. 

Error Message: 
Actual size of  the image can't fit to the paper size! 

Change printer setting or create an image with smaller size. 
 

File Operations Error Message: 
Failed to create process. Please close other applications and try again. 

 Close all the other applications. 
 Launch the TxSTUDIO application again. 

Error Message: 
Error: Unknown file format! 

Check if  this file is supported by TxSTUDIO. 

Error Message: 
Not enough memory 

 Close all the other applications. 
 Launch the TxSTUDIO application again. 

Error Message: 
Can't create temporary save file! 

Check if  the remaining disk capacity for the temporary 
folder is big enough. 

Error Message: 
Failed to read DICOM file! 

Check if  this file is supported by TxSTUDIO. 

Error Message: 
Can't read Dicom’s Image Data! 

Check if  this file is supported by TxSTUDIO. 

Try to open a file but nothing showing up Check if  this file is supported by TxSTUDIO. 

Error Message: 
Cannot save file! 

 Check if  the file is the correct type. 
Check if  the file path is correct and folder is writable. 

Image is distorted  Switch to another view and switch back. 
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Warning Message: 
3D reconstruction may not work! 

 Check if  the DICOM files are exported correctly. 

 
For all other issues, please contact Osteoid Inc. Customer Support at (408) 333-3484. 
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Keyboard Shortcuts 
The following keyboard shortcuts are available:  

 Hotkey Description 

Section P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Delete Deletes the selected 
notation/measurement 

 Shift + Delete Deletes all measurements on the 
active slice 

Volume Render 0 Changes to Gray Scale rendering 

 1 Changes to Inverse rendering 

 2 Changes to Soft Tissue 1 rendering 

 3 Changes to Soft Tissue 2 rendering 

 4 Changes to Soft Tissue+Bone 
rendering 

 5 Changes to Soft Tissue+Teeth 
rendering 

 6 Changes to Bone rendering 

 7 Changes to Teeth rendering 

 8 Changes to Custom rendering 

 P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 
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 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Q Enables Freehand Volume 
Sculpting tool 

 W Enables Polygon Sculpture tool 

 Delete Deletes the selected 
measurement/notation/airway 

ArchSection Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Up Arrow/Down Arrow Scrolls through selected slice 

 Delete Deletes the selected 
measurement/notation/nerve 

 Shift + Delete Deletes all measurements on the 
active slice 

Super Pano P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 0 Changes to Gray Scale rendering 

 1 Changes to Enhanced Gray 
rendering 

 2 Changes to Soft Tissue+Teeth 
rendering 

 3 Changes to Soft Tissue+Bone 
rendering 

 4 Changes to Composite 1 rendering 

 5 Changes to Composite 2 rendering 

 6 Changes to Bone 1 rendering 

 7 Changes to Bone 2 rendering 
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 8 Changes to Teeth 1 rendering 

 9 Changes to Teeth 2 rendering 

 Delete Deletes the selected measurement 

Super Ceph 0 Changes to X-ray rendering 

 1 Changes to X-ray + Soft Tissue 
rendering 

 2 Changes to Bone Preset 1 rendering 

 3 Changes to Bone Preset 2 rendering 

 4 Changes to Bone Preset 3 rendering 

 5 Changes to Soft + Bone 1 rendering 

 6 Changes to Soft + Bone 2 rendering 

 7 Changes to MIP rendering 

 Delete Deletes the selected measurement 

Implant 0 Changes to Volume preset 

 1 Changes to Implant preset 

 2 Changes to Stone Models preset 

 3 Changes to Restoration preset 

 4 Changes to Restoration2 preset 

 P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Delete Deletes the selected 
measurement/implant/airway 

Airway P Volume clipping is toggled on/off 

 A Volume is clipped axially 
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 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Delete Deletes the selected 
measurement/notation/airway 

 Shift + Delete Deletes all measurements on the 
active slice 

Restoration Delete Deletes the selected 
measurement/restoration 

 0 Changes to Volume preset 

 1 Changes to Implant preset 

 2 Changes to Stone Models preset 

 3 Changes to Restoration preset 

 4 Changes to Restoration2 preset 

 P Volume axial clipping is toggled 
on/off 

 F Volume clipping is flipped 

Endo 0 Changes to Teeth rendering 

 1 Changes to Pulp rendering 

 2 Changes to Bone rendering 

 3 Changes to Gradient Edges 

 4 Changes to Inverse 1 

 5 Changes to Inverse 2 

 P Volume clipping is toggled on/off 

 Q Enables Freehand Volume 
Sculpting tool 

 W Enables Polygon Sculpture tool 
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 Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Delete Deletes the selected 
measurement/notations 

 Shift + Delete Deletes all measurements on the 
active slice 

TMJ Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Delete Deletes the selected 
measurement/notations 

 Shift + Delete Deletes all measurements on the 
active slice 

Superimposition P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Delete Deletes the selected measurement 

Model P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Delete Deletes the selected 
measurement/notation 

3DAnalysis 0 Changes to Soft Tissue+Bone 1 
rendering 

 1 Changes to Soft Tissue+Bone 2 
rendering 

 2 Changes to Teeth rendering 

 3 Changes to Bone rendering  
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 4 Changes to X-ray rendering 

 5 Changes to GrayScale rendering 

 6 Changes to Custom rendering 

 P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Delete Deletes the selected 
measurement/notation/airway 

Medical Design Studio 0 Changes to Gray Scale 

 1 Changes to Inverse 

 2 Changes to Bone 

 3 Changes to Teeth 

 4 Changes to IsoSurface 

 P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Q Enables Freehand Volume 
Sculpting tool 

 W Enables Polygon Sculpture tool 

 Delete Deletes the selected measurement 

Report D Deletes page 

 E Bring up Edit Phrases dialog box 

 R Adds page 
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 P Go to previous page 

 N Go to next page 

 Delete Deletes the selected box 

Stitching P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 R Resets view per adjustment 
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Index 
This comprehensive list provides a quick and easy way to find the relevant information that you would like to examine. 
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DICOM ............................................................................................................................................................ 27, 29, 147 
DICOM & Invivo File Loading ..................................................................................................................................27 
Export Image .............................................................................................................................................................. 147 
Export Measurements ........................................................................................................................................ 211, 212 
Export Tracing ............................................................................................................................................................ 215 
Frontal Analysis .................................................................................................................................................. 182, 187 
Gallery View Tab ........................................................................................................................................................ 141 
Grid .................................................................................................................. 68, 76, 95, 117, 123, 127, 132, 153, 237 
Image Capture ......................................................................................................................................................... 35, 36 
Image Info ............................................................................................................................................................... 55, 61 
Implant ..................................................................................................................................................................... 75, 78 
Implant Angles ...............................................................................................................................................................75 
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